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Administer

This section describes administration tasks that the IT Administrator and Suite Administer user roles can perform in ITOM Container Deployment
Foundation (CDF) and ITSMA NG Express.

® Administer CDF
® Administer the ITSMA suite

Administer CDF

The ITOM Container Deployment Foundation (CDF) Administrator user role can perform administration tasks in the following areas in CDF.

Access ITOM CDF

Change your password

Edit the current CDF installation

Logs

Manage users

Monitor infrastructure status

Nodes

Manage licenses

View the existing images

Manage Resourses

Security

Restart ITOM CDF

Download and upload suite images
Customize the parameters for kubelet
Modify the external database configuration
Create or modify security groups in AWS

Access ITOM CDF

Logon

To access ITOM Container Deployment Foundation (CDF), follow these steps:

1. Launch the ITOM CDF from your browser:
https://[EXTERNAL_ACCESS_HOST >:5443

You must use the FQDN instead of its IP address in this URL. That is, the name you specified for
EXTERNAL_ACCESS_HOST in the install.properties file.

You access the application using a supported web browser, from any computer with a network connection (intranet or Internet)
to the servers. It is recommended to restore your browser settings to default.

You will be asked to change the password at first logon. See Change your password.
2. Loginto ITOM CDF as the admin user.

Use the out-of-box password cloud if this is your first login or use the password that you specified at your initial login after
installation.

Logout

To log out:

1. Click the [User Name] button the top right corner of the application and select Logout.
2. The application closes and the LOGON screen is displayed again.



When you have completed your session, it is recommended that you log out to prevent unauthorized use.

Change your password

To change your password, follow these steps:

1. Click the [User Name] button in the top right corner and select Change Password.
The following page opens:

| S

2. Enter the original password, the new password, and verify the new password.
The password should have minimum 8 characters and must contain characters the following four categories:
® Uppercase characters of European languages (A through Z, with diacritic marks, Greek and Cyrillic characters)
® Lowercase characters of European languages (a through z, sharp-s, with diacritic marks, Greek and Cyrillic characters)
® Base 10 digits (0 through 9)
® Nonalphanumeric characters
3. Click UPDATE PASSWORD.

Edit the current CDF installation

After ITOM Container Deployment Foundation (CDF) is installed, you can perform the following tasks to edit your existing installation:
® Add more machines to the existing Kubernetes cluster

® Remove machines from the existing Kubernetes cluster
® Edit the hard eviction thresholds of the existing worker nodes

Add more machines to the existing Kubernetes cluster

The administrator can add more worker nodes to the existing Kubernetes cluster.

Remove machines from the existing Kubernetes cluster

The administrator can remove machines from the existing Kubernetes cluster.
Use the following steps:

1. Log on the machine that you want to remove.
2. Go to the installation directory:

cd HPESW I TOM Sui t e_Foundati on_2017. 06. nnnn/
3. Uninstall the CDF from the node by running the following command: . / uni nstal | . sh

Edit the hard eviction thresholds of the existing worker nodes

CDF takes the hard eviction policy for the existing worker nodes. With the eviction service, Kubernetes will end the pod immediately once a hard

eviction threshold is met. The eviction can also delete dead pods, dead containers, and unused images when the disk space meets the
thresholds. See this Kubernetes article for more details.

To edit the hard eviction threshold, follow these steps:

1. Log on to the worker node for which you want to edit the eviction threshold.
2. Edit the parameter values in the following file: / usr/ 1 i b/ syst end/ syst em kubel et . servi ce.

For example, you can change the default thresholds below according to your needs.
vim/usr/lib/systend/system kubel et. service

--eviction-hard=nenory. avai | abl e<500M , nodef s. avai | abl e<56G , i magef s. avai | abl e<5G
--systemreserved=nenory=1. 5G


https://kubernetes.io/docs/tasks/administer-cluster/out-of-resource/

3. Run the following commands to enable the new thresholds.
systenct!| daenon-rel oad
systenctl restart kubel et

Logs

This section describes the logs.

Pod logs show the stderr/stdout of one Kubernetes pod/container.

Pod logs

1. Click RESOURCES > Workloads > Pods.
2. Click the relevant pod.
3. Click View logs in the Pod area. The following page is displayed:

You can use the following tools:

TT

® Toggles to change the size of the font used in the log.

A

L
® Toggles to change the colors of the log: white characters on black background or black characters on white background.

Logs from 10/31/16 723 AM 1o 10/31/16 7:37 AM

® Timestamp of the currently displayed log.

1< 4 ? >

® Use the relevant buttons to navigate between logs.

Manage users

ITOM Container Deployment Foundation supports two user roles (or user groups):
IT Administrator

Manages the shared services infrastructure and all suite products, as well as the grow/shrink functions, and adding and removing working nodes
(machines). The IT Administrator is a super administrator. This user has ability to request or add resources and has wide access permissions.

Suite Administrator

Manages a specific suite product. The Suite Administrator does not have access to the Admin menu and has the privileges with other operations
only under a specific namespace. The Suite Administrator is responsible for the relevant suite deployment, configuration, health, images, and
more.

In ITSMA, the seeded user sysadmin has full privileges of the suite and is responsible for suite administration from the ITSMA user
interface. We recommends that you configure a Suite Administrator user named sysadmin in ITOM CDF so that the same user can
administer the ITSMA suite from both the ITOM CDF and ITSMA user interfaces.

This section provides information on how to manage users.
1. Click ADMIN > User Management. The User page opens.

For each user, this page displays the user name, password, email, and user group.

ITOM CDF support two user groups: Administrators and Suite Administrators.
2. To create a user, click ADD. The following dialog box opens. Enter the relevant information, and click SAVE.



Create user

Administraters -

3. To delete a user, click the right-side ACTION icon for the user, select Delete, and then click Delete again to confirm the deletion.
4. To edit or view a user information, click the ACTION icon for the user, and then select View/Edit.

Monitor infrastructure status

The Infrastructure page displays:

®* Namespaces. The list of the current default namespaces as well as the namespaces for the suites. Every suite on the same Kubernetes
cluster is deployed in a different namespace.

®* Nodes. The composition of the Kubernetes cluster in terms of servers on which the cluster were installed (master and worker nodes, the
physical servers or the VMs).

® Persistent Volumes. The persistent volume configuration for one or more suites. These volumes contain the data that needs to live
outside of the containers.

To access, click ADMIN > Infrastructure.

Nodes

The Nodes page provides the node CPU and memory usage history, a list of the predefined labels, and a list of nodes.
To access, click ADMINISTRATION > Nodes.

View nodes
Add/delete labels
Manage node labels
Add a node

View the node details

View nodes

To view existing nodes:

1. Click ADMINISTRATION > Nodes. The following page opens.
2. The window displays the CPU and memory usage of the selected namespace during the past 15 minutes, a list of the node labels, and
the status, labels, readiness, and creation timestamps of the corresponding nodes. You can perform the following operations:
® Define a set of labels you want to use and then assign them to nodes by dragging them to the node.
® Add a node.
® Click REFRESH to refresh the display.
® Click a node to see its details.

Add/delete labels

® To add a label in the Predefined Labels area, enter the value and click [+]. The label is added to the list.
® To delete a label: in the Predefined Labels area, click [-] next to the relevant label.



Manage node labels

® To assign alabel to a node: drag the label from the Predefined Labels area to the node in the Nodes area.

® To unassign alabel: in the Nodes area, click [-] next to the label and node.

® To filter the labels: enter the relevant string or keyword in the Labels box in the table header. The labels with names that include the
relevant string are listed.

Add a node

To add a node:

1. Click + ADD in the Nodes area.
2. Enter the following information to add a worker node:
® the node's host name
® the name of a user that can remotely execute commands on the host
For non-root users, run the following command on the remote host you are adding before clicking ADD:

sudo visudo
Edit the file by adding the following line to the end:

<user name> ALL=(ALL) NOPASSWD: ALL

For example, if the user name is admin, add the following line:

admin ALL=(ALL) NOPASSWD: ALL

Comment out the Def aul t s requi retty setting in the file if it is there:

# Defaults requiretty
® the password of that user
®* THINPOOL_DEVICE

The THINPOOL_DEVICE parameter specifies the path to the Docker devicemapper storage driver.
®* FLANNEL_IFACE

The FLANNEL_IFACE parameter specifies the interface for Docker inter-host communication as a single IPv4 address or
interface name. This parameter is used when the nodes have more than one network adapter so that Flannel can set up the
correct routing table entries.

3. Click ADD to remotely install the extra node.

You can add multiple nodes simultaneously with + ADD:

® Enter multiple host names or IP addresses separated by a space.
® Enter the user name and password.

Those added nodes share the same user name and password. The installation of each node runs in parallel.

View the node details
In the Nodes area, select a node name from the list of nodes.
The top of the page displays the CPU and memory usage history of the selected node for the past 15 minutes.

The Details area displays details about the selected node, as well as system information.
The Allocated resources area displays the minimum CPU requests, CPU limits, memory requests, and memory limits for the container, as well
as the used and available percentage ratios of the CPU and memory resources.

The Conditions displays the type, status, last heartbeat, last transaction time, reason, and message.

The Pods area displays the CPU and memory usage history of the pod for the past 15 minutes, the name of the pod, the status, number of
restarts in the cycle, the amount of time that has elapsed since the pod was created, the cluster IP, as well as the CPU and memory usage of the
pod.

You can do the following:



® Click a Pod name to open the Workloads - Pods page for the pod.
® Click [text subject] icon

to review the pod log.
® Click [more actions] icon

and select Delete to delete the pod.

The Events area displays the message, source, sub-object, count, first seen and last seen information.

Manage licenses

The License page in ITOM Container Deployment Foundation (CDF) enables you to manage your suite licenses.

By default, there is no license installed. You can view the existing licenses only after you have installed them.

Activate a license

There are two ways to activate a suite license:
= Install the license file

1. Loginto ITOM CDF as admin.
2. Click SUITE > Management.
3. Click the more action icon

? Unknown Attachment

for the installed suite instance, and then select License > Install Licenses to open the following page:

| : ?:tveftgﬁsl?eackard AutoPass License Server Last Login Time: 10 Apr 17 07:10:31 UTC  User: admin | Logout

c; e £ ®
LICENSE USAGE LICENSE MANAGEMENT LICENSE REPORT 'CONFIGURATION ABOUT
Install Licenses View Licenses Archived Licenses License Clean Up
Install Licenses Lock Code: 3F47E83-25E30A0 @ ®
1. Please Enter/Browse License File 2. Install Licenses @ 1authorize Hewlett Packard Enterprise fo collect suite and product usage data.

Collection of suite/product usage data is governed by HPE privacy policy.
Choose File o file chosen License can also be redeemed on HPE Software Entitlement Porfal.

Add More Files ﬂ

OR
1. Activate Products Using Activation Code 2. Install Licenses

Enter Activation Code

“ Cenel

. Click Choose file to select the license file in your local system.

. Click Add More Files to select another license file in your local system.

. Accept the HPE End User License Agreement and authorize the suite and product usage data collecting.
. Click Next.

~N o oA

The following page opens:



a : ?::;lr;ﬁs?dﬂrd AutoPass License Server Last Login Time: 20 Apr 17 09:43:44 UTC  User: admin | Logout

(%% (%% o)
LICENSE USAGE LICENSE MANAGEMENT LICENSE REPORT CONFIGURATION
install Licenses View Licenses Archived Licenses License Clean Up
Install Licenses Lock Code: 708C9B2-7125284 @

1. Please Enter/Browse License File / Activate Products Using Activation Code 2. Install Licenses
“ Feature ID: Version Product Number LTU  Capacity Start Date Expiry Date Lock Code Remarks
5/ 10828:2 (UCMDB Foundation) ITSMA-UCMDB_P 10 10 26 Feb 17 10:15:54 UTC 27 Feb 20 10:04:37 UTC RRRE

3712:1 (720000259 ITSMA-CIT .70 HPE
@ IT Service Management Aufomation
Suite - Connect-If Base/DB/LDAP/Email
Connectors E-LTU CIT Default User)
37141 (720000259 ITSMA-CIT 970 HPE
@ IT Service Management Aufomation
Suite - Connect-If Base/DB/LDAPF/Email
Connectors E-LTU CIT Default Server)
37341 (720000259 ITSMA-CIT 970 HPE
@ IT Service Management Automation
Suite - Connect-If Base/DB/LDAP/Email

Install Licenses Back

You can select the appropriate license and click Install Licenses to install the license (you can also select to go back to the
previous Install Licenses page by clicking the Back button).

ITSMA-CIT_P 10 100 26 Feb 17 10:15:54 UTC 27 Feb 20 10:04:37 UTC e

ITSMA-CIT_P 10 100 26 Feb 17 10:15:54 UTC 27 Feb 20 10:04:37 UTC e

ITSMA-CIT_P 10 100 26 Feb 17 10:15:54 UTC 27 Feb 20 10:04:37 UTC e

The table below explains the fields of the license installation.

Fields Description

Feature ID: Version A feature ID version is a way of grouping and describing
different functionality that makes up a product.

Product Number Product's number which is given manually (SKU). For
example: ITSMA_Expr_30_Fixed_C1

Capacity Capacity is the field which indicates the actual quantity of a
license feature that the customer is entitled to.

Start Date The start date of the product license.
Expiry Date The expiry date of the product license.
Lock Code The lock code is unique for each ITOM Container

Deployment Foundation environment, and is used when
installing a license.

Remarks To take notice of the product license details.

8. The page displays the licenses in the selected file. You must select the licenses you want to install out of the
displayed licenses. After selecting, click Install Licenses. A message displays the number of licenses that were successfully
added.

Once the license is installed successfully, you can view the licenses.

« Enter the activation code
The Activation Code is a unigue code which is used to redeem licenses against an entitlement from a remote host at HPE.

The Activation Code is used for an automated entitlement process. Once an order is placed, the activation code for the product or suite is
provided via email.

This option is only available for a few products and suites at the moment. Customers who receive an activation code must also
redeem the licenses from the Entitlement Portal.

Once the Activation Code is entered in the AutoPass License Server (APLS), the licenses are automatically generated, based on your
entitlements.

The APLS must have an internet connection. Once the Activation Code is entered, the APLS establishes a connection to a remote HPE host



to generate and issue licenses.
Follow these steps to install a license:

1. Enter the activation code.
2. Click Next. The License Installation Wizard page opens.

There are three activation code types: Full, Partial and Fixed. You can distinguish the activation code from the
product number in the License Installation Wizard.

Example:
Full activation code shown in product number: HPE- | TSMA- PRODUCT- LAT- FULL
Partial activation code shown in product number: CAMOOPAEPC_PT_10

Fixed activation code shown in product number: HPE- | TSMA- PRODUCT- LAT- Fi xed
3. Check the boxes next to the license you want to install, then click Next.
® Enter the quantity manually for the Partial activation code.

You only need to input the activation quantity for the Partial activation code. The entered value should be
smaller than the available quantity value. For the Full/Fixed activation code, the quantity is disabled.
4. Select the appropriate environment from the drop-down list.

The table below explains the fields of the License Installation Wizard.

Fields Description

Product Number Product's number which is given manually (SKU). For
example: | TSVMA_Expr _30_Fi xed_C1

Product Name Product Name is the official name of the product. For
example: HPE- | TSMA_30_Fi xed_C1

Environment Environment displays a number of elements that
differentiate one environment from another.

For Example:
Production

Testing

Hot Stand By

Cold Stand By, etc.

Total Quantity The total quantity is quantity of licenses in general, not
taking into account how many are still available.

Available Quantity The license quantity that can be ordered.

Quantity to Activate Full: Quantity to Activate is equal to the available quantity,
so this field is disabled.

Partial: Enter the quantity of licenses that you want to
activate. This value must be less or equal to the available

quantity.

Fixed: Quantity to Activate is a fixed quantity, so this field is
disabled.

Remarks To take notice of the product license details.

5. Click Next. The requested quantity is activated. You are redirected to the License Management page.

The page displays the licenses in the selected file. You must select the licenses you want to install out of the displayed licenses. After
selecting, click Install Licenses. A message displays the number of licenses that were successfully added.



View licenses

Click SUITE > Management > [more action] icon

>License > View Licenses.
Select the relevant product in Select Product. The page displays the feature ID: version, product number,capacity, start date, expiry Date, the

date when it was installed, and who installed it, as well as the Lock Code.

Archive a license

1. In the View Licenses tab, select the unused licenses you want to archive.
2. Click Archive.

The licenses are removed from the list of installed licenses in the License Management table and become unavailable.

Restore an archived license

1. Inthe Archived License tab, select the product whose archived licenses you want to restore.
2. Select the relevant licenses that you want to restore.
3. Click Restore.

The licenses are again displayed in the License Management pane and customers can check them out.

If ID locked licenses are auto archived, they cannot be restored unless all the licenses locked to a lock value belonging to same feature
are either deleted or archived.

Delete a license from the License Manager

1. Inthe Archived Licenses tab, select the product whose licenses you want to delete.
2. Select the license to delete.
3. Click Delete and confirm the deletion.

View the Licenses Report

Click SUITE > Management > [more action] icon

>License > LICENSE REPORT.

LICENSE REPORT. The license report page tracks and displays the licenses currently installed and used on the License Manager. It also
displays specific check out information about a feature license including the product name and version, the requester ID, and the timestamp of

when it was accessed last.

You can export the license report details to Excel. You can also search a license with the product name, product version or requester IP address.
View the existing images

To view the existing images, click ADMINISTRATION > Local Registry. The following page is displayed.

This section lists the images that are in the local registry.

Manage Resourses

The RESOURCES menu enables you to deploy containerized applications to a Kubernetes cluster, troubleshoot them, and manage the cluster



and its resources itself. You can use it for getting an overview of applications running on the cluster, as well as for creating or modifying individual
Kubernetes resources and workloads, such as Daemon sets, Pet sets, Replica sets, Jobs, Replication controllers and corresponding Services, or
Pods.

It also provides information on the state of Pods, Replication controllers, etc. and on any errors that might have occurred. You can inspect and
manage the Kubernetes resources, as well as your deployed containerized applications. You can also change the number of replicated Pods,
delete Pods, and deploy new applications using a deploy wizard.

Namespace

Workloads

Services and discovery
Persistent Volume Claims
Configuration

Namespace

This section provides details about the selected Namespace.

Kubernetes supports multiple virtual clusters backed by the same physical cluster. These virtual clusters are called hamespaces.

Select the namespace

You select a namespace to filter the information in the pages of the Ul and display only the items related to the namespace.
1. Click RESOURCES > Namespace and select the relevant namespace.
The following page opens:

The page shows the CPU and memory usage history for the selected namespace, for the past 15 minutes, the name of the
namespace, its labels, pods, the timestamp of the creation of the namespace and its images.
2. Click the relevant namespace to display more details. See View the namespace details.

View the namespace details

click RESOURCES > Namespaces and select the relevant namespace. You can also click RESOURCES > Na
mespaces, and click the relevant namespace

The page shows details about the namespace and details about the events occurring in the namespace.
Workloads

This section displays information about Namespaces, Deployments, Replica Sets, Replication Controllers, Daemon Sets, Jobs, Pods, filtered by
the selected namespace.

Click RESOURCES > Workloads.

The page displays all the resources filtered by the selected namespace.
Pods

The Pods page provides information about the pods that are currently running or that have been running for the past 15 minutes. You can also
access details about a specific pod as well as its log.

By default, pods run with unbounded CPU and memory limits. This means that any pod in the system will be able to consume as much CPU and
memory on the node that executes the pod.


https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=12321006#Namespace-viewnamespacedetail

You may want to impose restrictions on the amount of resources a single pod in the system may consume for a variety of reasons.
See Glossary.
View the Pods

1. Click RESOURCES > Workloads > Pods.
The following page is displayed.
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The page displays the CPU and memory usage history of the namespace the pod belongs to, namespace the pod belongs to, the name,
status, number of restarts during the lifecycle of the pod, the amount of time passed since the creation of the pod, the IP address of the
pod, the CPU and memory usage of the pod itself in the last 15 minutes.

You can:

® Click

to display the log of a pod. See View log.
® Click

L
.
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and select to delete the pod or to view and edit its YAML. See Pods.
® Click a pod itself to display its details. See View pod details.

View pod details

1. Click RESOURCES > Workloads > Pods, and then click the relevant Pod.

The page displays the CPU and memory usage history of the pod in the last 15 minutes, the pod details, and the network details. To
display the log of the pod. See View log.

The page also displays information about the pod containers such as the name, image, environment variables, commands, arguments,
and more. To display the log of the container. See View log.

View log

1. Click RESOURCES > Workloads > Pods.
2. Click the relevant pod.
3. Click

in the Pod page or View logs in the Pod Details page or click View logs in the Container area. The page displays the information for the
pod.

You can use the following tools:

TT

® Toggles to change the size of the font used in the log.

A

® Toggles to change the colors of the log: white characters on black background or black characters on white background.
Logs from 10/31/16 723 AM 10 10/31/16 7:37 AM

®* The timestamp of the currently displayed log.

1< < > >



® Use the relevant buttons to navigate between logs.
Namespaces
The Namespaces page displays information about the existing namespaces, their labels, status, and age.

1. Click RESOURCES > Workloads > Namespaces.
2. The page displays the existing namespaces, their labels, status, and age.
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3. Click the relevant namespace to view more details:

The page shows details about the namespace and details about the events occurring in the core such as messages, source, count, first
seen and last seen.

Deployments

You create and manage sets of replicated containers (actually, replicated Pods) using Deployments.
A Deployment provides declarative updates for Pods and Replica Sets (the next-generation Replication Controller).

A Deployment simply ensures that a specified number of pod “replicas” are running at any one time. If there are too many, it will kill some. If there
are too few, it will start more.

You can select another namespace.

View the deployments

1. Click RESOURCES > Workloads > Deployments.
The following page is displayed:

The page displays the CPU and memory usage history of the selected namespace during the past 15 minutes, the name of the available
deployments, their labels, the number of pods, the creation timestamp of the deployment, and its images.

You can:

® Click a deployment to display its details. See View a deployment details.
® Click

and Delete, to delete the deployment.
® Click

and View/edit YAML, to view or edit a deployment.

View a deployment details

1. Click RESOURCES > Workloads > Deployments, and then click the relevant deployment.

The following page is displayed:
J__i |

The page displays the CPU and memory usage history of the selected deployment during the past 15 minutes, and details about the
selected deployment.



The page displays details about the new replica set, the old replica sets, and the events that took place.

Daemon Sets

The Daemon Sets page provides information about the Daemon Sets for the selected Namespace. See Glossary.

Replica Sets

Replica Set is the next-generation Replication Controller. The only difference between a ReplicaSet and a Replication Controller right now is the
selector support. ReplicaSet supports the new set-based selector requirements as described in the labels user guide whereas a Replication
Controller only supports equality-based selector requirements.

This section displays information about replica sets of the selected namespace. See Glossary.

View replica sets

1. Click RESOURCES > Workloads > Replica Sets.
The following page opens:

The page shows the CPU and memory usage history of the selected namespace during the past 15 minutes, the name of the available
replica sets for the selected namespace, its labels, pods, images and creation timestamp.

You can:

® Click a replica set to display its details. See View a replica set details.
® Click

and Delete, to delete the replica set.
® Click

and View/edit YAML, to edit the replica set.

View areplica set details

1. Click RESOURCES > Workloads > Replica Sets.
2. Click the relevant replica set.

[P . . . e . [r— .

The details page shows details about the selected replica set, the services (see Services), pods (see Pods), and events related to the
replica set.

Replication controllers

The Replication Controllers page provides details about the Replication Controllers.
See Glossary.
View the Replication Controllers

1. Click RESOURCES > Workloads > Replication Controllers to display the current Replication Controllers.
The following page is displayed.
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The page displays the CPU and memory usage of the selected namespace during the past 15 minutes, and the list of replication

controllers with their name, labels, pods, age, and images of the replication controllers associated with the selected namespace.
You can:

® Click the relevant replication controller to view its details. See View the replication controller details.
® Click

and select:

View details. You can also click the relevant replication controller. See Scale the number of pods linked to the replication
controller.

Scale. See View the replication controller details.
View/edit YAML You can edit a Replication Controller.
Delete. The replication controller is deleted.

Scale the number of pods linked to the replication controller

1. Click RESOURCES > Workloads > Replication Controllers , click
and then select Scale. Enter the relevant number of pods and click OK.

View the replication controller details

1. click RESOURCES > Workloads > Replication Controllers.
2. Click

and select View details, or click the relevant Replication Controllers.

The following page opens.

It displays the CPU and memory usage history of the selected replication controller for the past 15 minutes, the details of the selected
replication controller, and the services provided by the selected replication controller.

Pet Sets

The Pet Sets page provides information about pet sets. See Glossary.

Jobs

The Jobs page provides information about jobs. See Glossary.
Services and discovery

Click Services and discovery to display information about:

® Services
® Ingress

Services
The Services page provides information about services.

View services

1. Click RESOURCES > Services and Discovery > Services .
The following page is displayed.
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The page displays the name of the services attached to the selected namespace, the labels assigned to the service, the IP address of the
related cluster, and the internal and external endpoints.
You can:

® Click
and select Delete to delete the service.
® Click
and select View/edit YAML to edit the service.
® Click the relevant service to display its details. See View a Service Details.

View service details

1. Click RESOURCES > Services and Discovery > Services , and then click the relevant Service.
The following page is displayed:

a Resource Details

Details Connection

app:autopass-im-app
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The page displays details about the service and the connection as well as information about the related pods.

Ingress
The Ingress page provides details about the ingresses. See Glossary.

View ingresses

1. Click RESOURCES > Services and Discovery > Ingress.
The following page is displayed.

(D Broken image
The page displays the names of the ingresses attached to the selected namespace, the labels assigned to the ingress, the IP of the

related cluster, and the internal and external endpoints.
You can click the relevant ingress to display its details. See View an Ingress Details.

View an Ingress Details

Click RESOURCES > Services and discovery > Ingress, and then click the relevant Ingress.
The following page is displayed:

(D Broken image



The page displays details of the selected ingress and its related pods.
Persistent Volume Claims

The Persistent Volume Claims page displays information about the currently running persistent volumes.

A persistent volume claim is bound to a persistent volume. The claim is subsequently used inside a container volume specification. This provides
volume technology abstraction for the suite deployment as suites request size and access type rather than a certain specific storage provider.

A volume is a directory, possibly with some data in it, which is accessible to the containers in a pod.

See Glossary.

View the Persistent Volume Claims

1. click RESOURCES > Persistent Volume Claims. The following page opens:

The page displays the name of the persistent volume, the volume it belongs to, the labels, and the timestamp of the creation of the
persistent volume.

Each suite will have at least one persistent volume but may have more depending on the suite.

You can click the relevant volume to display its details. See View a persistent volume claim details.

View a persistent volume claim details

1. Click RESOURCES > Persistent Volume Claims, and then click the relevant Persistent Volume Claims. The page that opens displays
detailed information about the persistent volume claim.

To see the contents of itom-vol, go to the master node (the NFS server) and enter cd /var/vols/itom/. It contains the baseinfra-<versi
on-number> and the suite-install subdirectories.

Enter Is -R baseinfra-<version-number>; this shows the PrivateRegistry.

Enter Is -R suite-install/; this shows information about the containers that includes the configuration information to deploy the
supported suites.

Configuration

Click RESOURCES > Configuration to display information about:

® Secrets. See Secrets.
® Config Maps. See Config Maps.

Secrets

The Secrets page provides information about Secrets that are currently running.
See Glossary.

View the Secrets

click RESOURCES > Configuration > Secrets.
The following page opens:

The page displays the list of secrets and their age. You can click the relevant secret to display its details. See View a Secret details.

View a Secret details



Click RESOURCES > Configuration >Secrets. In the page that opens, click the relevant secret.

The page displays the details of the selected secret and its data.

Config Maps

The Config Maps page provides information about the config maps that are currently running.

See Glossary.

View the Config Maps

1. Click RESOURCES > Configuration > Config Maps.The following page opens:

" 1

The page opened displays the names of the configuration map and its labels, and the amount of time passed since the configuration map
was created.
You can:

® Click
.

and select Delete to delete the config map.
® Click
Ll

and select View/edit YAML to edit the config map.
® Click the relevant config map to display its details. See View a Config Map details.

View a Config Map details

1. Click RESOURCES > Configuration > Config Maps to display the currently running Config Maps.
2. In the page that opens, click the relevant name.
The following page opens:

The page opened displays the selected config map details, and its related data.

Security

This section is intended for ITOM Container Deployment Foundation (CDF) implementers and system administrators who need to implement
their ITOM CDF environment in a secure manner.

Secure implementation and deployment

This section provides information on implementing and deploying the ITOM Container Deployment Foundation (CDF) in a secure manner.

Technical system landscape

ITOM CDF is a container that integrates with other Suites. ITOM CDF is written in Java and JavaScript and Go.

For more information about typical deployment schemes and options, see Overview of HPE ITOM CDF.

Security in ITOM CDF configurations

ITOM CDF configurations may be deployed in the following three implementations. See Overview of HPE ITOM CDF.

® Single mode.


https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=10752474
https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=10752474

® Distributed mode 1 (one master node and multiple worker nodes)
® Distributed mode 2 (multiple master nodes and multiple worker nodes)

All of these implementations share the same basic out-of-the-box security configuration options.

1. In an out-of-the-box default installation, the Transport Layer Security/Secure Socket Layer (TLS/SSL) security is enabled between the
browser and the ITOM CDF server by default.

2. In an out-of-the-box default installation, ITOM CDF requires users to enter username and password credentials to gain access to the
application.

External Authentication

With additional configuration, it is possible to supplement or replace the default authentication & authorization provider for ITOM CDF by using a
variety of industry-standard protocols and tools such as LDAP and Single Sign-On.

Common security considerations

ITOM CDF can only be deployed on supported operating systems.

It is recommended to follow vendor-provided best practices and security hardening guides for each of the third-party components used in support
of your ITOM CDF deployment, which includes Docker, Kubernetes, Vault and Nginx, NFS. Below are some resources that can serve as a
starting point for researching these recommended security considerations:

Docker Security Tips
https://www.docker.com/docker-security
Kubernetes Security Tips
http://kubernetes.io/docs/troubleshooting/
Vault Security Tips
https://www.hashicorp.com/security.html
Nginx Security Tips
http://nginx.org/en/security_advisories.html
NFS Security Tips
http://www.cert.org/historical/advisories/

ITOM CDF security parameters

This section contains reference to some of ITOM Container Deployment Foundation (CDF) parameters that are relevant to security.

Secure file storage

ITOM CDF allows users to upload files (suite installation binary) to the ITOM CDF Server. All files uploaded to the server must be validated, since
they can contain viruses, malicious code, or Trojans.

As a result, it is strongly recommended to implement proper antivirus protection for the file storage.

Installation security

This section provides information on aspects of installation security.

Supported operating systems

See Support matrix.

Harden SSH on OS

On each node, the SSH server is configured with weak cipher and weak KexAlgorithms by default.
Set the values of KexAlgorithms, Ciphers and MACs in file: /etc/ssh/sshd_config as follows:

® KexAlgorithms ecdh-sha2-nistp521,ecdh-sha2-nistp384,ecdh-sha2-nistp256
® Ciphers aes256-gcm@openssh.com,aes128-gcm@openssh.com,aes256-ctr,aes192-ctr,aes128-ctr
® MACs hmac-sha2-256


https://www.docker.com/docker-security
http://kubernetes.io/docs/troubleshooting/
https://www.hashicorp.com/security.html
http://nginx.org/en/security_advisories.html
http://www.cert.org/historical/advisories/
https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=10752490

Database security recommendations

For PostgreSQL, see http://www.openscg.com/postgresql-security-guidelines/ for information about PostgreSQL database security solutions.

Application server security recommendations

Always change default passwords.

Always use the minimal possible permissions when installing and running ITOM Container Deployment Foundation (CDF).

Action Permissions needed for user

Installing or running the HPE ITOM CDF You must install and run root permissions using the sudo command.

Network and communication

Secure topology

ITOM Container Deployment Foundation (CDF) is designed to be part of a secure architecture and to deal with the security threats to which it
could potentially be exposed.

To securely deploy the CDF, we recommends that you use the TLS/SSL communication protocol.

Replace the ingress service certificate with a custom certificate

To replace the certificate and private key of Ingress Service with a custom certificate and private key, follow these steps:

1. Generate a certificate and private key for the host on which the ingress service is running. Save the certificate and key on the master
node.

2. On the master node, run the following command to delete a secret:
kubectl delete secret nginx-default-secret -n core

3. On the master node, run the following commands to recreate the secret with the new certificate and private key:

You must keep the format of the following commands as it is, especially the indented spaces.

i echo i
f api Version: vl f
. kind: Secret ;
. netadat a:

© name: nginx-default-secret g
. nanespace: core |
i data: f
: tls.crt: “~base64 -w 0 $K8S_HOVE/ ssl/ ${host Name}.crt"

i tls.key: “base64 -w 0 $K8S HOVE/ ssl/ ${ host Name}. key" i
i "] kubectl create -f - i

4. On the master node, run the following commands to delete and recreate the ingress service.
kubectl delete -f ${K8S_HOME}/objectdefs/nginx-ingress.yaml|
kubectl create -f ${K8S_HOME}/objectdefs/nginx-ingress.yaml

Renew the client.crt, client.key, server.crt, and server.key certificates

You cannot replace these certificate files with your own. When these certificates expire, you must renew them.
To renew the certificates, follow these steps:

1. Generate new server certificates or client certificates with the following commands:


http://www.openscg.com/postgresql-security-guidelines/

cd $<K8S_HOME>/scripts

IrenewCert.sh
2. Copy the new server certificates or client certificates to other nodes.
a. Copy the server certificates (server.crt, server.key, client.crt, and client.key) to other master nodes.
b. Copy the client certificates (client.crt and client.key) to the worker nodes.
3. Restart the kubelete service with the following commands:
4. cd $<K8S_HOME>/bin

. kube-restart.sh
5. Run the following commands to delete three default tokens in the core, default, and suite namespaces:

kubectl get secrets --all-namespaces

kubectl get delete secret xxxx -n default-token-xxxx
6. Run the following commands to recreate the yaml files:

cd $<K8S_HOME>/objectives
kubectl delete -f kube-vault.yaml
kubectl delete -f mng-portal.yaml
kubectl delete -f nginx-ingress.yaml
kubectl create -f kube-vault.yaml
kubectl create -f mng-portal.yaml
kubectl create -f nginx-ingress.yaml

kubectl delete -f ingress yaml
7. Run the following commands to recreate the suite ingress yaml file:

cd /var/vols/itom/core/suite-install/<suite_ingress _yaml_directory>/objectives
kubectl delete -f xxxx-nginx-ingress.yaml

kubectl create -f xxxx-nginx-ingress.yam|

Security recommendations

We recommend that you add the following iptables rules.

Apart from the listed ports, all other ports should be blocked at the localhost level.

Target server to configure  Required ports Service Direction Short description

the rules

NFS server 111 NFS Nodes -> NFS Server NFS server port access by
all nodes

NFS server 2049 NFS Nodes -> NFS Server NFS server port access by
all nodes

Master Node 2380 Etcd Master <-> Master Etcd service port for etcd

cluster communication

Master Node 4001 Etcd Nodes -> Master Etcd service port for
connection from client

Ingress Node 5443 MngPortal All -> Ingress Node The port exposed on ingress
node. All clients could
access this port

Master Node 8200 Vault Nodes->Master Vault port for client
connection

Master Node 8201 Vault Nodes->Master Vault port for peer member
connection

Master Node 8443 Kubernetes Nodes -> Master API server port for client
connection

All Nodes in Cluster 10250 Kubernetes Nodes -> Nodes Kubernete port for internal

communication



All Nodes in Cluster 10251 Kubernetes Nodes -> Nodes Kubernete port for internal
communication

All Nodes in Cluster 10252 Kubernetes Nodes -> Nodes Kubernete port for internal
communication

All Nodes in Cluster 10255 Kubernetes Nodes -> Nodes Kubernete port for internal
communication

NFS server 20048 NFS Nodes -> NFS Server NFS server port access by
all nodes

Example:

Assume that the cluster is installed on 10.10.10.10, 10.10.10.11, 10.10.10.12, and the master node is installed on: 10.10.10.10. In this example. t
0 add iptable rules to port 8443 on the master node, you run the following commands:

iptables -l INPUT 1 -p tcp -m tcp -s 0.0.0.0/0 --dport 8443 -j DROP
iptables -1 INPUT 1 -p tcp -s 127.0.0.1 --dport 8443 -j ACCEPT
iptables -1 INPUT 1 -p tcp -s 10.10.10.10 --dport 8443 -j ACCEPT
iptables -1 INPUT 1 -p tcp -s 10.10.10.11 --dport 8443 -j ACCEPT

iptables -1 INPUT 1 -p tcp -s 10.10.10.12 --dport 8443 -j ACCEPT

Authorization

This section provides information related to user authorization in ITOM Container Deployment Foundation (CDF).

Authorization model

Access to ITOM CDF resources is authorized based on the user’s following settings:

® User name
® Session and inactivity timer timeouts

FAQ

Question
Can ITOM CDF inherit users’ information and authorization profiles from an external repository, such as LDAP?
Answer

No.

Data integrity

The database server is used as a simple data store and is responsible for all persistent storage. While the database contains definitions
describing business logic, no processing is actually performed in this tier, other than create, read, update, and delete (CRUD) operations in

response to requests from ITOM Container Deployment Foundation (CDF). Referential integrity is enforced by the application, thereby protecting
transactions. In addition, the database captures a complete audit log of all changes to data.

The data backup procedure is also an integral part of data integrity and while ITOM CDF does not provide native backup capabilities, the following
guidelines should be considered:

® Database backup is especially important before critical actions such as upgrades.

® Backup files should be stored properly according to the industry best practices to avoid unauthorized access.

® Since database backup can be a resource intensive process, it is strongly recommended to avoid running backups during peak demand
times.

Enable firewall on a running node

Follow the steps below on each running node to enable firewall.

On the NFS server

Run the following commands to enable firewall on the NFS server.



systemctl start firewalld;systemctl enable firewalld
firewall-cmd --permanent --add-port=111/udp
firewall-cmd --permanent --add-port=111/tcp
firewall-cmd --permanent --add-port=2049/tcp
firewall-cmd --permanent --add-port=20048/tcp
firewall-cmd --reload

On the running master nodes

Run the following commands to enable firewall on each running master node.

systemctl start firewalld; systemctl enable firewalld

firewall-cmd --permanent --add-port=4001/tcp

firewall-cmd --permanent --add-port=2380/tcp

firewall-cmd --permanent --add-port=8200/tcp

firewall-cmd --permanent --add-port=8201/tcp

firewall-cmd --permanent --add-port=8443/tcp

firewall-cmd --permanent --add-port=10250/tcp

firewall-cmd --permanent--direct --add-rule ipv4 filter FORWARD 1 -o docker0 -j ACCEPT -m comment --comment "docker subnet"
firewall-cmd --permanent --direct --add-rule ipv4 filter INPUT 1 -i docker0 -j ACCEPT -m comment --comment 'kube-proxy redirects'
firewall-cmd --reload

On the running worker nodes

Run the following commands to enable firewall on each running worker node.

systemctl start firewalld; systemctl enable firewalld

firewall-cmd --permanent --add-port=10250/tcp

firewall-cmd --permanent--direct --add-rule ipv4 filter FORWARD 1 -o docker0 -j ACCEPT -m comment --comment "docker subnet"
firewall-cmd --permanent --direct --add-rule ipv4 filter INPUT 1 -i docker0 -j ACCEPT -m comment --comment 'kube-proxy redirects'
firewall-cmd --reload

Data backup for the single-master cluster
To back up the data in the dat a directory for the single-master cluster, use the et cdct| backup command.

For example:
etcdct!| backup \

--data-dir %ata_dir%\
--backup-dir %ackup_data_dir%
You can also use the et cdct | backup command to back up all the exported folders in the NFS server too.

The et cdct| backup command will rewrite some of metadata contained in the backup (specifically, the node ID and cluster ID), which means
that the node will lose its former identity.

In order to recreate a cluster from the backup, you will need to start a new, single-node cluster. The metadata is rewritten to prevent the
new node from inadvertently being joined onto an existing cluster.

Encryption

This section provides information on data encryption in ITOM Container Deployment Foundation (CDF).

TLS/SSL Data Transmission

ITOM CDF was configured to use TLS/SSL to transmit data between the server and browsers.
Customers can change the default value of SSL CIPHER through the following steps:

1. On the master node, change the ssl-ciphers value in file $K8S_HOME/objectdefs/nginx-ingress.yaml.
2. Recreate the ingress container with the commands below:
kubectl delete -f $K8S_HOME/objectdefs/nginx-ingress.yaml



kubectl create -f $K8S_HOME/objectdefs/nginx-ingress.yaml

Encryption of stored database fields

ITOM CDF uses proprietary algorithms when encrypting data stored in the database and uses HPE Identity Manager (IDM) to manage user
passwords.

Docker logs

This section provides information related to docker logs.

Log and Trace Model

Recommendations:

® Pay attention to the log level and do not leave tracing or debug parameters enabled unnecessarily.
® Pay attention to log rotation/switching.

Log rotation

The CDF supports the log rotation. By default, the maximum log file size is 10 MB, and the maximum number of the log file is 5. You can also
change the maximum log file size and maximum log file number with the following steps.

1. Open the docker file with the following commands.
cd /opt/kubernetes/cfg

vi m docker
2. Change the value of max- si ze and nax- fi | e in the parameter DOCKER_LOG_OPTS.

For example:

DOCKER_LOG OPTS="--1o0g-driver=json-file --10g-opt

| abel s=i 0. kuber net es. cont ai ner. nane, i 0. kuber netes. pod. uid --1o0g-opt nmax-size=12m - -1 og- opt
mex-fil e=6"

3. Restart Docker to enable the changes with the following command:
systenctl restart docker

The default maximum log size number and maximum log file number is recommended. Do not set a large number for the max- si ze an
d max-fil e. Too large maximum size and maximum file number may affect the free disk size.

Network and Communication Security

HPE recommends that you add iptables rules listed below.

The ports in this topic are the pods for CDF. For the ports specific to ITSMA suite, see ITSMA node ports.

Apart from the listed ports, all other ports should be blocked at the localhost level.

Target server to configure  Required ports Service Direction Short description

the rules

NFS server 111 NFS Nodes -> NFS Server NFS server port access by
all nodes

NFS server 2049 NFS Nodes -> NFS Server NFS server port access by
all nodes

Master Node 2380 Etcd Master <-> Master Etcd service port for etcd

cluster communication

Master Node 4001 Etcd Nodes -> Master Etcd service port for
connection from client


https://docs.software.hpe.com/wiki/display/ITSMA201707/ITSMA+node+ports

Ingress Node 5443 MngPortal All -> Ingress Node

Master Node 8200 Vault Nodes->Master
Master Node 8201 Vault Nodes->Master
Master Node 8443 Kubernetes Nodes -> Master

All Nodes in Cluster 10250 Kubernetes Nodes -> Nodes

All Nodes in Cluster 10251 Kubernetes Nodes -> Nodes

All Nodes in Cluster 10252 Kubernetes Nodes -> Nodes

All Nodes in Cluster 10255 Kubernetes Nodes -> Nodes
NFS server 20048 NFS Nodes -> NFS Server
Example:

The cluster is installed on 10.10.10.10, 10.10.10.11, 10.10.10.12, and the master node is on: 10.10.10.10 .

To add iptable rules to port 8443 on the master node, do the following:

iptables -1 INPUT 1 -p tcp -mtcp -s 0.0.0.0/0 --dport 8443 -j DROP
iptables -1 INPUT 1 -p tcp -s 127.0.0.1 --dport 8443 -j ACCEPT
iptables -1 INPUT 1 -p tcp -s 10.10.10.10 --dport 8443 -j ACCEPT
iptables -1 INPUT 1 -p tcp -s 10.10.10.11 --dport 8443 -j ACCEPT
iptables -1 INPUT 1 -p tcp -s 10.10.10.12 --dport 8443 -j ACCEPT

Restart ITOM CDF

To restart ITOM Container Deployment Foundation (CDF), stop and then start it.
Follow the steps below to stop ITOM
1. On the master node:
cd $K8S_HOVE/ bi n

. I kube- st op. sh
2. On each worker node:

cd $K8S_HOVE/ bi n
./ kube- st op. sh
Follow the steps below to start ITOM CDF:

1. On the master node:
cd $K8S_HOVE/ bi n

./ kube-start. sh
2. On each worker node:

cd $K8S_HOVE/ bi n

./ kube-start.sh

Download and upload suite images

The port exposed on ingress
node. All clients could
access this port

Vault port for client
connection

Vault port for peer member
connection

API server port for client
connection

Kubernete port for internal
communication

Kubernete port for internal
communication

Kubernete port for internal
communication

Kubernete port for internal
communication

NFS server port access by
all nodes



You can download suite images from Docker Hub and then upload the images to ITOM Container Deployment Foundation (CDF). For details, see
Download ITSMA images from Docker Hub to CDF.

Customize the parameters for kubelet

You can modify the default values of the kubelet parameters and add some customized parameters for kubelet. Follow the steps below to
customize the parameters.

Follow these steps:

1. Log on to any of the cluster node.
2. Edit or add the parameters in the kubel et . servi ce under the / usr/ | i b/ syst end/ syst endirectory.
3. Run the following commands to restart the kubelet:

systemctl daemon-reload

systemctl restart kubelet

Modify the external database configuration

You can modify the external database configuration with the following command: $K8S_HOVE/ bi n/ updat eExt er nal Dbl nf o

Example Usage:
Usage: $updat eExternal Dblnfo <-t|--dbtype <DB type>> <-u|--user <usernane>> <-H| --host <DB host>>
<-p|--port <DB port>> <-d|--dbnane <DB nane>>

or updat eExternal Dbl nfo <-t|--dbtype <DB type>> <-u|--user <username>> <-U --url <DB connection URL>>
-u| --user External database usernane.

-H --host External database host.

-p|--port External database port.

-d| --dbnane External database nane.

-U --url External database connection URL.

-t|--dbtype External database type, optional choices are ("EMBEDDED',"EXTERNAL_PG', "EXTERNAL_ORA") . The
dat abase type nmust be capitalized.

-h| --hel p Show hel p.

When you modified any external default database configuration, you must recreate the IDM pod with the following commands:
kubect| delete -f $K8S_HOVE/ obj ectdefs/idm yan

kubect| create -f $K8S_HOVE/ obj ect def s/i dm yani
Create or modify security groups in AWS

If you deploy ITSMA in a cloud-based environment, three security groups will be configured for the Virtual Private Cloud (VPC) after ITSMA is
successfully deployed on Amazon Web Services (AWS). These security groups provide access to the instances in the VPC. They act as a firewall
for the associated instances to control both inbound and outbound traffic at the instance level.

Group Name Pattern Target
${aws_resource_prefix}-master-sg master nodes
${aws_resource_prefix}-worker-sg = worker nodes

${aws_resource_prefix}-efs-sg EFS

For example, if you use "itom-itsmal" as the deployment name prefix, you will find security groups "itom-itsmal-master-sg",
"itom-itsmal-worker-sg", and "itom-itsmal-efs_sg".

Usually, you do not need to modify these security groups, as they allow access to ITSMA by default. However, if you do need to modify the
security group settings, follow these steps:

1. Log into the AWS console.

2. Click VPC.

3. On the left-hand menu, click Security Group.

4. Create a new security group or modify the existing security group as required.

For more information about AWS security groups, refer to the following Amazon website:


https://docs.software.hpe.com/wiki/display/ITSMA201707/Download+ITSMA+images+from+Docker+Hub+to+CDF

Amazon EC2 Security Groups for Linux Instances

Administer the ITSMA suite

The Suite Administrator user role can perform the following administration tasks.

Install an ITSMA suite license
Configure LDAP

Import master data

Configure Email

Replace the certificate for ITSMA
Configure SAML SSO

Configure the Service Portal mobile app
Configure log level for debugging
Change the ITSMA suite administrator password
Service Portal administration

Smart Analytics administration

Install an ITSMA suite license

A license for ITOM Container Deployment Foundation (CDF) is included in each suite license. Each ITSMA suite license includes a license key for
each of the suite components. When ITSMA is running in fully containerized mode, a suite license is required; when running in mixed mode, a
suite license may or may not be required depending on the actual situation.

Deployment mode based licensing

The following licensing rules apply for ITSMA NG Express 2017.07.
For more information about the deployment modes, see Deployment modes.
Fully containerized mode

When running in fully containerized mode, ITSMA requires an ITSMA suite license. ITSMA comes with a 21-day trial license. After the trail period,
you must purchase and activate a perpetual license.

Mixed mode

For mixed mode scenario 2, an ITSMA suite license is required and UCMDB requires a license of its own. For mixed mode scenario 1, no suite
license is required.

Additionally, you can optionally purchase a Smart Analytics license according to your business needs:

® |f without a Smart Analytics license: IDOL-based search is enabled for Service Portal users; however, the following features are disabled
in Service Management: Smart Ticketing, Hot Topic Analytics (HTA), OCR, Smart Search, and Smart Analytics related features in Virtual
Agent and Smart Email (that is, automatically proposing knowledge articles or service catalog offerings).

® |f with a Smart Analytics license: all Smart Analytics related features listed above are enabled.

The Virtual Agent feature in Service Portal is enabled regardless of whether the system has a Smart Analytics license installed.

Activate an ITSMA suite license

License menu option

Once ITSMA is installed, you can locate the installed ITSMA instance from the ITOM CDF user interface (Suite > Management) and
then access the License menu option from its more action icon. You must use the License menu option to install and manage suite
licenses.

To activate an ITSMA license, follow these steps:

1. Install your ITSMA license. For details, see the license installation section in Manage licenses.
2. Restart the Service Management RTE deployments:

a. Click RESOURCES, and then select your <namespace>. For example, itsmal.

b. Click Workloads > Deployments, and then locate one of the following deployments:

sm-rte
sm-rte-integration
sm-rte-irque


http://docs.aws.amazon.com/AWSEC2/latest/UserGuide/using-network-security.html
https://docs.software.hpe.com/wiki/display/ITSMA201707/Deployment+modes

sm-rte-scheduler
sm-rte-emailout
sm-rte-integration-cit
sm-rte-report-export
sm-rte-gossip

The sm-rte-gossip deployment must be the last one to stop. No sequence is required for the rest of the deployments.

c. Click the more action icon (
*

), and then click View/edit YAML.

d. Locate "replicas" under "spec”, and then do the following:

i. Make a note of the current value. You will need to use the value when you start the pod again later in step g.

ii. Setthe value to 0.

iii. Click the UPDATE button.
e. Repeat the steps above to stop all the deployments listed in step b. The sm-rte-gossip deployment must be the last one to stop.
Wait until the Pods field for each deployment is changed to 0/0.
g. Change the value of "replicas" in the YAML from 0 to the original number for all the deployments listed in step b.

—h

You must start the sm-rte-gossip deployment first. No sequence is required for the rest of the deployments.

Configure LDAP

See the following topics for LDAP related configurations for ITSMA NG Express:

® Configure an external LDAP server

® Configure LDAP for CMDB

® Configure LDAP for Service Portal

® Configure users in the internal LDAP server

Configure an external LDAP server

User role: Suite Administrator

The ITSMA suite must be integrated with an LDAP server for user authentication. All LDAP servers are supported, including OpenLDAP
and Microsoft Active Directory.

The ITSMA LDAP settings fall into these categories: LDAP Server Settings, LDAP User Attributes, LDAP Group Attributes, and Group Mappings.
You have the option to configure LDAP either during installation or after installation (by using the Suite Configuration utility). The LDAP settings
that you see during installation and after installation are basically the same. However, Group Mappings available during installation are not
available in the Suite Configuration user interface.

Additionally, ITSMA supports SAML 2.0 based single sign-on (SAML SSO), which relies on correct LDAP configuration to work, and therefore the
LDAP configuration page in the Suite Configuration user interface also contains a SAML 2.0 Configuration section. If you do not want to enable
SAML, ignore SAML configuration fields on this page.

The ITSMA suite has a seeded user account named sysadmin, which is stored in ITSMA's |dM database. This user has super
administrator privileges for the suite. For this reason, make sure that your external LDAP server does NOT contain a sysadmin user
account.

This topic describes the steps to configure an external LDAP server after installation by using the Suite Configuration utility. For information about
how to configure LDAP during installation, see Run the Suite Installer.

To configure an external LDAP server, follow these steps:

1. Open the Suite Configuration utility. For details, see Access ITSMA capabilities.
2. Navigate to Configuration > Accounts > LDAP & SAML.
3. Optional. Select one of the following options according to your own LDAP server: OpenLDAP, Active Directory, or Other LDAP.

A default value is provided for certain LDAP fields if OpenLDAP or Active Directory is selected.
4. Configure your external LDAP server settings as described in the following tables. All fields are mandatory unless otherwise specified.

LDAP Server Settings


https://docs.software.hpe.com/wiki/display/ITSMA201707/Run+the+Suite+Installer
https://docs.software.hpe.com/wiki/display/ITSMA201707/Access+ITSMA+capabilities

Field

Host

Port

Base DN

User ID (Full DN)

Password

Enable SSL

Search Subtree

LDAP User Attributes

Field

User Base DN

User Class

User Filter

Description

The fully-qualified domain name
(server.domain.com) or IP address of the
LDAP server.

The port used to connect to the LDAP
server (by default, 389).

Base distinguished name. The Base DN is
the top level of the LDAP directory that is
used as the basis of a search.

The fully distinguished name of any user
with authentication rights to the LDAP
server.

Password of the User ID. If the LDAP
server does not require a User ID or
password for authentication, this value
can be omitted.

If your LDAP server is configured to
require Idaps (LDAP over SSL), select
the Enable SSL checkbox.

When a user logs in, the LDAP directory
is queried to find the user's account. The
Search Subtree setting controls the
depth of the search under User
Searchbase.

If you want to search for a matching user
in the User Searchbase and all subtrees
under the User Searchbase, make sure
the Search Subtree checkbox is
selected.

If you want to restrict the search for a
matching user to only the User
Searchbase, excluding any subtrees,
unselect the Search Subtree checkbox.

Description

Base distinguished name for the User
object. The User Base DN is the top level
of the LDAP directory that is used as the
basis of a search for the User object.

Value of objectClass that is used to
identify the user.

Specifies the general form of the LDAP
query used to identify users during login.
It must include the pattern {0}, which
represents the user name entered by the
user when logging in.

The filter must use the following format:
(&(objectclass=*)(cn=falcon))

OpenLDAP default value

389

dc=itsma,dc=com

cn=admin,dc=itsma,dc=com

OpenLDAP example value

ou=people,dc=itsma,dc=com

inetOrgPerson

(objectclass=inetOrgPerson)



First Name

Last Name

User Display Name

User Name Attributes

User Email

Phone Number

User Avatar

Manager Identifier

Manager Identifier Value

Optional field.

First name of the user.

Optional field.

Last name of the user.

The display name of the user.

The name of the attribute of a user object
that contains the username that will be
used to log in. The value for this field can
be determined by looking at one or more
user objects in the LDAP directory to
determine which attribute consistently
contains a unique user name. Often, you
will want a User Name Attribute whose
value in a user object is an email address.

The email address of the user.

Optional field.

Business phone number of the user.

Optional field.

The LDAP attribute whose value is the
URL to a user avatar image that is
displayed for the logged-in user. If no
avatar is specified, a default avatar image
is used.

Optional field.

The name of the attribute of a user object
that identifies the manager of the user.

Optional field.

The name of the attribute of a user object
that describes the value of the Manager
Identifier's attribute. For example, if the
value of the Manager Identifier attribute is
a distinguished name (such as cn=John
Smith, ou=People, o=xyz.com) then the
value of this field could

be dn (distinguished name). Or, if

the Manager Identifier is an email address
(such as admin@xyz.com) then the
value of this field could be email.

givenName

sn

cn

uid

mail

telephoneNumber

jpegPhoto

manager

dn



Last Modified

LDAP Group Attributes

Field

Group Base DN

Group Class

Group Filter

Group Display Name

Group Membership

Optional field.

The LDAP attribute that stores the
timestamp when an object was last
updated.

Description

Base distinguished name for the Group
object. The Group Base DN is the top
level of the LDAP directory that is used as
the basis of a search for the Group object.

Value of objectClass that is used to
identify the Group object.

Specifies the general form of the LDAP
query used to identify user groups during
login. It must use a standard search filter
syntax for your LDAP server.

The display name of the user group.

The name of the attribute(s) of a group
object that identifies a user as belonging
to the group. If multiple attributes convey
group membership, the attribute names
should be separated by a comma.

modifyTimestamp (for OpenLDAP)

whenChanged (for Active Directory)

OpenLDAP example value

ou=groups,dc=itsma,dc=com

groupOfUniqueNames

(objectclass=groupOfUniqueNames)

cn

uniqueMember

Skip SAML configuration at this point. Configure SAML SSO after you complete the LDAP configuration. For details, see Config
ure SAML SSO.

5. If you selected the Enable SSL option, before you apply the LDAP configuration, copy the LDAP CA certificate file to the {itsma_global_
volume}/certificate/ca-trust/ folder, where {itsma_global_volume} is the ITSMA global NFS volume (see Set up three NFS shares for
ITSMA). For example: /var/vols/itom/itsma/itsma-itsma-global/certificate/ca-trust/. Note that UCMDB only supports importing a certificate
file whose extension is “.crt”, which means you need to convert or rename the certificate file to that format.

6. Click Test to make sure all settings are correct.

All LDAP settings are validated, and an error message is displayed if a validation fails.

7. Click Apply to save your configuration.

After you apply the changes, the system restarts the related services.
8. Wait until the background services restart.
ITSMA automatically updates the LDAP mapping settings in Service Management, Service Portal, and CMDB according to your
configuration.
9. Go to Service Management, Service Portal, and CMDB to check the LDAP settings, and perform additional configurations:
® Configure LDAP for Service Portal
® Configure LDAP for CMDB
10. Log out of the ITSMA suite, and then log in by using an LDAP account to verify the LDAP server.

Configure LDAP for CMDB

In an out-of-box ITSMA system, only the sysadmin user can access CMDB. To enable other users to access CMDB, you need to configure LDAP
settings in CMDB. See also Import user data into ITSMA.


https://docs.software.hpe.com/wiki/display/ITSMA201707/Set+up+three+NFS+shares+for+ITSMA
https://docs.software.hpe.com/wiki/display/ITSMA201707/Set+up+three+NFS+shares+for+ITSMA

Configuring LDAP settings in CMDB is required for both the internal and an external LDAP server.

To configure an external LDAP server for CMDB, make sure that you have configured the global LDAP settings in the Suite
Configuration user interface (CONFIGURATION > Accounts > LDAP & SAML) before your perform the steps here. For details, see Co
nfigure an external LDAP server.

This document uses screenshots based on the internal LDAP server.

To configure LDAP in CMDB, perform these steps:

® Fully containerized mode (CMDB is containerized)
® Step 1: Create groups in CMDB and map them with LDAP groups
® Step 2: Enable LDAP authentication
® Step 3: Verify your LDAP settings
® Mixed mode (CMDB is non-containerized)
® Step 1: Configure "LDAP Services" in the UCMDB JMX console
® Step 2: Create groups in CMDB and map them with LDAP groups
® Step 3: Enable LDAP authentication
® Step 4: Verify your LDAP settings

Fully containerized mode (CMDB is containerized)

If ITSMA is installed in fully containerized mode, once you have selected the internal LDAP server during the installation or have configured an
external LDAP server (see Configure an external LDAP server), ITSMA automatically populates CMDB with the internal or external LDAP
settings. You only need to configure LDAP groups in CMDB.

In fully containerized mode, perform the following steps.

Step 1: Create groups in CMDB and map them with LDAP groups

1. Log on to ITSMA suite as sysadmin: https://<EXTERNAL_ACCESS_HOST>/main.

2. From the ITSMA landing page, click CMDB Administrator.

3. Create two CMDB groups:
a. Click Security > User and Groups.
b. Create a new group "administrators" and assign the "SuperAdmin" role to this group.
c. Create a new group "itpeople" and assign the "Viewer" role to this group.

If you use external LDAP, you need to create the groups in CMDB according to the actual groups in your external LDAP server
and assign the appropriate right to each group.

4. Click Security > LDAP Mapping, and then map the newly created CMDB groups with the LDAP groups.
LDAP il

a rZ—J T | Open New LDAF Mapping

LDAF Repository UCMDB Groups For LDAP Group:
B LoaP Repostory Avalable groups Selected groups
epository
7 administrators itpeopie [—
E='; itpeople
LDAFP Mapping
ﬂ % AT Open New LDAP Mapping

LDAF Repository UCMDE Groups For LDAF Group: itpecple:

E| LOAFP Repository g groups 2 orouns
EZ administrators administrators tpeopie
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Step 2: Enable LDAP authentication

Select Administration > Infrastructure Settings > LDAP General > Enable LDAP authentication, and then set the value to True.



Step 3: Verify your LDAP settings

1. Log on to CMDB and CMDB browser as a user from the admin group (the group with the "SuperAdmin" role assigned in CMDB) of your
LDAP server.
For example, if you use internal LDAP, you can use "falcon" to log on to CMDB and CDMB browser.

2. Check that the user information is from LDAP.

[ Users | Groups
2% %O
Name External User User Repository
& admin UCMDE
a4 FALCON, JENMIFER v openidap-svc
& intgAdmin LUICMDE
&4 sysadmin UCMDB
sy UlSysadmin UCMDB

Mixed mode (CMDB is non-containerized)

In mixed mode, CMDB is an external UCMDB system. For this reason, UCMDB is not automatically populated with the global LDAP settings that
you have configured (see Configure an external LDAP server), and you have to manually configure the required settings by using the UCMDB
JMX console.

In mixed mode, perform the following steps.

Step 1: Configure "LDAP Services" in the UCMDB JMX console

1. Onthe UCMDB server, launch the Web browser and enter the following address: https://localhost:8443/jmx-console.
2. Login as sysadmin.
3. Search for "LDAP Services" and then click the corresponding service.

UCMDB JMX Quick Search

LOAP services

UCKHCE rArdra=LOAP Sarslzer: LE ARG rrsinan
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4. Getthe LDAP URL:
a. Click getLDAPSettings from the service list.

deletel dapServer Uelete the LUAF Server and all the its users rom UHM.
forceCaseMatchAuthentication Enable/Disable case-sensitivity LDAF authentication
getLDAPGroupMappings Getting LDAP group to ACL role mappings

getl DAPGroupUsers Get LDAP group users

getl DAPGroupUsersChunk Get LDAP group users by chunks. The defaults for search/sort fields is uid.
getl DAPSettings Getting LDAP Settings

getLDAPUserMappings Show LDAP group to ucmdb group

L T Iy VP

b. Click the Invoke button.


https://localhost:8443/jmx-console

Mbean: UCMDB:service=LDAP Services. Method: getLDAPSettings

Is LDAP synchronization enabled : true

Is case-sensitivity enforced in LDAP authentication enabled : false

openldap-svc.itsmal.svc.cluster.local

Setting Value

Connection

URL ldap://openldap-svc.itsmal.svc.cluster.local:389/dc=itsma,dc=com
Host openldap-svc.itsmal.svc.cluster.local

Port 389

c. Get the LDAP URL. For example, the out-of-box internal LDAP URL is: Idap:openldap-svc.itsmal.svc.cluster.local:389/dc=it
sma,dc=com

5. Configure the LDAP settings for UCMDB.
a. From the LDAP Services list, click configureLdapServer. The following screen is displayed.
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b. Inthe IdapURL field, enter the LDAP URL you obtained previously, and then enter the correct values for all the required fields as
indicated in the following example.

The following example describes the required values for configuring internal LDAP server. For external LDAP, you
must change the values accordingly based on your external LDAP server setting. For example the LDAP URL must be
your external LDAP server URL.

Be sure to also configure "searchUserPassword" for the system to log on to the LDAP server. The default value is
"secret" for the internal LDAP server.
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c. After you configure the LDAP settings, click Invoke.
6. Test the LDAP connection after your configuration:
a. From the LDAP Services list, click testLDAPConnection.
b. Click the Invoke button. Make sure that you can see your LDAP groups. For internal LDAP, you can see the following two
groups in the test result.

Mbean: UCMDB:service=LDAP Services. Method: testLDAPConnection

openldap-svc.itsmal.svc.cluster.local

Testing LDAP connection and retrieving LDAP root groups took: ©.4 seconds.

Unigue Name Display Name Description Has WMembers
administrators administrators false
itpeople itpeople false

Step 2: Create groups in CMDB and map them with LDAP groups

Log on to the external UCMDB system and then follow the instructions provided in step 1 for fully containerized mode.

Step 3: Enable LDAP authentication

Log on to the external UCMDB system and then follow the instructions provided in step 2 for fully containerized mode.

Step 4: Verify your LDAP settings

For details, see step 3 for fully containerized mode.

Configure LDAP for Service Portal

Service Portal uses HPE Identity Manager (IdM) for user authentication. Once you have configured an external LDAP server (see Configure an
external LDAP server), you still need to manually configure LDAP groups in Service Portal to synchronize users from the LDAP server to IdM so
that LDAP users can log in to Service Portal. For more information, see Import user data into ITSMA.

If you configure LDAP during installation, a self-service user group is automatically created in Service Portal and mapped to the
Consumer group. If you skip LDAP configuration during installation and configure LDAP after installation, no group is automatically
created.

To manually configure groups, follow these steps:

. Log on to ITSMA as sysadmin.
. Click Suite Configuration > Operation > Service Portal Administration.
. Click the Identity application in the Launchpad.
. In the Organization List view, click ITSMA.
Follow these steps to add a group to which you can assign roles:
a. In the Organization Details view, click Groups.
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b. In the Groups view, click Add Group.
c. Inthe Add Group dialog, provide the following required information:
i. Type a descriptive Group Name.
ii. Inthe Group Representation Type field, select LDAP Representation.
iii. Inthe Distinguished Name field, enter a value according to your LDAP data hierarchy. For example: cn=<Group Name
in LDAP>.ou=Groups.
iv. In the Authentication field, select the LDAP server that you configured.
d. Click Save to save your new group.
6. Follow these steps to add the groups created above to the corresponding roles. By default, Consumer and Organization Administrator
roles are available.
a. In the Organization Details view, click Permissions.
b. In the Permissions view, click Add Group for the role that you want to associate with a group
c. Inthe Add Group dialog, select the group, and then click Save. The specified group is associated with the role and listed under
the role.

For more information on Service Portal LDAP related tasks, see the "Configure LDAP" topic from the Service Manager Help Center.

Configure users in the internal LDAP server

ITSMA has bundled an internal OpenLDAP server for demonstration purposes only. This internal LDAP server has only a very limited number of
sample users configured. You can configure more users if needed.

The ITSMA suite uses the following port and user to connect Service Management and CMDB to the internal LDAP server:

¢ Port: 31389
® LDAP DN: cn=falcon,ou=people,dc=itsma,dc=com (password: 123456)

To configure users in the internal LDAP server, follow these steps:

1. Install an LDAP connection tool. For example, install Apache Directory Studio.

The next steps use Apache Directory Studio as an example.

2. Launch Apache Directory Studio, and specify the following LDAP server connection information:

On the Network Parameter tab, provide the following information:
® Connection name: specify a display name for the LDAP server. For example, internalLdap.
® Hostname: Enter the fully-qualified domain name or IP address of the master node.
® Port: enter 31389.
® Encryption method: Make sure No encryption is selected.
® Provider: Make sure that Apache Directory LDAP Client APl is selected.

See the following figure for an example.


http://docs.software.hpe.com/SM/9.52/Codeless/Content/install/smsp_install/confgure_ldap.htm

type filter text & Connection

| Connection |

&

&

\ : :
Network Parameter | Authentication | Browser Options = Edit Options

Connection name: |internalLdap

Network Parameter

Hostname: ]
Port: 31389
Encryption method: | No encryption

Server certificates for LDAP connections can be managed in
the 'Certificate Validation' preference page.

Provider: Apache Directory LDAP Client API

Check Network Parameter

) Read-Only (prevents any add, delete, modify or rename operation)

©)

Cancel OK

On the Authentication tab, provide the following information:

® Authentication Method: Make sure Simple Authentication is selected.
® Bind DN or user: Enter cn=admin,dc=itsma,dc=com.

® Bind password: Enter secret. This is the LDAP server administrator password.
See the following figure for an example.




3yt ] Connection & N =
Network Parameter | Authentication | Browser Options = Edit Options
Authentication Method
Simple Authentication hd
Authentication Parameter
Bind DN or user: cn=admin,dc=itsma,dc=com bd
Bind password: |eeeeese
¥ Save password Check Authentication
} SASL Settings
» Kerberos Settings
@ Cancel OK
3. Click Check Authentication to make sure the connection information is correct:
Check Authentication b 4
The authentication was successful.
o
OK
4. Click OK.

5. Add LDAP users. For details, see the OpenLDAP documentation.
Import master data

HPE provides a data import tool set, which can help you import master data from an existing Classic ITSMA system to ITSMA NG Express. You
can download this toolset from HPE Marketplace.

® Purge demonstration data
® Use the data onboarding toolset to import master data
® Import user data into ITSMA

® This toolset supports master data onboarding for Service Management only.
® This toolset enables you to incrementally import data, which means you can always import additional data after an initial data
import.


https://marketplace.saas.hpe.com/itom/content/itsma-containerized-suite-2017-07-express-edition

Purge demonstration data

Before your ITSMA system goes live, you need to purge the out-of-box demonstration data from Service Management, Smart Analytics, and
UCMDB.

To purge demonstration data, you must log in to the ITSMA Suite Portal as a suite administrator. For details, see Log in to the
ITSMA Suite Portal. The following tasks assume you are already logged in to the suite portal.

Purge data from Service Management

To purge the demonstration data from Service Manager, follow these steps:

. On the suite landing page, click Service Management.

You are automatically logged in to the Service Manager web tier client.

On the left-side navigator, click System Administration > Base System Configuration > Miscellaneous > Purge Production Data.
Make sure the All Out of Box Data option is selected, and then click Next.

. Select the | wish to purge all out of box data from the system option to confirm the purge action.

. Click Next to purge the data.

SRR

Purge indexes from Smart Analytics

To purge the indexes of the Service Manager demonstration data from Smart Analytics, follow these steps:

1. Make sure that you have already purged the demonstration data from Service Manager.
2. Click Tailoring > Integration Manager, and make sure the SMIDOL integration instance is enabled.

The SMIDOL instance is for the training, testing, index, and tuning processes that are triggered in Smart Analytics
Configuration. Normally, one Service Manager Server has only one SMIDOL instance (hamed as SMIDOL*). The asterisk sign
represents the sequence number, which is usually 0.

3. On the navigator, click System Status and make sure that the KMReindex schedule is started.

4. Follow these steps to index each Hot Topic Analytics configuration record:
a. Click System Administration > Ongoing Maintenance > Smart Analytics > Hot Topic Analytics.
b. Click Search, select a configuration record, and then click Start Index.

c. Click Yes in the confirmation dialog that is displayed:

x

5. Follow these steps to fully re-index each Smart Ticket task:
a. Click System Administration > Ongoing Maintenance > Smart Analytics > Smart Ticket.
b. From the Current Configuration List, select a task.
c. Click Training, and then click Yes to confirm the training action.
6. Follow these steps to fully re-index each Smart Search library:
a. Click System Administration > Ongoing Maintenance > Smart Analytics > Smart Search.
b. From the Current Knowledgebase List, select a knowledgebase.
c. Click Full Reindex.

Purge data from UCMDB

To purge the demonstration data from UCMDB, follow these steps:

1. On the suite landing page, click UCMDB Administrator. You are automatically logged in to UCMDB.
2. Click Modeling, and then click IT Universe Manager.
3. In the CI Type field, select Managed Object. Click OK.
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4. Click the search icon (magnifying glass) next to the Cl Name field. A list of Cls is displayed.
5. Select all Cls, right-click the selected Cls, and then select Delete from CMDB.

i
!

Use the data onboarding toolset to import master data

If you have an existing Service Manager implementation, you can import the master data into your ITSMA system by using a toolset that is
released on HPE Marketplace as a .zip file. This toolset comprises the following tools:

® A Microsoft Excel spreadsheet that contains a macro for exporting data to CSV files (located in the Excel subfolder)

® A set of files for use with HPE Connect-It, including a scenario file (DataOnBoarding.scn) and configuration files that are required for
running the scenario (located in the SM-CIT subfolder)

® Sample CSV files (located in the CSV subfolder)

Limitations and known issues
® This toolset currently supports only data migration for Service Manager.
® Operator startup parameter values are not displayed correctly when you attempt to update them.
® Data is not imported into the Full Name field in the contacts table.

Understand the Excel spreadsheet

To migrate data by using the data onboarding toolset, you first need to enter your supporting data in the Excel spreadsheet provided by HPE.

The Excel spreadsheet is located in the Excel subfolder of the data onboarding package (.zip).

Color codes

The Excel sheet uses the following color codes.

Color Explanation
Yellow Yellow cells with this color contain sample data, which is not
imported

Red Cells that contain red text allow to specify additional data to import


https://marketplace.saas.hpe.com/itom/content/itsma-containerized-suite-2017-07-express-edition

Gray

Green

The Selections worksheet

Gray cells are automatically populated based on the value selected
in another cell

Green cells require you to select a value. The selected value is not
get imported into the solution; instead, it is normally used to populate
gray cells.

For example, in the following image Column A allows you to select a
value, which then populates column E. Column E is then imported
into the solution.

A
Companies

B

[of

D

E

Notes:

Contains contact information and preferences about the companies you work with. This area typically contain

Definition

Service Manager Label

Customer ID

Company Code

Company Name

Default SLA for Company ID

Fieldname

customer.id

company

company.full.name

default.sla

Data Type

character

character

character

number

Data

mandatory

optional

Maximum Characters 60 70 50
Index Unique Not Null

Notes The ID
Format Rules
Example Data ABC
Data
Please list your data here in Company 1 |k |company 1 |168
this area Company 2 |Company 1 |Company 2 |168
abc bac |ABC Company Limited  |168

ABC Company Limited | 168

The Selections worksheet contains predefined data from the solution. The data is used as a reference in all the other worksheets to ensure that

the entered data matches the data that the toolset requires.
The following table describes the data available in the worksheet.

Column

TimeZones

Country Name

Language Name

Language ID

Customer SLA Name

Customer SLA ID

Service SLA Name

Service SLA ID

Location Site Category

User Work Type

Security Roles

Contract Profiles

Configuration Profiles

Operator Templates

ClI Display Name
Cl Identifier

Job Titles

Dependencies between worksheets

Explanation

All available time zones of the suite products

All available countries

All available languages

The language ID matching the language name

The customer specific SLA Names

The SLA ID matching the customer SLA Name

The service specific SLA Names

The SLA ID matching the service SLA Name

The location site category

The different user types. For example, site, home, mobile
The security roles to give user the correct access in the modules
The user profile for the Contract Management module

The user profile for the Configuration Management module

The template use to set basic details in the operator record. For
example, dashboard, default menu.

The Cl display name
The CI ID matching the display name

The available job titles per department

Some worksheets include cross-references to data in other worksheets. These cross-references ensure data integrity throughout the
spreadsheet. The ITSMA solution will import the same references between the data records into the ITSMA suite components.



The cross-references help you to select the correct record.
For example, the Contacts worksheet is referencing the following worksheets:

® Companies
® Location
® Departments

A D E F G H [
1 Contact
2 |Notes bntact the service desk to initiate a service desk interaction, incident, or change, or a person who uses components tracked in Config
3
4 Definition
5 |Label First Name Last Name Title Employee ID Company Dept Name
6 |Fieldname first.name last.name title user.id company dept.name
7 |Data Type character character character character character character
8 |Data Requirement mandatory rmandatory optional rmandatory rmandatory rmandatory
9 |Field Length 80 80 140 140 60 50
10 |Unique Unique
Need to match drop down values | A unigue identifier
from department data Job Title  |for the contact,
field. Please select a Department |using lettersand  |To be the same as Company |Has to match Dept Name field from the
11 |Field Note The first name The last name first numbers Code in company table department table
12 |Format Rules
13 |Example Data Joe Bloggs Admin M; 1234567 ABC ABC HR Department
14 Data
15 |Please list your data |Jan Steube Administrative Assistant |231541235 Company 1 Dept 1
16 |here in this area Klaus Meier Manager, General sdfsdf Company 1 Dept 2

Therefore, some worksheets can be completed only when some data is correctly entered in the other worksheets.

Worksheets

The Excel spreadsheet contains the following worksheets.

Information

This worksheet contains some basic information.

Companies

This worksheet contains contact information and preferences about the companies you work with.
Locations

This worksheet contains addresses and organizational information about the location of the companies. It comprises a hierarchy of records that
document the company information, such as locations, sites, and buildings. The data can be used in contact records to see where a person is
located.

Examples:
Conpany: Custoner A

/| AT/ Cityl/ Streetl

/| AT/ City/ Street1/Buil ding A/ Floor 1

Contacts

This worksheet contains contact information about users who:

® Contact the service desk to initiate a service desk interaction, incident, or change
® Order from the Service Request Catalog
® Use components tracked in Configuration Management

Contact records contain reference to a company, department, and location. The unique ID for contact records is the contact name. The contact
name is used as a reference in many places in the system and creates the link to the operator object. We recommend that you use a clear
identifier for Contact and Operator Names.

Examples:

Contact Nane: firstnane.|astnane@ustonera.com
Conpany: Custoner A

Departnent: Goup 1

HPE Service Manager |D:



Location: Floor 1
Departments

The department worksheet contains the data for the master data entities related to the Business-Organization of a company. You must ensure
that correct organizational structure is built into the department table. The department is the next level of organizational unit after the company.
The departmental structure is hierarchically organized, which means that each level references a parent department.

Departments are important for defining the correct relationship between the following records:

® SLA records and the Business Services in the Subscription Table
® Contact records and the correct Organizational Unit

Examples:

Conpany: Custoner A
Cust oner / Unit 1
Cust oner / Unit 1
Cust oner / Unit 1/ Department 1
Cust oner / Unit 1/ Departnent 2
Cust oner Unit 1/ Departnent 1/ Goup 1
Cust oner / Unit 1/ Departrment 1/ Goup 2
Cust oner / Unit 1/ Departnment 2/ Goup 3

Cust oner / Unit 1/ Departnment 2/ Group 4

> » >» » » » >» > >

Cust oner / Unit 2
Operators

This worksheet captures the operators who work with ITSMA. Although every user with access to a computer that has an active directory entry
may access ITSMA, the import process should focus on operators who are actively working in the different modules in ITSMA.

Users who only access the end user portal do not need to be imported. End Users are created automatically within the suite, when the user first
logs in.

To import and successfully create operator records, you must provide the following data:

® Name

® Contact ID

* Company

® Security Roles / Profiles

Other required attributes are set by a template operator and are populated at the creation of the operator record.

® Menu (Navigation Tree items)
® Time zone (should be taken from the contact record)
® Date format (defaulted date format of the time zone)

To ensure successful authentication, the operator name has to match the <ID> in the HPE Identity Manager (IdM) server used by
ITSMA.

Example:

Name: WRXX212

Conpany: Custoner A

Contact| D: firstnane. | ast nane@ust onera. com

Operator templates

ITSMA includes operator templates to ease the creation of operator records. The templates are used to fill some of the required attributes, such
as the startup menu, capability words, currency, or query groups.

The following table describes out-of-box operator templates.



Template Description

TEMPLATE_IM Set the basic details for the Incident module
TEMPLATE_SM Set the basic details for the Service Desk module
TEMPLATE_CM Set the basic details for the Change module
TEMPLATE_RM Set the basic details for the Request module

TEMPLATE_ADM  Set the basic details for Administrators

If the default settings in the operator templates do not cover your requirements, modify the templates or create new ones.
Operator Security
This worksheet captures the authorization rights of the ITSMA users.

The security model provides a consistent method of assigning permissions to users across all facets of ITSMA. It also provides standardized
methods to manage user rights.

Security Roles:

A role has a set of rights and settings assigned to it. Each operator is assigned a role or roles which, along with area, determine the access rights
for the operator.

Contract Profile:

The profile determines the access rights for the Contract Management module.
Configuration Profile:

The profile determines the access rights for the Configuration Management module.
Security Groups:

The operator record is used to determine the security groups of which the operator is a member and uses this information to determine the files to
which the operator has limited access. When an operator queries a restricted file, Service Management reads the security group records to
determine the filtering conditions to apply to the query. Service Management then returns only those records that match the filtering conditions in
the security group records.

Examples:

change manager, change anal yst

Vendors

This worksheet contains the list of suppliers (vendors and service providers) that support the IT solutions. This allows you to define:

® To which supplier a ticket was sent (in case there is no specified Assignment Group)
® To which supplier the Assignment Group is related (in case it is a service provider)

Examples

HPE, SAP, M CROSOFT

Assignment Groups

This worksheet captures the Assignment groups involved in Service Management process.

The naming convention for the Assignment Group is very important. A consistent and methodologically-organized naming convention facilitates
the re-assignment of tickets. Additional attributes such as different levels or further classifications enable users to search for Assignment groups
based on these attributes (for example, find all Assignment Groups that provide second-line support and that support the Service "Email").

Examples:

Service Desk EUR
Service Desk APJ
Exchange Team Level 2

Exchange Team Level 3



Exchange Team vendor
Assignments

This worksheets allows you to specify the members and approvers of each assignment group, and other attributes such as supported languages,
supported departments, and locations.

KM Groups

This worksheet captures KM groups. KM groups allow you to relate groups of people with a specific KM profile and KM Category, which
determine the rights of group members to create, review, and approve KM documents.

Examples:

KCS1 — Al docunments; KCSII — Al docunments; KCS1 — SAP; KCS2 - Service Manager

KM Group Assignment

This worksheets facilitates the setup of group members and other attributes of the KM group. You can specify the members of each group.
Holiday Group

This worksheet captures the different groups into which holidays may be organized.

For example, one group of holidays might include all holidays observed in France. This group would include worldwide holidays like Christmas
and New Year's Day, together with those unique to France. A second group might also list the worldwide holidays, but add those unique to North
America.

Holidays

This worksheet captures all holidays relevant to you and your partners.

Holiday Groupings

This worksheet is used to link the Holiday Group entries with the data in the Holidays table.
Work schedules

This worksheet captures the work schedules that define the work hours for users. Service Management can generate complex 24x7 schedules
that span multiple time zones, include all shift and break information, accommodate any regional shift to Daylight Savings time, and automatically
account for local or national holidays.

Work schedules can apply to a group, such as an assignment group, or to an individual named in the operator or contacts table. When you create
schedule records, start and stop times must not overlap, and breaks must occur within the defined work shift.

Subscriptions
This worksheet captures the service subscriptions that track the relationships between IT customers and the services they use.

A service subscriber, either an individual user or an entire department, can request subscriptions to various services listed in Service Catalog. A
subscriber’s list of subscriptions may reference access to shared services and individually assigned Cls. Subscriptions can include SLAs, history,
custom options, and pending change requests.
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Customize data fields

You may need to collect data from custom fields that are not included in the spreadsheet. Therefore, most of the worksheets have at least one
section to capture the extra custom fields. This section is highlighted red.

A B , c D F
1 |Holidays Customer Field
2 Notes | H
il 3 I
4
| 5 Tabel Holiday Name Start Date End Date
6 Fieldname holiday start. date end.date
7 Data Type character Date/Time Date/Time
8 Data Requirement mandatony mandatory mandatory
9 Field Length 50
10 Unigque Unigue
11 Field Note Day of hobday One day after - o sionify 1 day holday
12 Field Note
| 13 Related to Requirement
\| 14 Format Rules UPPER CASE Sdimmiyyyy adimmhnyy
|| 15 Example Data Christmas 2011 2512711 261272011
|| 16 Example Data Boxing Day 2011 |26/11272011 2TN25A011
|| 17 Example Data School Holidays | 18/07/2011 0210972011
| 18 —
| 19
20
| 21

On each of the worksheets, there is a line of code that resembles the following in the Visual Basic Macro. This exports the data to a CSV file.
Cal | Createl TSMACSV(BRwi n, 1, "1.Conpanies", "B5:E5, G5: U5, B15: E999, G15: U999, "1_Conpany", "")

® By default, the code line expects only one extra field (in the example above, this is column E). If you have more that one
custom fields, you must customize the code.

® By default, the macro only exports up to row 999 in the worksheet. If you have more than 999 rows of data, you must
customize the code.

Once that you have entered your data in the spreadsheet, you can export the data to CSV files. For more information about how to do this, see
Export data to CSV files.



Export the master datato CSV files

To import master data into ITSMA, you must first use the the "ITSMA_Suite_Supporting_Data" spreadsheet to generate a number of CSV files. To
do this, follow these steps.

The spreadsheet contains only the main options that dictate the minimum required settings in ITSMA, and hence is not a complete
replacement for direct entry into ITSMA. Many other factors and data cannot be entered through simple "yes or no" answers and are
therefore not captured by the spreadsheet.

The following steps are based on Excel 2013. If you are using a different version of Excel, the steps may slightly differ.

1. Unzip the data onboarding toolset package to a temporary directory on your local drive (for example, C:\DataOnBoarding).

When you unzip the package, retain the folder structure of the .zip file. Later, you will need to export data to CSV files and put
the CSV files in the CSV subfolder. You may want to make a backup copy of the sample CSV files in the CSV folder, because
your own CSYV files will overwrite them.

2. Open the Excel spreadsheet in the Excel subfolder.
3. Make sure that macros are enabled in the spreadsheet (if macros are disabled, you should see a security warning. Click Enable
content to enable macros).
4. Enter supporting data in the spreadsheet. For detailed instructions, see Understand the Excel spreadsheet.
5. Customize the "PreparelTSMAImport" macro (if required; see Understand the Excel spreadsheet), and then run the macro:
a. On the View tab, click Macros and then select View Macros.
b. If needed, select the "PreparelTSMAImport" macro and click Edit to edit it.

We recommend that you create a backup of the macro code before you edit it.
Macro 5 -
RAacrn mame
| ThisworkbookFreparemmsraimpan| il | Bun
-
Fep o
| Edt
|
: (Dt
| Do
: Mgerps e & Open Workbpols ;
| Dedirghion
|
|
|
LancH
|
| |
6. Once you have finished editing the macro, click Run. This directory (the directory from which you opened the spreadsheet) will generate

12 CSV files.
7. Verify the CSV files contain the correct data.
8. Copy the CSV files to the CSV subfolder (for example, C:\DataOnBoarding\CSV).

CSV file Description

1_Company.csv List of companies

2_Locations.csv List of locations

3_Contacts.csv List of departments (in a company above)

4 Departments.csv List if contacts (in a company and dept above)



5_Operators.csv List of operators against contacts

6_Vendors.csv List of vendors
7_Assignments.csv List of assignment group names
8_KMgroups.csv The KM group names

9_Holiday Groups.csv  List of holiday group names
10_Holidays.csv Calendar holidays (name and date)
11_Workschedules.csv = List of work schedules

12_Subscriptions.csv Business service subscription against above dept

You can follow the progress in the status bar:

1.Companies | 2.

T_Assignments

If you execute the macro more than once, the macro overwrites existing files in the folder.
Next, you need to import the CSV files into ITSMA. See Import data from the CSV files into the ITSMA suite.
Import data from the CSV files into the ITSMA suite

Together with the data onboarding Excel spreadsheet, HPE provides a Connect-It scenario for you to easily import the generated CSV files into
the ITSMA suite.

In this release, the tool can import data into the Service Management capability only.

The Connect-It scenario consists of three main elements:

® A source connector, which helps to read the CSV files
® A destination connector, which connects to the ITSMA suite to insert and update the data

® Data mapping between the source and destination connectors to map the data from the CSV files with the database fields in the ITSMA
suite

This scenario is designed for a one-time import; however, it can be used to import data on a regular basis.
To do this, perform the following steps:

® Step 1: Install Connect-It

® Step 2: Import the CSV files to the ITSMA suite
® Task 1: Configure the source connectors
® Task 2: Configure the custom field mapping
® Task 3: Configure the destination connector
® Task 4: Run the scenario

® Step 3: Verify the imported data

Step 1: Install Connect-It

We recommend that you install Connect-It 9.70, which you can download from http://www.hpe.com/software/entitlements.

For installation instructions, see the installation chapter in the Connect-It User Guide.

You can use a 120-day InstantOn license for a one-time data import. For information about how to activate a Connect-It InstantOn
license, see the Connect-It documentation.

Step 2: Import the CSV files to the ITSMA suite
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This step consists of the following tasks.

Task 1: Configure the source connectors

To do this, follow these steps:

1. Double-click DataOnBoarding.scn located in the C:\DataOnBoarding\SM-CIT directory. 12 source connectors are displayed.

File Edit Display Favorites Scenario Iools

Monitors  Administration Java  Help

&84 PITEEZ el BENE @Sho———

Seenario diagram
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& 1.Company |
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F 2Location |

&l Basic engine
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File - Text
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(:’} Basic engine

1 3_contacts_Mapping

File- Text

% aDepartment

&l Basic engine
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File - Text

7 50perators
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File - Text
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=
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2. Configure the source connectors.

a. Right-click the Company source connector, and then select Configure connector.
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b. Click Next repeatedly until you see the "Select files or folders" page. Click the File name field and then browse to the

corresponding CSV file.



Select files or folders

Specify the location of the files or folders

* Read files
" Read folders

Mame of the files

Extension |txt

[ Read sub-folders

< Previous | MHest > | Finizh Cancel

c. Click Next repeatedly until you see the "Choose a description file" page. Browse to the corresponding description file on your
local drive.

Choose a description file

Enter the location of the D5C file for the text file[s].

The D5C file describes how data in the flat text file is organized [delimited. fixed width, etc.]. Click the magnifier to
create or edit the D5C file

Use thiz DSC file C:A\Datal0nBoardingSk-CITAD elimitedT ext_Company.dsc @

By default. Connect-lt tries to use the code page of your computer. However. you may specify that another code page
. be used.

Code page to uze |[automatic] j

< Previous Mest > Cancel

d. Click the Edit button to the right of the Use this DSC file field to open the "Select a document type" window.



Choose a description file

Enter the location of the DSC file For the text file(s).

The DSC file describes how data in the flat text file iz organized [delimited. fixed width, etc.). Click the magnifier to
create or edit the DSC file.

Usze thiz DSC file C:\Dataln -CIThDelimitedT ext_Compary. dsc

By default. Connect-lt tries to use the code page of your computer. However. you may specify that another code page
. be used.

Code page to uze |[aut0matic]

< Previous Mest » | Finigh | Cancel

Select a document type

Thiz wizard enables you to create a description file [.dzc). A description file contains one or more document types each comresponding to
the organization of values in a text file. These values are separated by a fixed width or a delimiter.

Select or create a document type before continuing to the next page.

“ Document type

< Previous Firizh Cancel

e. Click Next. The following page is displayed.



Select afile for the preview

File to preview |C:\D atalnBoarding C5Y1_Compary.cav

Mumber of lines to preview |25

< Previouz ] Finizh Cancel

Click Next.
f. Make sure the Delimiter and Comma options are selected.

Specify the column delimiters

Specify whether the columns are fixed-width or are separated using delimiters.
" Fived width
& Delimiter

 Tab

& Comma

 Semi-colon

~ Space

= Others (List of characters uzed a3 delimiters)

Data preview

Customer D Company Code Compary Mame
ahc bac ABC Company Linited 168
Company 1 k Company 1 168
Company 2 Company 1 Company 2 168

Default SLA for Compary 1D Service Manager

operator 1
jan
jan

i
< Previous Finish Cancel

Click Next.
g. Make sure that the Import column titles from first line option is selected and the Quote character field is set to the



double-quotation mark ().

Specify the data-processing options

[ wite the: colurin headers
[V Import column titles from first line
[ Do nat generate ermarz if a line containg a number of columng different than what iz indicated in the description,

[ Trim spaces around values

Mumber of gkipped lines |D

Quate character |"

[ Keep quotes anound values [preview anly)

Start of the comment line |.-".-"

Ezcape character |

Diata preview
Cugtomer D Company Code Company Mame Drefault SLA for Company D Service Manager

ahc hac ARKC Company Limited 168 operator 1
Conpany 1 k Conpany 1 165 jan
Company 2 Company 1 Conpany 2 168 jan

¥
< Previous Finizh Cancel

Click Next.

Specify the column names and types

Enter the column names and types

“ Mame |° Tupe
Custormer |D Text
Company Code Text
Company Mame Test
Default SLA for Company (D Teut
Service Manager Teut
Service Delivery Manager Test
Service Desk Email Text
Addresz 1 Text
Address 2 Tet
Address 3 Test
City Teut
State Temt
Post Code Test
Country Teut
Phone Humnber Text
Fax Mumber Test
Show Canipaty in Multi-Cornpary Lists Teut
Alwayz Show Company in Lists Teut
Customer Field Tet

< Previous Mest = i i Cancel

Click Finish.
h. Check that the rest of the source connectors are automatically updated.



Task 2: Configure the custom field mapping

You do not need to perform manual mapping for the out-of-box fields.

To do this, follow these steps:

1. In the scenario diagram, double-click the Company mapping.
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2. Double-click the mapping destination.

3. For the customer field ("Customer Field" on the left-side pane), locate the mapping field on the right-side pane (companyold in this

example). Drag and drop the mapping field from the right-side pane to the middle pane.
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B Detault SLA for Campany 1D B company. hullname [Campary Mame) B default sla
Bl Fax Mumber B comparvoid B dellag
B Phone Numbesr ey [Courtry] B fan
Bl Post Code B customer.id [Customer ID] B last update
B Service Delivery Manager B ustormer since B mandatory asset
B Service Desk Email B default sla [Default SLA for Company D] B phone
Bl Service Manager B defilag B o synced
B Show Company in Multi-Company Lists B fax [Fax Mumber] B servicedesk.emall
B State B gt update B show.company
%% UrlFilenfo B mandatory. asset B gann

B phone [Phone Mumber] B srve, del.manager

B spnced B v manager

B zervicedesk.email [Service Desk Email] E state

B show company [Shaw Compary in Multi-Compargy Lists] spsmodeount

E gano B spsmadtime

B srve del manager [Service Delivery Manager] E spsmoduser

B gryc.manager [Service Manager] - vemdb. custamer.id

» — A E_codh oassuod

Fields on the left-side pane are from the CSV file, and those on the right-side pane are from the company table in Service

Management.

4. Map the customer field you entered in the Excel spreadsheet to a Service Manager field.

If the customer field is a text field, drag the customer field from the left-side pane to the middle pane to map it to the Service Manager

field




Edit mapping *
= - 1 Company (File - Text) X Mapping Destination - 'ServiceCenter/Service Manager (localho:
t |:|‘}:| ] Q ﬂ @ Element Ty
Compaty B address?

B Addess 1 Fast access to menus: Select a menu ~| | Kepsst #1 = B address?
B Address 2 Element Mapping D escription B ghways show
B Address 3 - [E] CiTesveompany B ciy
B Always Show Company in Lists B address] [Address 1] B code
B Ciy B addess2 [address 2] B compary
B Compary Code B address? [Address 3] B compary full hame
B Company Name B alwaps.show [&lwaps Show Compary in Lists] B comparyold
E Country B iy City] B country
B Customer Field B code [Past Cade] B customer.id
B Customer D B company [Campany Cods) B customer.since
B Default SLA for Compary 10 B company.full name B defaul sls
E Fax Mumber B delflag
B Phone Number T county B fax
B Post Code B customer.id [Customer ID] B jastupdate
B Service Delivery Manager B customer. since B mandatary. asset
B Service Desk Email B default.sla [Default SLA for Company ID] B phone
B Service Manager B dellsg B rospnced
B Show Company in Mult-Company Lists B fa [Fax Mumber] B servicedesk. email
B Siate B |ast update B show company
% UnlFilelnte B mandatory. asset B slano
B phone [Phane Mumber] B gy delmanager
=) 1c.gynced =] FYC.Manager
B servicedesk.email [Service Desk Email] E state
B show.company [Shaw Company in Muli-Company Lists] sysmadcaunt
B gano B gpzmodtime
B srvc.del manager [Service Delivery Manager] E sysmaduser .
B grve.manager [Service Manager] - uemdb customer.id
L4 = e B2 uemdb password
4 3
i L L

If the customer field is an array field in Service Manager, you should use a mapping script instead of the mapping method described
above.
For example, the following script maps the out-of-box secRole field:

Dimpath as String

Di m nmyVal ue as String

Dimtotal as Long

Di mi Counter As Integer, |SumAs Long
path = [' Security Role(s)']

t ot al =Count Val ues(path, "|", "")

For iCounter = 1 To total

myVal ue=Get Li stlten(path, "|", iCounter, "")

Ret Val =Pi f Set St ri ngVal ("secRol e. secRol e(" & cstr(iCounter) & ").secRole", nyVal ue)
Next

5. Click OK, and then save the scenario.
6. Repeat the same steps for the rest of the mappings in the scenario.

Task 3: Configure the destination connector
To do this, follow these steps:

1. In the scenario diagram, right-click the SericeCenter/Service Manager connector, and then select Configure connector.
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@ Basic enging |

Q 9_HolidayGroups_Mapping
ﬂ Basic engine |
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Q 10_Holidays_Mapping
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Y 11_WorkSchedules_Mapping Edit a document type..
y &k masic engine
’ Produce now
Delete
& 12_Subscriptions_Mapping Shacing fics
ﬂ EESEEI_| Showe toolbox

Q SemceCenter!Semce Manager
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@& localhost 13090

2. Click Next to display the Define the connection parameters page, and then enter the following information:
Server name: Enter a value with the following format: <host FQDN>.31191.
Here, <host FQDN> is the fully qualified domain name or IP address of the ITSMA master node, and 31191 is the Service
Management and Connect-It integration port.
® Login and Password: Enter the user name and password of an ITSMA suite administrator user (for example, the sysadmin use
r.

® Service Manager server port: enter 31191.

In ITSMA, this is the SM-CIT integration port instead of the SM RTE port. See also ITSMA node ports.

® Make sure the following options are selected:
® Service Manager 9.20 and later versions
® Write to a Service Manager database


https://docs.software.hpe.com/wiki/display/ITSMA201707/ITSMA+node+ports

Define the connection parameters

Enter the tion [using " puter.port’ format]. and enter the 5erviceCenter/5ervice Manager login and password.
Server hame |mt. 31191

Login |sysadmin

R RN

Pazsword

[w %/iite o @ Service Manager databass

Service Manager server port |31191

Test the connection

Test

< Previous Finish Cancel

3. Click Test to make sure that the connection is successful, and then click Close.

Message Date
- @ Test the connection 4/18/2017 10:52:25 &M
- o Connecting to ServiceCenter server "siminmmminniinmmmmwem:t 31151 4/13/2017 10:52:25 &M
© i/ mieiii—< 31151 /5M i 4/19/2017 10:52:25 &M
@ Successfully connected to the server. 413/2017 10:52:27 &AM
= o Disconnecting from ServiceCenter server "sumimmiiismiims' 3711591"... 4/13/2017 10:52.27 &M
o Digconnected from ServiceCenter server " umuuGmmmbiummmmsmmmmm -1191", 4/13/2017 10:52.27 &M
@ Deploying module: addressing-1.6.2 - file:/C: /Program Files (x86)/HPE /ConnectIt 970 endl.. 4/19/2017 10:52:27 AM
@ Successiul connection test 4/19/2017 10:52:27 &M

4. Return to the wizard screen, and click Next repeatedly until the Define document types page is displayed.
Select to the smdb951.cfg file located in the C:\DataOnBoarding\SM-CIT directory, and then click Finish.



Define document types

E xtension file for document types published by the connector.

By default, the description file comesponding to the application version of the server will be loaded
automaltically, Howewer, pou can specily a file.

Extension fike CADatalnBoadngSM-CI Themdb 951 .cig

<Bewns [ ot ] feh | Corce

Task 4: Run the scenario

Each CSV file is prefixed with a number. You must import the CSV files in ascending numerical order.

To do this, follow these steps:

1. In the scenario diagram, right-click Service Center/Service Manager, and then select Open connector.



(;:] Ser“icel"‘nrﬂ'nr Eormino l.ﬂﬂﬂﬂﬂri
Configure connectar,.,

_;I_ Close connector

Fawarites
Cache
Modify the relational rmodel...
Edit a docurment type...
Edit a rapping...

) Produce nowy

Delete

showe tracking lines

v Showe toolbox

v Show scenario diagrarm

2. Right-click the Company source connector, and select Produce now to import the data.
3. Continue to produce data for the rest of the source connectors in the following order.

To produce Subscription data, configuration items (Cls) must exist in your ITSMA system. If you have purged the out-of-box
data from the system, be sure to create your own Cls in the system.

2.Location
3.Contacts
4.Departments
5.0perators
6.Vendors
7.Assignments
8.KMGroups
9.HolidayGroups
10.Holidays
11.WorkSchedules
12.Subscriptions



i 2.KMGroups I i 2 _KMGroups Mapping

B Fie-Tot | Basic engine
e Ho\idayGroupsI 179_Halidaylroups_Mapping

B Fie-Tort | ] Basic engine
I 10Holidays I IH10_Holidays_Mapping
L[] e | LS
G 41 MorkSchedules I 437 14 _\Work Schedules_Mapping

B File - Txt I 7] Basic angine

e Subwipﬁmsl AF12_subscriptions_Mapping

B e -ten g Biasic engine Ii

2

4

Detail of the connector 12 Subscriptions' (view 'Global’)

@ Scenario zearch Patches list & Connectt log Docurment types

m Document log

estage

= o Mapping box "10_Holidavs_Mapping’
@ Totaltime: 00.000s

= o Mapping box '2_Location_Mapping':
@ Total time: 00.000s

= o Mapping box '5_Operators_Mapping’
@ Totaltime: 00.000s

= o Mapping box '3_Contacts_Mapping':
@ Total time: 00.000s

- @ Statistics for Connectt monitors:
@ Totaltime: 00.000s

Step 3: Verify the imported data

After the data onboarding scenario is executed, follow these steps to verify the data is successfully imported into ITSMA:

1. Log into ITSMA as sysadmin:
https://<EXTERNAL_ACCESS_HOST>/main

2. Click Service Management.
3. Enter db in the command line, and then press Enter to open the Database Manager.
4. In the Table field, enter the name of a corresponding table. For example, enter company or contacts.
5. Verify the data is successfully imported.
Company Code = Company Name & Custome.. & Custome.. = City + State < Country &
DEFAULT Default Company 00000001  12/31/98 O...
advantage advantage inc. 00000002 Denver co USA
bac ABC Company Limited abc
k Company 1 Company 1 Armenia
Company 1 Company 2 Company 2
1to5of5 1 Show | 50 records per page
OK [x]cancel 4 Previous & Next [ Save X Delete Q Find E’Fill | More ~ L

Company Information

Customer ID: | 00000001 |
Company Code: x| DEFAULT |
Company Name: | Default Company ‘

Default SLA for Company: | ‘ v ‘




Confact Na.. # Contact Ph.. & Extension 4 DeptName % Company 4 Operaforld & FullName 4 Posicode %

S LN, AN Asia - Saes auvalnaye AnLOE A srein
STERLAND, P... Asia - Finance  advantage Pat.Sterland Pat Sterland

Steubelan Dept 1 Company 1 Jan Steube Americas
STEWART. IKE South Americ.. advantage Ike.Stewart lke Stewart
STOCK, WAR... Africa - Sales advantage Warren.Stock Warren Stock
STONE, MARL.. South Americ.. advantage Marisa.Stone Marisa Stone

451 10 500 of 519 K ¢ . 2 3 45 6 7 8 9 10 11 > ) Show | 50 records per page

OK [x]Cancel 4 Previous & Next + Add [ Save X Delete Q Find B Fill | More ~

Contact Information

Business Address Contact Numbers Misc Comments Attachments - O file(s) attached Portrait
Contact

Contact Name: t| STEUBEJAN | Full Name: t| Jan Steube ‘
Employee ID: | 231541235 | Service Manager ID: | ‘g" ‘

To troubleshoot any issues, see Troubleshoot data onboarding.

Extend the toolset to import more custom fields

By default, the data onboarding Excel spreadsheet allows you to specify one custom field. If you have more than one custom field, follow these

steps.

1.

g b w

The following steps use the Contacts worksheet as an example.

Enter your data, including the custom fields in the Excel spreadsheet. For instructions, see Understand the Excel spreadsheet.
In this example, we enter three custom fields in the Contacts worksheet: Custom Field1, Custom Field2, and Custom Field.
rrEE—

=
T |

. Update the data onboarding macro according to your data entries. For instructions, see Understand the Excel spreadsheet.

In this example, we update the code line for Contacts in the macro as follows:

Cal | Createl TSMACSV(BRwi n, 3, "3.Contacts", "B5:L5, B15:L999, N5: AN5, N15: AN999", "3_Contacts", "AJ:AK")

. Run the data onboarding macro to export the data to CSV files. See Export the master data to CSV files.
. Double-click the DataOnBoarding.scn file (located in the C:\DataOnBoarding\SM-CIT directory) to open the scenario in Connect-It.
. Reconfigure the source connector. For detailed steps, see Export the master data to CSV files.

In this example, right-click the Contacts connector and select Configure connector. Follow the configuration wizard to complete the
configuration. Make sure the following page is displayed, which indicates the custom fields that you added are loaded into Connect-It.



Specify the column nomes and types
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6. Reconfigure the mapping. To do this, double-click the mapping to open the following window, and then double-click the highlighted part.
= WFowmo b T
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g e = ¥

The field that you added in Excel now appears on the left-side pane. Drag and drop the field to the right-side pane, and then click OK.

Double-click the Contacts mapping, and then drag and drop the custom fields to the middle pane to map them to their corresponding
fields in the Service Management database. Click OK.

I.... ST 0 EcET Wk - o

ity

i

7. Run the data onboading scenario and verify the imported data. For details, see Import data from the CSV files into the ITSMA suite.

Troubleshoot data importing issues

Troubleshoot Connect-It



You may encounter the following issues in Connect-It when you import data.
"The record being added contains a duplicate key" error

This error occurs when you re-run the data onboarding scenario in Connect-It to re-import Departments data.
To solve this issue, delete the imported data from the dept table in Service Management, and then re-import the departments data.

"Invalid value" error

A | R 0. Werders_Mappng |
B rie-ns | VB B e
L
Wikl ol o corvmcii . Verdirs Magping {verss Cobal)
m fomai k| [l Pachesi | B Covesting m focumentlg | [l Document ype: E Higpng:
Elemart. (5 Veeuion_Mappe vt eogea] . Fiter | B bl oo ® Trackingdre e | iytio sbe

[ ——

Dber

Mrtinge
TAAEAT AP P

e slomant Sorth's 1 Fm out of lets in e siang 17007

Larred oot TTOT Froo ekl ko clate el irmm bype firrvakd vahesl.
& T he slormert. Thay'aTF i £ o et iy sty BONF
G Ciarres ptrmmt DO iypon Vo] 15 chabe e b b il st
T et o= 7o i o bt i i e 1707
A Tttt VT O ot ) b chab il b i it
& T e Ty =TT i ok i ey e iy T
O Tt ot T iypss ] b chaba sl b g rmonded o)

® Root cause: You have entered invalid values in the Excel spreadsheet.
® Solution: Check the relevant data entries in the Excel spreadsheet and correct mistakes.

"More columns found than expected" error

® Root cause: You have added one or more columns to the Excel spreadsheet and exported the data to CSV files, and then run the data
onboarding scenario without reconfiguring the source connector and the mapping. The error occurs because the newly added data is not

reloaded to the scenario.
® Solution: If you update a CSV file, you need to reconfigure the source connector and the mapping to reload the updated data, and then

run the scenario again.

"Name is not defined in element" error

= N CONSIEnCY ype on [Loc ).
& Mame Location Code’ it not defined in element Location’
0 The ‘2 Location [File - Texd] conneclon has besan opered,
- ) Stating scenano...
- ) Preparing connecion "2 Location [File - Texd] to start the scenaric...
= Checking coberency of connector document vpes...
= i Checking consistency of produced lype document 'Location [LocationSic1 ).,
& Mame ‘Location Code' is nol defired in slement Location'
= n Prepaiing connecicd "4_Department_M apping [Basc engine] to stai the scenano.,
g' Compiling scripts ...

® Root cause: You have updated a column header in the Excel spreadsheet and exported the data to CSV files, and then run the data
onboarding scenario without reconfiguring the source connector and the mapping. The error occurs because the newly added data is not

reloaded to the scenario.
® Solution: If the update is correct, you need to reconfigure the source connector and the mapping to reload the updated data, and then run
the scenario again. If the update is made by mistake, change the name back to the correct value and then run the scenario again.

Troubleshoot ITSMA
Follow these guidelines to troubleshoot problems that occur when you import master data into ITSMA.

Monitor the eventin queue

Once you have imported data into ITSMA by using the master data onboarding tool set, the system creates eventin records to insert the data into
the database and executes the records based on a scheduler. You can use the eventin queue to monitor the status of the import: once the data is
inserted into the Service Management database, the eventin records should disappear from the eventin queue.

To access the eventin queue, do the following:

1. On the ITSMA suite landing page, click Service Management.
2. Type db in the command line box, and press Enter to open the Database Manager.
3. Inthe Table field, enter eventin, and then click Search.



If eventin records remain in the queue, try the following solutions, depending on the status of the record:

® |f the Status field is empty: the record is not executed.
Solution: go to System Status on the navigator to restart the event process.

ClTcsveompany ac808023b588072b3041...  01/18/17 19:50:37 Alne e
ClTcsvcompany ac808023b588072b32e00.. 01/18/17 19:50:37 Company 1~k™"...
ClTcsvcompany ac808023b588072b32fa0.. 01/18/17 19:50:37 Company 2*Co...
1to30f3 1 Show ‘ 50 records per page
OK [X]cCancel 4 Previous & Next + Add P Save X Delete Q Find EJFill | More ~
| ClTesvcompany | First Expiration:
Status | 01/18/17 19:50:37 9
| ‘ Time Processed:
System Sequence: | |Eﬁ|
| ac8080235588072b3041002 |

® |f the Status field is "error": errors occurred when the system attempted to insert the data into the database.
Solution: debug the error according to the error messages. For example, the following figure shows an error caused by an empty primary

key value.
Event Cade
Time Stamps
[EMEMGroup | Fieat Expiratinn:
Sratuy

Itm‘u |
Systern Sequence:

|ebB‘I531555%ehF3 |

@ Detals | G Messages | & Field List | & Adtachments

Tirne Procesied:

01/051T 1814:05

Artempt to sdd ar updste kmaroup record Failed; noahd null: Seq Feb81 53135588 b8 35T0086
The record being added containg 2 NULL key {ances.database,add)

files(kmgroup) keys(id=) (aecesdatabase, add)

Ky 7113 ermply. (oces databaie add)

Check the Scheduled Event Types global list

To import data successfully, make sure the Scheduled Event Types global list contains the event registration. To do this, follow these steps:

. On the ITSMA suite landing page, click Service Management.

. Type gl in the command line, and then press Enter.

. In the Name field, enter Scheduled Event Types.

. Click Search.

. Make sure that the Display List field contains the following values:

ab~wnNBE

"Cl Tcontacts", "ClTcsvAssignments”, "Cl Tcsvconpany”, "Cl Tdepartnent"”, "Cl Thol i daygroup",
"Cl Thol i days",

"Cl TKM& oup", "Cl TLocation", "ClToperator", "Cl TSubscriptions", "Cl Tvendors", "Cl TWrkShedul es"



List Name: ‘ Scheduled Event Types | Times Updated: ‘ 763 ‘

Regen Every: [ 1 00:00:00 |  Expiration: [ 01/19/17 10:24:32 69|

Build List on Starfup?

List Variable: ‘ D Guard Against Duplicates?

Display Variable: ‘ $G.sch.events

Display Field: ‘ eviype

|
|
List Field: ‘ |
|
|

Filename: ‘ eventregister

Limiting SQL: ‘ evftype="input® and (sync.process=NULL or sync.process-=irue)

Sort By: ‘ |

Server App.: ‘ |

Application:

I:l Use Localized Values?

|:| User Defined List?

Value List: ‘ {NULL, NULL, NULL, NULL, NULL, NULL, NULL, NULL, NULL, NULL, NULL, NULL, NULL, NULL, NULL, NULL, NULL, NULL, NULL, t ‘

Display List: | ‘ {"ClTcontacts®, "ClTcsvAssignments”, "ClTcsvcompany”, "ClTdepartment”, "CITholidaygroup”, "CITholidays", "CITKMGroup”, "CITLocatior H
1

6. Go to System Status, and then restart the event process.

Import user data into ITSMA

Import user data into Service Management

When LDAP users attempt to log in to ITSMA for the first time, ITSMA does not automatically synchronize the users to Service Management. You
need to use the data onboarding toolset to import user data to Service Management first before LDAP users can log in to Service Management.

For details about how to import user data, see Use the data onboarding toolset to import master data.

You can download this toolset from here. This toolset supports incremental data import. You can always run the toolset to import new
user data.

Import user data into CMDB

Users from the LDAP server are created in CMDB on the fly when LDAP users perform the following tasks:

® Access Service Management and launch an embedded UCMDB Browser widget
® Access CMDB Browser
® Access CMDB

However, before these LDAP users can log in to UCMDB, you must configure additional necessary LDAP parameters in the UCMDB JMX
Console in addition to the LDAP configuration in ITSMA. For more information, see Configure LDAP for CMDB.

If you are using the internal LDAP server, users from the LDAP server are created in CMDB with the group named "itpeople” and a
default role (that is, the SuperAdmin role inherited from "itpeople"). You must manually create other groups and roles in CMDB and
create other user permissions. For more information, see the UCMDB Help Center.

User data onboarding in Service Portal

Service Portal uses the HPE Identity Manager (IdM) instance embedded in ITSMA for user authentication. The IdM roster loader runs periodically
to load LDAP users to IdM; on the other hand, full and delta user synchronizations from IdM to the Service Portal frondend (which is based on
HPE Service Anywhere) are executed to create Service Portal ESS users.

The process of end user self-registration in Service Portal is as follows:

1. The user logs in to Service Portal. The user is authenticated by the LDAP server.
2. Atthe backend, the user is loaded to IdM and is created as a Service Portal ESS user.


https://marketplace.saas.hpe.com/itom/content/itsma-containerized-suite-2017-07-express-edition
http://cmshelpcenter.saas.hp.com/CMS/10.33/ucmdb-docs/docs/eng/doc_lib/Content/admin/LDAPmap_c_Chapter.htm

However, you need to manually configure LDAP groups in Service Portal. For details, see Configure LDAP for Service Portal.

Configure Email

User role: Suite Administrator

Follow the instructions in this topic to configure both outbound and inbound email for ITSMA.

Outbound email

The email service enables the system to send email notifications to any mail server that supports Simple Mail Transfer Protocol (SMTP).
Configuring the email service is mandatory before you can use email related features such as the Service Management email notifications and

survey.

To configure email service, follow these steps:

1. Log on to the ITSMA Suite Configuration user interface as the sysadmin user:

https://EXTERNAL_ACCESS_HOST>/itsmaconfig
2. Click CONFIGURATION > Email Service.

If you are using non-containerized Service Manager (mixed mode scenario 1), you will not see the Email Service menu item in
the suite configuration interface. You need to configure email in your external Service Management system.

3. Configure your email service settings as described in the following table.

Setting

SMTP Server Host

SMTP Server Port

User Name Password

Mail From

Enable SSL&TLS

4. Click Test to make sure you can successfully connect to the SMTP server.

Description

Specifies the name of the SMTP server host that is used for
sending email notifications. The value for the parameter can be
the IP address, machine name, or DNS name of the SMTP
server .

Specifies the communications port that the SMTP server uses.

Specifies the user name and password of an existing account
that the ITSMA suite uses to bind to the SMTP server.

Specifies the descriptive name or other identifier of the sender
an e-mail. This parameter should be set in the format of email
address.

Select this option to enable SSL/TLS for SMTP operations. If tt
option is set to true, see Email with SSL certificate to configure
SSL.

5. Click Apply to save your configuration. A dialog box that lists the items to be changed is displayed.

6. Review the listed items, and then click Confirm.

After your confirmation for applying the changes, the system restarts the related services.

Inbound email

The Smart Email solution offered by ITSMA can process inbound emails and automatically create requests in the containerized Service
Management. ITSMA retrieves emails from an external mail server. By default, Smart Email is not enabled in ITSMA.

To enable Smart Email, follow these steps:

If the external mail server is using a secure protocol (IMAPS, POP3S, or HTTPS for EWS)

To enable Smart Email, you need to copy the certificate of the external mail server to a subfoler under the ITSMA global NFS share
directory, and then restart the sm-rte-emailout pod. This is not needed if the external mail server is not using a secure protocol.

1. Configure SSL certificate. See Email with SSL certificate.



2. Set up Smart Email in Service Management. For details, see the Set up inbound email topic and related topics in the Smart Email section
in the Service Management Help Center.

Configure SSL for outbound or inbound emai

To configure SSL for outbound or inbound emal, follow these steps:

1. Upload the mail server's certificate (for example, smtp.cer) to the <ITSMA global NFS share directory>/certificate/source folder (see S

et up three NFS shares for ITSMA).
For example, upload the certificate to this folder: /var/vols/itom/itsma/itsma-itsma-global/certificate/source.
The system automatically re-generates itsma-truststore.jks and itsma-cer.pem in the ca-trust folder (for example: /var/vols/itom/itsmalit

sma-itsma-global/certificate/ca-trust).

If the system fails to update itsma-cer.pem, you can import the certificate by using the following commands:
cd /var/vols/itomitsma/itsna-itsma-global/certificate
export PATH=. : $PATH
keytool -inportcert -trustcacerts -alias <alias> -keystore
ca-trust/itsma-truststore.jks -file source/<certificate_nane>

.........................................................................................................................................................................

kubect!| get pod -n itsmal | grep smrte-email out

itsmal smrte-email out-1377400934- 5dvqr 2/ 2
Runni ng 0 21h

kubect| delete pod smrte-emil out-1377400934-5dvgr -n itsmal

The system will restart the following sm-rte-emailout in a few minutes.
3. Log in to the Service Management user inteface, and send an email for testing.

Replace the certificate for ITSMA

In a production environment, you are recommended to replace the out-of-box Nginx certificate for ITSMA with your own certificate that is signed
by your corporate CA or a third-party CA.

To do this, follow these steps:

1. Prepare a certificate file (for example, tls.crt) and a private key file (for example, tls.key) in .pem format.
The certificate's CN value must be the FQDN defined in the <EXTERNAL_ACCESS_HOST> parameter, and the certificate must be
signed by your corporate root CA or a third-party root CA.
The following figure shows the content of an example private key file (tls.key):


https://docs.software.hpe.com/SM/9.52/Codeless/Content/smartemail/tasks/set_up_smart_email_integration.htm
https://docs.software.hpe.com/wiki/display/ITSMA201707/Set+up+three+NFS+shares+for+ITSMA
https://docs.software.hpe.com/wiki/display/ITSMA201707/Set+up+three+NFS+shares+for+ITSMA

B ___BEGIN RSA PRIVATE KEY
MITEowIBARKCRAQERkyNtyO0/aMBlacHpSP44hkfZ68QFCrEYW+uB+bPAZMmZQau9Tu
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The following figure shows the content of an example certificate file (tls.crt):



B ——-BEGIN CERTIFICATE
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END CERTIFICAT

2. Download the tls.crt and tls.key files to a temporary directory on the master node, and then use the following commands to encode the
certificate (tls.crt) and the private key (tls.key):
# base64 -w 0 tls.crt > tls_base64.crt
# base64 -w 0 tls.key > tls_base64.key
The content of your tls_base64.crt should resemble the following:
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The content of your tls_base64.key should resemble the following:
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3. Go to /var/vols/itom/core/suite-install/itsma/output/itom-ingress-x.x.x.xxx/yamls, and then edit the secret.yaml file as follows:
a. Replace the tls.crt:"xx...xxx" part with the content of the tls_base64.crt file.
b. Replace the tls.key:"xx...xxx" part with the content of the tls_base64.key file.
See the following figure for an example.



4. Re-generate the secret:
# kubectl delete -f secret.yaml
# kubectl| create -f secret.yaml|
5. Re-start the Nginx:
# kubectl delete -f itom-nginx-ingress-deployment.yaml
# kubectl create -f itom-nginx-ingress-deployment.yaml

Configure SAML SSO

ITSMA NG Express 2017.07 supports Single Sign-On (SSO) based on the SAML 2.0 protocol. Using the HPE Identity Manager (IdM) instance
that comes with ITSMA and an external Identity Provider (IdP), this solution enables SSO between ITSMA and other HPE applications (for

example, other containerized HPE ITOM suites).
Currently, the SAML SSO solution supports only Microsoft Active Directory Federation Services (ADFS) 2.0 or 3.0 as the IdP. ADFS helps you

use single sign-on (SSO) to authenticate users to multiple, related web applications over the life of a single online session. Once ADFS is installed
and configured to authenticate users from an LDAP directory, you are ready to add the IdM metadata to ADFS as a trusted relying party.

The screenshots in this section are from ADFS 3.0, and may slightly differ from those in ADFS 2.0.

Prerequisite
ITSMA must use an LDAP connection for SAML SSO, and ITSMA and the IdP (currently, ADFS only) must connect to the same LDAP

server.



To configure SAML SSO for ITSMA, perform the following steps.

Step 1: Export the public key portion of the ADFS federation service certificate
Step 2: Upload the ADFS communication public key to ITSMA

Step 3: Enable SAML 2.0 in ITSMA

Step 4: Download the IdM metadata of ITSMA

Step 5: Add the metadata file as a new relying party trust in ADFS

Step 6: Verify SAML SSO

Step 1: Export the public key portion of the ADFS federation service certificate

SAML SSO requires two-way SSL between ITSMA and ADFS. This step will export the public key from the ADFS certificate. In a later step, you
will upload this key into ITSMA so that the ITSMA IdM can decrypt SAML responses from ADFS.

. From your operating system, start Active Directory Federation Services.

. Right-click Federation Service, and then click Properties.

. On the General tab, under Communicating certificate, click View.

. In the Certificate dialog box, select the Details tab.

On the Details tab, click Copy to File.

. Click Next.

On the Export Private Key page, make sure that No, do not export the private key is selected, and then click Next.
On the Export File Format page, select DER encoded binary X.509 (.CER), and then click Next.

. On the File to Export page, specify the certificate file in File name, and then click Next.
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Step 2: Upload the ADFS communication public key to ITSMA

You need to upload the ADFS communication public key that you exported previously to the following directory in the ITSMA installation:
{itsma_global_volume}/certificate/idm

Where: {itsma_global_volume} is the global NFS share directory that you configured for the suite installation. This directory is used to store global
data of ITSMA. For more information, see Set up three NFS shares for ITSMA.

For example, copy the ADFS public key to the following folder:
Ivar/vols/itom/itsmalitsma-itsma-global/certificate/idm/

Step 3: Enable SAML 2.0 in ITSMA

Before you proceed, make sure that LDAP settings are correctly configured in ITSMA (see Configure an external LDAP server). This is
a prerequisite for configuring SAML SSO for ITSMA.

1. Launch the Suite Configuration utility as the sysadmin user:
https:<EXTERNAL_ACCESS_HOST>/itsmaconfig

2. Navigate to Configuration > Accounts > LDAP & SAML.

3. Switch on the Enable SAML 2.0 button on the upper right corner.

4. Specify a value for IDP Metadata URL. This value must use this format: https://<ADFS
host>/federationmetadata/2007-06/federationmetadata.xml.

5. Click Test to make sure the URL is correct.

6. Click Apply.

Step 4: Download the IdM metadata of ITSMA

Make sure that you have already enabled SAML in ITSMA, otherwise the IdM metadata is not available to download.

Download the suite's IdM metadata using the following URL: https://<SEXTERNAL_ACCESS_HOST>/idm-service/saml/metadata.

The metadata is downloaded as an XML file (for example, spring_saml_metadata.xml).

Step 5: Add the metadata file as a new relying party trust in ADFS
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This step will add the metadata file that you have downloaded in the previous step as a new relying party trust in ADFS.

1. In the ADFS 3.0 Management Console, right-click Trust Relationships and then select Add Relying Party Trust.

%@ File  Action  View Window Help
e 2
[ ADFs Trust Relationships

B Rervice

[ j Trust Belatinnzhin : | - PRl T Y hIpS OVBNIEW

Bl Buthe Add Relying Party Trust..,
Add Mon-Claims-fwvare Relying Party Trust., ships bo manage how claims are accepted and issued from the Federation Service.

. . ntain configuration data about claims providers and rules that govern how claims are
Add Claims Provider Trust... trusts contain configuration data about relying parties and rules that govern haw
Add Attribute Store..,

Wiewy 3

Mews Window from Here elationzhips:
Refresh

Help

2. Select Import data about the relying party from a file, and then select the IdM metadata file that you created previously. Click Next.

Select Data Source

s Select an option that thiz wizard will use to obtain data about this relying party:
@ ‘welcome
() Impart data abot the relving party published onling or on a local netwaork
@ Select Data Source ) ) ) . ) L ]
Uze thiz option to impart the necessany data and certificates from a relying party organization that publishes
@ Specify Dizplay Mame itz federation metadata online or on a local network.

@ Configure Multi-factor Federation metadata address [hast name ar URL
Authentication Now? |

@ Choose [ssuance
Authorization Fules Example: fz.contoso.com or https: /Asmsne. contozo. comdapp

@ Ready to Add Trust (®) Import data about the relying party from a file

@ Finish Uze thiz option to impart the neceszany data and certificates from a relying party organization that has
exported its federation metadata to a file. Enzure that this file is from a tusted source. Thiz wizard will not
validate the source of the file,

Federation metadata file location:

zaml_metadata.«ml | Browse. .

() Enter data about the relying party manually

Uze thiz option to manually input the necessary data about this relying party organization.

< Previous || Mest > || Cancel

3. The wizard may display a warning, indicating that some content of the metadata is not supported. You can safely ignore this warning.
Click OK to ignore the warning.

Some of the content in the federation metadata was skipped because it is not supported by AD FS. Review the properties
of the trust carefully before pou save the trust to the AD FS configuration database.




4. Specify a display name for the IdM service, and add optional notes. Click Next.

Specify Display Name

Steps Enter the display name and any optional notes for this relying party.
@ Welcome Display name:

@ Select Data Source |SMHDM|

@ Specify Display Name Mates:

@ Configure Multifactor
Authentication Now?

@ Choose |ssuance
Authorization Rules

@ Readyto Add Trust
@ Finish

5. Make sure that the | do not want to configure multi-factor authentication setting for this relying party trust at this time option is
selected, and then click Next.



i Add Relying Party Trust Wizard [*]

Steps Configure multi-factor authentication settings for this relying party trust. Multi-factor authentication iz required if

@ ‘Welcome there is a match for any of the specified requirements.

@ Select Data Source

@ Specity Display Mame Multi-factor Authentication Global Settings
@ Eﬁmgﬁt{isaﬁti}zﬁnﬂ? Requirements Users/Groups Mat configured
® Choose lssuance Device Mot configured
Authorization Fules Location Mot configured
@ Feady to Add Trust
@ Finizh

® | do not want to configure multifactor authentication settings for this relving party tust at this time.

() Configure multi-factor authentication settings for this relying party trust,

ou can also configure multi-factor authentication settings for thiz relwing party trust by navigating to the
Authentication Policies node. For more information, see Confiquiing Authentication Policies,

< Previous || Hewt » || Cancel

6. Select the Permit all users to access this relying party issuance authorization rule.



Choose Issuance Authorization Rules

Steps Issuance authonization rules determine whether a user is pemitted to receive claims for the relying party.

VWelcome Choose one of the following options for the initial behavior of this relying party’s issuance authorization rules.

Select Data Source (® Pemit gll users to access this relying party

Specify Display Name The issuance authorization rules will be configured to permit all users to access this relying party. The relying
Configure Multifactor party service or application may still deny the user access.

Authertication Now?
Friesten How () Deny all users access to this relying party
Choose lssuance

A thorization Rules The issuance authorization rules will be configured to deny all users access to this relying party. You must
later add issuance authorization rules to enable any users to access this relying party.
Ready to Add Trust

Finish
You can change the issuance authorization rules for this relying party trust by selecting the relying party trust

and clicking Edit Claim Rules in the Actions pane.

7. You are now in the Ready to Add Trust step. Check that the Endpoints tab contains multiple endpoint values. If not, verify that your
metadata was generated with https protocol URLSs.



L Add Relying Party Trust Wizard |
Ready to Add Trust
5 The relving party trugt has been configured. Review the following settings, and then click Mext to add the
@ Welcome relging party trust to the A0 FS configuration database.
@ Select Data Source Identifiers | Encryption | Signature | Accepted Claims | Organization || || Nates | Advanc £ | *
@ Specity Display Name Specify the endpoints to uze for SAML and WS -FederationPassive protocols.
@ Eonfigu(e Multi-factor
Authertication Mow? URL Index  Binding Default  Response URL
@ Choose lssuance SAML Assertiocn Consumer Endpoints
Authorization Rules https:.-".-"_... n POST Yes
@ PFeady to &dd Trust https: /S .. 1 Artifact Mo
@ Finish SAML Logout Endpoints
https: /s POST Mo
hitps: /< . Redirect Mo
¢ Previous | | Mest » | | Cancel

8. Leave the Open the Edit Claim Rules dialog checkbox selected, and then click Close to close the wizard.



Finish

Steps The relying party trust wag successfully added to the AD FS configuration databage,

@ ‘Welcome Lo . . L . .
r'ou can modify thiz relying party trugt by uzing the Properties dialog box in the AD FS Management snap-in.

@ Select Data Source

@ Specity Display Mame

) ) Open the Edit Claim Rules dialog for this relying party trust when the wizard closes
@ Configure Multi-factar i Op E BB
Authentication Now?

@ Chooge lssuance
Authorization Rules

@ Ready to Add Trust
@ Finish

Close

The Add Transform Claim Rule wizard opens.
9. Continue to configure the NamelD element as part of the Subject in the SAML Response message as follows:
a. Select Add Rule, and then select Send LDAP Attributes as Claims. Click Next.



Lt Add Transform Claim Rule Wizard -

Select Rule Template

D7 Select the template for the claim rule that you want to create from the following list, The description provides
@ Choose Fuls Type detailz about each claim rule temnplate.
@ Configure Claim Rule Clairn rule template:

Send LDAP Attributes az Claims W

Claim rule template description;

Uzing the Send LDAP Attribute as Claims rule termplate you can select attributes fram an LDAP attribute
ghore such az Active Directony to send az claims to the relying party. Multiple attibutes map be gent az
multiple claims fram a single rule using this rule tppe, For example, pou can uze thiz ke tenplate to create
a rule that will extract attribute values for authenticated users from the displayi ame and telephoneMumber
Active Directony attributes and then zend thoze values ag bwo different outgoing claims. Thiz rule may alzo
be uzed to send all of the user's group memberzhipz. If you want to only zend individual group
memberzhips, use the Send Group Membership as a Claim rule terplate.

< Previous Meut » | | Cancel

b. Specify the following fields to configure the claim rule:
® Claim rule name: enter NamelD
® Attribute store: select Active Directory
* LDAP Attribute: select SAM-Account-Name
® Qutgoing claim type: select Name ID



Configure Rule

U Y'ou can configure this rule to send the values of LDAP attributes as claims. Select an attribute store from

@ Choose Rule Type which to extract LDAP attributes. Specify haw the attributes will map to the outgoing claim types that will be
izzued from the nle.

@ Configure Claim Ruls
LClairm rule name:

WamelD

Rule template: Send LDAP Attibutes az Claims

Attribute stare:

Active Directary

Mapping of LDAP attributes to outgaoing claim types:

LDAP Attribute [Select or type to
add mare)

SaM-account-Mame Mame 1D

Outgaing Claim Type [Select or type to add more]

< Previous | | Finish

c. Close the wizard and the Apply the claim rules window.

In ADFS 3.0, you may need to configure the Name ID as a PassThrough claim.

Step 6: Verify SAML SSO

1. Launch one of the following ITSMA login URLs from your browser:
https://[<EXTERNAL_ACCESS_HOST>/main (for non-ESS users)
https://<EXTERNAL_ACCESS_HOST>/saw/ess (for ESS users)

Login URL for sysadmin

The sysadmin user is a seeded user, which is stored in the suite's |dM database instead of the LDAP server and hence cannot
be authenticated by ADFS. If SAML SSO is enabled, the sysadmin user can only use the following login URL:
https://[EXTERNAL_ACCESS_HOST>/itsmaconfiglogin.

2. Check that you are directed to an ADFS login page, as shown in the following example figure:



SMADEFS3

Sign in with your organizational account

|someone@examp\e.com

Password

3. Enter your LDAP user name and password to log in.

Configure the Service Portal mobile app

ITSMA Service Portal provides a mobility solution that is based on a native Android mobile app published on Google Play and HPE Marketplace.
Before end users can use the mobile app to do their daily work, the suite administrator must set up the mobility solution.

Prerequisites

® An access server is already set up if your organization is using a DMZ network. For details, see (Optional) Set up Access Server for a

DMZ network.
® The ITSMA suite is already installed. For details, see Install the ITSMA suite (on-premises).

Once the prerequisites are met during the suite installation. After the suite installation, the suite administrator can perform the following tasks to
set up the mobile app so that end users can use the mobile app in their daily work.

® Replace the out-of-box ITSMA Nginx certificate
® Enable ITSMA suite mobile notifications

Replace the out-of-box ITSMA Nginx certificate
The out-of-box Nginx certificate in ITSMA is signed by a private CA. You may want to replace the certificate with your own one, which is signed by

your corporate root CA or a third-party root CA. For more information about how to replace the out-of-box Nginx certificate for ITSMA, see Replac
e the certificate for ITSMA.

If you do not do this or if your corporate root CA is a private CA, when users attempt to log in to ITSMA using the mobile app, the
HTTPS connections are considered "untrusted" by Android and thus blocked. If this is the case, users need to import the private root
CA certificate to their mobile device by following Google’s instructions: https://support.google.com/nexus/answer/2844832.

Enable ITSMA suite mobile notifications

If your organization is using a proxy server to access the Internet, you can follow the instructions below to enable the ITSMA suite to send
notifications to Google Play. These notifications are then sent to user's Smartphones when connected to Google Play.

If your organization is not using a proxy server to access the Internet, this task is not needed.

Before you proceed, make sure that the mobile app is working correctly.

You can repeat the following procedure if the proxy settings are changed.
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1. Log in to the ITSMA suite master node.
2. Run the following command:

kubect| get deploynent itom xservices-platform -n “kubectl get namespaces
-o=cust om col ums=NAME: . net adat a. nane --no-headers |grep itsma’ -o yan
>/tnp/itom xservices-platformyani
3. Edit the /tmp/itom-xservices-platform.yaml file as follows:
a. Modify the section from

- name: GCM_PROXY_HOST

- name: GCM_PROXY_PORT

to

- name: GCM_PROXY_HOST
value: '<proxy server address>'

- name: GCM_PROXY_PORT
value: '<proxy server port number>'

For example:

- name: GCM_PROXY_HOST
value: 'proxy.yourcompany.com'

- name: GCM_PROXY_PORT
value: '8080'

® Use the Spacebar key instead of the Tab key to align the first letter of 'value' to the first letter of 'name’ on the

line above.
® Remember to put the proxy server address and port number within single quotation mark.

b. Remove the whole line starting with 'pod.alpha.kubernetes.io/init-containers'.
c. Remove the whole line starting with 'pod.beta.kubernetes.io/init-containers'.
d. Save the file.

4. Run the following command to apply the changes.

kubect| replace --force -f /tnp/itom xservices-platformyamn

This stops ITSMA services for several minutes. We recommend that you make such changes during non-business hours.

5. Wait for the changes to be applied. Run the following command to verify if the suite is up and running:

kubect| get pods -n " kubect| get nanmespaces -o=custom col unms=NAME: . net adat a. nane - - no- headers
|grep itsma” | grep xservices

All items should be Running.
6. Run the following command and check if the proxy host and port are configured correctly:

kubect| get deploynent itom xservices-platform -n ~kubectl get namespaces
-o=cust om col ums=NAME: . net adat a. nane --no-headers |grep itsma’ -o yan

Configure log level for debugging

User role: Suite Administrator
The suite administrator can configure the debugging log level for the following components or features of the suite:

Service Management
CMDB

Smart Analytics
Service Portal

IDM

Chat

® The log level for Service Management and CMDB can only be configured on the suite configuration page when you install



ITSMA in full containerized mode.
® After your confirmation for applying the changes, the system restarts the related services.
® Once debugging is enabled, additional logging information is written to the suite logs, which you can download from ITOM
Container Deployment Foundation (CDF).

Configure the Service Management log level

Configure the CMDB log level

Configure the Smart Analytics log level

Configure the Service Portal log level

Configure the 1dM log level
Configure the Chat log level

Configure the Service Management log level

To configure the debugging log level, follow these steps:
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. On the suite landing page, click Suite Configuration.
. Click CONFIGURATION > Debug > Log Level.

. Click the Service Management tab.

. In the Server section, update the parameters by selecting a value in the drop-down list, and then click the Update button. Or, you can

directly modify the parameter values in the text area.

= SM server log level parameters

Some values are available for quick selection in the the drop-down list. If you wan to specify other possible values that are
not in the drop-down list, you can directly modify the values in the text box.

Parameter name

sqllimit

debugdbquery

cache_clean_interval

Default value Possible values

10 Number of seconds
For example: 1, 2, 3, 4, 5, 10, 20,
30, 60

5 Number of seconds or 999 for a

full query debug.

For example: 1, 2, 3, 4, 5, 10, 20,
999

3600 1800, 2700, 3600

Description

This parameter defines the time
limit for requests to the RDBMS.
If a particular request exceeds
the time limit defined by this
parameter, the ITSMA Service
Management server writes a
message to the server log file
documenting the name of the
user making the request, how
long it took, and the actual SQL
query.

This parameter causes the Servic
e Management server to record
database queries, timings, and
results information that exceed
the time threshold you specify in
this parameter value in the log
file.

This parameter defines the
interval the Service Management
server waits before clearing the
cache of infrequently used
entries.



webservices_sessiontimeout

connectionTimeout

smartemailTimeout

1800

180000

45000

15, 30, 60, 120, 300, 600, 900,
1800, 3600

45000, 60000, 90000, 180000

30000, 45000, 60000, 90000,
180000

This parameter defines the
number of seconds that the
server waits for a WebService
API client request before the
server assumes that the client
session has timed out and closes
the connection. If a Service
Management connection is kept
alive, a value that is 30 seconds
shorter than the value of the conn
ectionTimeout parameter is
automatically applied for the
timeout limit of the web service
session. Otherwise, the value set
in the webservices_sessiontimeo
ut parameter is applied.

If a Service
Management connecti
on is kept alive, the
minimum timeout limit
(15 seconds) is then
applied for the web
service session when
the timeout limit for
the Service
Management connecti
on is less than 45
seconds.

This parameter defines the
number of milliseconds that the
server waits for a Service
Management client request
before the server assumes that
the client connection has timed
out and closes the connection.

® The timeout limit for the co
nnectionTimeout paramet
er should be longer than
that for
the webservices_sessionti
meout parameter.
Otherwise, the client
session could not be
reused. It is recommended
that you set the connectio
nTimeout parameter to a
value of no less than
60000 milliseconds.

® Avalue that is 30 seconds
shorter than the value of
the connectionTimeout par
ameter is automatically
applied for the timeout
limit of a web service if
the Service Management c
onnection is kept alive.

This parameter defines the
number of milliseconds that the
Smart Email process waits for a
connection to the mail server to
be established. When the defined
timeout value is reached, the
Smart Email process stops trying
to connect to the mail server until
the next time when the Service
Management Smart Email
scheduler starts again.



sqldebug

debughttp

debugjavascript

debugrest

0 (Disable), 1 (Enable)

0 (Disable), 1 (Enable)

1,2,3

0 (Disable), 1 (Enable)

This parameter causes the ITSM
A Service Management server to
write information about RDBMS
connections to the server log file.
If enabled, the server writes the
time to login to the RDBMS (sqllo
gintime) and the time it takes to
perform a query request (sqlquer
ytime).

This parameter causes the Servic
e Management server to write
HTTP SOAP requests and
responses to the following log
files.

® Jogs\sm.log
® RUN\HTTP.log

Important: Enabling this
parameter significantly reduces
available system resources
because the log files the server
produces contain all HTTP traffic,
including HTTP headers and
attachments. For this reason, we
recommend that you not enable
this parameter on production
systems, but rather in test
environments only.

This parameter causes the HPE
Service Manager server to write
JavaScript debugging messages
to the log file. Its value can be 1,
2,0r3.

® 1: Prints log information
when an object is
compiled, created, or
disposed.

® 2:In addition to the output
of debugjavascript:1,
prints log information
when the garbage
collector of the server's
internal JavaScript engine
is started or stopped.

® 3: Forces the JavaScript
engine to run garbage
collection before running
any JavasScript scripts.

This setting is
intended only
for developers,
and must not
be used in
production
environments.

This parameter enables the Servi
ce Management server to write
detailed log trace for RESTful
web services diagnostics. By
default, this feature is disabled.

To use this debugging parameter,
set it to 1, then restart the Service
Management server and re-run
the RESTful web service
application.



logdebuglevel 1

debugjni

log4jDebug

enablecoredump

rtm
maxlogsize 20

(Size in MB)
numberoflogfiles 10

0 = DEBUG, 1 = INFO(default),
2= WARN, 3 = ERROR, 4 =
FATAL

0 (Disable), 1 (Enable)
com.hp.ov.sm.common.oom.Low

MemoryHandler

0 (Disable), 1 (Enable)

0,1,23,4,5

5, 10, 20, 40, 60, 80, 100

0to 100

This parameter defines the log
level of the JRTE codes. If the
value of this parameter is equal to
or larger than 1, all JVM options
are logged in sm.log when the Se
rvice Management server is
starting.

This parameter provides detailed
debugging in the Java Native
Interface implementation.

This parameter enables certain
java packages to be started in
debug mode. By default, none of
the java packages will be run in
debug mode.

Unused in this release

This parameter causes the Servic
e Management server to write
Response Time Monitor (RTM)
performance statistics to the log
file.

This parameter defines the
maximum size to which a log file
can grow before Service
Management rotates to a new log
file. The system creates a new
log when the current file reaches
the indicated size. This parameter
requires the use of the numberofl
ogfiles parameter.

This parameter specifies the
number of the log files. Service
Management switches the log
when the log size reaches the
maximum size defined by the ma
xlogsize parameter. When this
happens, the current log file is
archived to the log file ending
with 1, and the existing log files
are renamed to the next higher
number, so that the archive log
file n+1 always contains older
data than archive file n.

To disable log
switching, set its value
to zero (0).

5. In the Webtier section, update the parameters by selecting a value in the drop-down list, and then click the Update button. Alternatively,

you can directly modify the parameter values in the text area.
=~ SM webtier log level parameters

If no value is listed in the drop-down list for a parameter, you need to update the value directly in the text area.

Parameter name Default value

session-timeout 15

Possible values

Number of minutes

Description

This parameter defines the
default session timeout interval
for all sessions created in the Ser
vice Management web tier.

It is best practice to lower

the session-timeout value to 2
minutes if you experience Service
Management web client sessions
lingering for a longer period of
time than expected.



viewrecordlist true true, false Enabling this parameter causes
web clients to display the record
list/detail view for search results.
Enabling this parameter from
here forces all web clients to
display the record list/detail view.
Enabling the this parameter from
the web browser URL only
displays the record list/detail view
on that particular web client.

querySecurity true true, false Enabling this parameter causes
the Service Management web tier
to verify the security key of a
URL query generated by the
Service Management server, and,
if valid, authorize the query.
Disabling this parameter allows
any user with logon permissions,
the skills to create a query, and
access to the Service
Management URL to extract data
from any Service Management
table.

jsDebug false true, false This parameter enables the web
client to load unminified
JavaScript files. However, when
this parameter is enabled, the
web client also displays to end
users an error message that
includes full stack trace. For this
reason, do not enable this
parameter in production
environments to avoid disclosure
of sensitive information.

6. Click Apply.

® By default, customized branding files and settings are stored in the following folder: {itsma_global_volume}/logs/sm-9.52/we
btier.
® By default, the path to the exported dashboard report is: {itsma_global_volume}/logs/sm-9.52/report-export.

{itsma_global_volume} is the global NFS share directory that you set up during installation (For example: /var/vols/itom/itsma/itsma-
itsma-gloabl). For more information, see Set up three NFS shares for ITSMA.

Configure the CMDB log level

. On the suite landing page, click Suite Configuration.

. Click CONFIGURATION > Debug > Log Level.

. Click the CMDB tab.

. Inthe Server, UD, and Browser sections, select a module, specify its log level, and then click Update. Repeat this step to specify the log
levels for further modules.
~ CMDB log level module

A WNPE

Server:

Module name Default value
ucmdb-api.properties.loglevel ERROR
mam.properties.loglevel INFO
security.properties.loglevel INFO
cmdb-framework.properties.loglevel ERROR
cmdb.properties.cla.loglevel INFO
cmdb.properties.loglevel ERROR

logstash.statistics.properties.loglevel.history ERROR


https://docs.software.hpe.com/wiki/display/ITSMA201707/Set+up+three+NFS+shares+for+ITSMA

cmdb.properties.notification.loglevel INFO

reconciliation.properties.loglevel ERROR
cmdb.properties.tglscheduler.loglevel INFO
cmdb-framework.properties.urmLogLevel WARN
cmdb_soaapi.properties.loglevel ERROR
security.properties.loglevel.cm INFO
security.properties.loglevel.lwsso ERROR
ui-server.properties.loglevel ERROR
security.properties.loglevel.authorization INFO
mam.web.properties.loglevel ERROR
cmdb.properties.search.loglevel INFO
fcmdb.properties.loglevel INFO
cmdb.properties.downgrade.loglevel INFO
cmdb.properties.quota.loglevel INFO

logstash.statistics.properties.loglevel.datain ~ ERROR

fcmdb.gdba.properties.loglevel ERROR
fcmdb.push.properties.loglevel ERROR
mam.properties.loglevel.monitoring INFO
multiple.cmdb.properties.loglevel INFO
security.properties.loglevel.wink ERROR
ui-server.properties.spring ERROR

logstash.statistics.properties.loglevel.search ERROR

logstash.statistics.properties.loglevel.tgl ERROR

Universal Discovery (UD):

Module name Default value
discovery.framework INFO
discovery.library INFO
discovery.probe.agents INFO
discovery.library.results.resultprocess INFO
discovery.library.dal INFO

discovery.probe.agents.probemgr.workflow = INFO

Browser:
Module name Default value
ucmdb_browser.level WARN

ucmdb_browser_search.level WARN

jvm_stats.level ERROR



statistics.level INFO

rpcCalls.level INFO

You can select from the following log levels for each module:

® INFO: An event for informational purposes
WARN: An event that might possible lead to an error
TRACE: A fine-grained debug message, typically capturing the flow through the application
DEBUG: A general debugging event
ERROR: An error in the application, possibly recoverable
FATAL: A severe error that will prevent the application from continuing

® OFF: No events will be logged

5. Click Apply.

Configure the Smart Analytics log level

1. On the suite landing page, click Suite Configuration.

. Click CONFIGURATION > Debug > Log Level.

3. Click the Smart Analytics tab, and then specify a log level. You can select one of the following log levels:
® INFO (default): An event for informational purposes
* DEBUG: A general debugging event

4. Click Apply.

N

Configure the Service Portal log level

1. On the suite landing page, click Suite Configuration.
. Click CONFIGURATION > Debug > Log Level.
3. Click the Service Portal tab, and then specify a log level. You can select from the following log levels:
INFO (default)
WARN
TRACE
DEBUG
®* ERROR
4. Click Apply.

N

Configure the IdM log level

1. On the suite landing page, click Suite Configuration.

. Click CONFIGURATION > Debug > Log Level.

3. Click the IDM tab, update the parameters by selecting a value in the drop-down list, and then click the Update button. Or, you can directly
modify the parameter values in the text area.

N

Parameter Default value
idm_auth_debug INFO

idm_debug INFO

You can select from the following log levels:

INFO (default)
WARN
TRACE
DEBUG

®* ERROR
4. Click Apply.

Configure the Chat log level

a. On the suite landing page, click Suite Configuration.

b. Click CONFIGURATION > Debug > Chat.

c. Click the Chat tab, and then specify a log level. You can select from the following log levels:
* INFO
* WARN
®* TRACE



* DEBUG
®* ERROR
d. Click Apply.

Change the ITSMA suite administrator password

User role: Suite Administrator

The Suite Administrator (sysadmin) has full administrator privileges for the suite. During the installation, you configured a password for this user.
You can change this password after the installation.

The initial password for the Suite Administrator user role was set when the suite was installed. To change the password, follow these steps:

1. Log in to the ITSMA Suite Configuration user interface as the sysadmin user:
https://[EXTERNAL_ACCESS_HOST>/itsmaconfig

2. Click Operation > Admin Password.

3. Enter the old and new passwords for the sysadmin user.

The password must be 10 to 30 characters in length and contain all of the following types of characters: uppercase letters,
lowercase letters, numbers, and special characters.

4. Click Update.
Service Portal administration
This section describes Service Portal administration tasks.

® Customize Service Portal
® Import Service Manager catalog item entitlement to Service Portal

Customize Service Portal

You can design the look and feel of Service Portal.

® Configure Service Portal display theme setting
® Configure Service Portal feature settings

Configure Service Portal display theme setting

ITSMA suite provides a default display theme for the Service Portal. You can create a custom display theme to suit your company's look and feel.

Themes settings page user interface

On Service Portal main page, click

and select Theme Settings.

Interface ltem Description

The theme for the Service Portal that is displayed. By default, the

Theme
out-of-the-box Standard (default) theme settings are displayed.

THEME: Standard (default) ~



Theme selection

(> Preview

More

Preview custom theme
Settings tab

Add a new theme

1. On Service Portal main page, click

and select Theme Settings.
2. Click

S

and select + New Theme.

The Create New Theme dialog box is displayed.

Click
e

to display a drop-down list of themes. You may select a previously
created theme, or create a theme.

THEME: Standar

Alpha

Beta

When you update a setting, you can click Preview to display the
change. The setting is only previewed and not saved until you click S
ave.

Preview custom theme
Hame Search Category page

When you have selected a theme other than the default, click More t
o display the following options:

® Rename - select to rename the theme.

® Delete - select to delete the theme.

® Enable - select to enable the theme. Only available for selection
when the theme is disabled.

® Disable - select to disable the theme. Only available for
selection when the theme is enabled.

® Set as default - select to set the theme as the default. Only
available for selection when the theme is enabled.

You can select which part of the Service Portal user interface the
theme settings are previewed on.

Area where you define the settings for the theme.



Create new theme

Theme name

Start from theme Standard hd

By defaulf, a theme is dizabled when you create it. Make sure to enable the

theme after you configure it.

CAMCEL

3. Type a suitable name for the theme.

4. From the drop-down list, select the theme to provide the initial settings that you want to customize.
For example, assume you previously created a custom theme named Alpha. You now want to create a similar theme, based on Alpha,
but perhaps with changes to the text color, and background. First, you would give your new theme a name. Then, you would select Alpha
from the drop-down list. If you want to create a theme based on the Standard theme, you would select Standard from the drop-down list.

. Click Create. The theme displays, but is disabled.

. To enable the theme, click More, and select Enable.

. Edit the settings as required. For more information, see

Click Save.

. To make the theme the default, click More, and select Set as default.

© o~ U,

Edit theme settings

The following table describes the theme settings:

Section Fields Affected area of Service Portal display

Header Name sonvespora +— D oo ]
Font/Text size/Text color/Bold
Logo

Background

Action ribbon Search box background
Ribbon button foreground
Ribbon button background
Ribbon button hover
Ribbon text

Ribbon text hover

Global page setting Background image | B e = o
Page baCkgrOUnd Mobile Phone Service #1
Page title

Section title |'

Content text
Link

Link mouseover
Clickable text

INTERACTIONS (4) MENTS(O)

Ghad amachmen

® Dropdown list background [

1= Critical
Drop-down list backgrourd

4 - Low



Buttons ® Submit button text
® Submit button background

POST

® Action button text _ _
* Action button 1 background Action button 1 Action button 2

® Action button 2 background

® Buttons disabled color

MARK AS SOLVED

Callout ® My callout background

® My callout text

® Counterpart callout background

® Counterpart callout text 0
MISC ® Search keyword highlight Showing resulfs for mail

Filter by Knowledge Offerings

Lotus Notes Account

A Lotus Notes License i required 1o access Lotus Notes applicaions,efmalfand fax services.

® Record form background

Almost done.

GENERIC SM SUPPORT CATALOG ITEM

This support catalog ilem is used 1o create support requests if no specific
support catalog item s selected by fhe user.

Recora fom
Petals: background

Order Name *

Generc SM Support Catalog tem

[ ] Live Chat bar text COlOr INITIALIZING CHAT FOR YOU, PLEASE WAIT mm
® Live chat bar background color



® Sidebar text

® Sidebar background

® Sidebar background blur 1 falcon, falcon
This setting blurs the image selected for
the background of the sidebar. You can
enter a two digit number. O displays the
image as it is and 99 blurs the image till
it is nearly opaque. 9 is the default =9 Your requests
setting.

[] Activate mobile app

Sidebar
background

NEWS

Install Lync Mobile App on a
Windows Phone Device

Issue with Shar#” dint

NO

Sidebar text

RECENT OFFERINGS

Name Change
JULY 12 2017

Configure Service Portal feature settings

ITSMA suite provides default feature settings for the Service Portal. You can change the following feature settings:

® Self-Service settings
Feature selection
Ribbon promotion
Portal loading page
Mobile app
® Portal profile page on first login
® Virtual agent and email integration
® Suggested links in email and support suggestion
® Miscellaneous
® Select category page type

Self-Service settings

Feature selection

By default, Q&A and Ideas are disabled, select On to enable a feature.

And the following features are enabled, select Off to disable a feature and remove all reference to it from the portal.
® Request on behalf

® Shopping cart
® Live chat



Ribbon promotion
In the Ribbon promotion section, you can select which of the following links display in the top ribbon of the Service Portal:

Ask friends

Help friends

Suggest idea

Your services and assets
Your approvals

Request on behalf

You can select up to four links to display.

Portal loading page
By default, the Service Portal light startup landing page is enabled. In the Enable portal loading page field, you can disable this by selecting Off.
If this option is enabled, on startup a standardized light landing page displays for users. While the portal loads in the background, users can:

® Start typing a request description

® Track their open requests:
® View open requests
® Accept or reject proposed solutions
® Provide more information

® View news

If users do not interact with the light landing page, it automatically closes when the portal loads.

Mobile app

By default, the ability to log in to the Service Portal using the mobile app is disabled. In the Enable mobile app field, you can enable this by
selecting On.

In the Mobile QR code URL field, you can customize the website URL placed into the mobile app QR code, default website URL is used if this
field is left blank.

Portal profile page on first login

On the Service Portal, there is a profile page for the user to complete. By default, this displays automatically when the user logs in for the first
time. In the Show portal profile page on first login field, you can disable this by selecting Off.

Virtual agent and email integration

Suggested links in email and support suggestion

On the Service Portal, the ability to display links to the following, in specially prepared email messages and virtual agent support, is enabled by
default. In this section, you can disable each type by selecting Off.

Articles
Q&A
News
Offerings

Miscellaneous

Select category page type

On the Service Portal, when a user clicks on a category tile, a page is displayed with three tabbed sections. You can configure the default section
that is displayed. Select the appropriate option in the Category page type field, as detailed in the following table.

Option Description
FEATURED A list of items in the following order:

All new items
Recommended offerings
Popular offerings

Article

(Out-of-the-box default)

There may be up to 30 items in this section.



OFFERINGS A list of offerings in the following order:

® Recommended offerings
® Popular offerings

There may be up to 20 items on each page of this section.

ARTICLES A list of articles in the following order:

® Recommended articles
® Other articles

There may be up to 20 items on each page of this section.

Import Service Manager catalog item entitlement to Service Portal

Service Manager catalog Item capability words and access filters can be imported to Service Portal of ITSMA. In Service Portal, the access
control of catalog items is achieved using user groups, and therefore, a user group is created for each capability word and access filter imported
from Service Manager.

To import the capability words and access filters from Service Manager to Service Portal, follow these steps.

1.
2.

H W

~

10.
11.
12.

13.

14.
15.

16.

Log in to the Service Portal administration portal as sysadmin: https://SEXTERNAL_ACCESS_HOST>/propel/launchpad.
Click Supplier, and then verify that the supplier is properly set for Service Manager. For more information about how to set a supplier,
refer to the Service Manager Help Center.

. Click the supplier for SM.
. On the detail page of the supplier, check the User Auto Entitlement checkbox and save.
. Go back to the Service Portal page, click Catalog Connect, and then verify that there is at least one aggregation with the offering type S

ervice Offering or Support Offering.

. In Service Manager, in the navigation tree, expand Miscellaneous, and then click System Status.
. Click Start Scheduler.
. On the Select startup record page, click propel to start the scheduler.

If you want to change the schedule interval, you need to modify the PropelSync schedule before you start the scheduler.

. After you start the scheduler, a user group is created for each Service Manager capability word, and its name starts with “SM_", for

example, “SM_AlwaysAdmin.” Likewise, a user group is created for each access filter, and its name starts with “SM_AF-", for

example, “SM_AF- 6664B6BEB9F75971.” Meanwhile, if a user exists in IDM and has a certain capability word(s) or meets a certain
access filter, the user will be add to the corresponding user group.

Wait a few minutes, go back to the Service Portal Admin page, and then click Identity.

Click the organization of ITSMA.

On the detail page of the organization, click the Groups tab, and make sure that all Service Manager capability words and access filters
have been imported.

Go back to the Service Portal page, click Catalog Connect, and then restart all the aggregations so that they run with the user groups
imported from Service Manager.

Go back to the Service Portal page, click Catalog Items, and then click a catalog item.

On the Access Control page, verify that Access Control Rule 1 has the user groups imported from Service Manager capability words.
Also verify that Access Control Rule 2 has the user groups imported from Service Manager access filters.

After you finish all these steps, Service Manager Service Catalog capability words and access filters have been imported to Service
Portal of ITSMA.

After the Service Manager catalog item entitlement is imported, end users can search their entitled offerings in Service Portal. In addition, end
users can also search their entitled KM articles and hot news in Service Portal. The KM entitlement is based on Service Manager KM entitlement.

Variables used in access filters

If an access filter leverages a variable, in order for this access filter to be imported and effective in Service Portal, you need to open the variablel
nfos table with the Database Manager, and then add the variable to this table.

While adding a variable, the following rules apply:

Variable Name must be identical to the variable name specified in the access filter.

When the variable points to a field in the operator table, Table Name must be operator, Field Name must be the field the variable
points to, Join Tables must be operator, Base Query Type must be operatorBaseQuery.

When the variable points to a field in the contacts table, Table Name must be contacts, Field Name must be the field the variable
points to, Join Tables must be operator and contacts, Base Query Type must be contactsBaseQuery.

When the variable points to a field in the Subscription table, Table Name must be Subscription, Field Name must be the field the
variable points to, Join Tables must be operator, contacts, and Subscription, and Base Query Type must be subscription
BaseQuery.


https://docs.software.hpe.com/SM/9.52/Hybrid/Content/install/smsp_install/add_sm_as_supplier.htm

Smart Analytics administration

As the Suite Administrator, you can perform the following administration tasks for Smart Analytics.

Add Smart Analytics content groups
Use Smart Analytics Assistant
Add trusted clients for Smart Analytics

Functional comparison of classic and containerized Smart Analytics

Functional comparison of classic and containerized Smart Analytics

Configure external connectors to work with Smart Analytics in ITSMA suite
Set stop words, stop phrases, and synonyms for Smart Analytics
Roll back from containerized Smart Analytics

The followng table provides a functional comparison of Classic and containerized Smart Analytics:

Function

Stop word

Stop Phrase

Synonyms

Data cleansing

Connector

(HTTP/SharePoint/File System)

Scale out Smart Search content

Redistribute

Classic Smart Analytics

Configure this function in the <Language
name>.dat file in the <Smart Analytics
Installation>/langfiles directory.

Configure this function in the gssp.db file in
the <Smart Analytics Installation>/Content1/
main directory.

Configure this function in the synonym.txt file
in the <Smart Analytics Installation>/
directory.

Configure this function in Service Manager
by clicking System Administration > Ongoi
ng Maintenance > Smart Analytics > Data
Cleansing.

Install Connector with CFS either on the
same computer as the Smart Analytics serve
r or on a different computer.

Configure connector to connect with Smart
Analytics Server Port. The default port
number is 9000.

1. Install the content server.

2. Edit the trusted client settings in the leve
I2proxy\IDOLServer.cfg file on the Smar
t Analytics proxy server. For detailed
instructions, see SM Help Center > Add
a content server for Smart Search.

3. Use the Service Manager Smart
Analytics Assistant (SAA) utility to add
this content.

Click the Redistribute button in the Service
Manager Smart Analytics Assistant.

Containerized Smart Analytics

Configure this function in the <Language
name>.dat file in the <Smart Analytics NFS
root folder>/data/idol/langfiles/ directory.

Configure this function in the gssp.db file in
the <Smart Analytics NFS root folder>/datali
dol/st/content[1,2]/main/ directory.

Configure this function in the synonym.txt file
in the <Smart Analytics NFS root folder>/con
fig/idol/synonym directory.

Configure this function in Service Manager b
y clicking System Administration > Ongoin
g Maintenance > Smart Analytics > Data
Cleansing.

Due to performance perspective and
SharePoint connector limitation (SharePoint
connector can be installed on Windows
only), connector with CFS must be installed
outside the Container. The installation
method for Connector with CFS is as same
as that in Classic mode.

Refer to Configure external connectors to
work with Smart Analytics in ITSMA suite for
detailed instructions.

Configure the connector to connect to Smart
Analytics Mix Proxy Port (the default port
number is 31370 in the 2017.07 release).

Configure the connector to connect to the
exposed DIH port (the default port number is
31370 in the 2017.02 and 2017.04 releases).

Click Operation > Smart Analytics > Add
Content Group.

Click the Redistribute button after you
successfully add a content group. This
button is enabled automatically.



Scale out Smart Ticket and Hot Topic
Analytics

Index

Search

Smart Analytics Assistant (SAA)

Smart Ticket Tuning

Extend Smart Ticket/Hot Topic
Analytics/Smart Search to other modules

OCR

Restart IDOL services

License

1. Install the content server.
2. Edit the <Smart Analytics Installation>/|
DOL/IDOLServer.cfg file.

Detail can be found in Service Manager Help
Center > Add a content server for Smart
Ticket and Hot Topic Analytics.

Connect to the Smart Analytics main server.

Connect to the Smart Analytics main server.

Use the saa command in Service Manager
to open the Smart Analytics Assistant page.

Configure this function in Service Manager
by clicking the System Administration > On
going Maintenance > Smart Analytics > S
mart Ticket > Tuning tab. For detailed
instructions, see Service Manager Help
Center > Configure Smart Ticket.

Configure this function in Service Manager.

For detailed instructions about how to extend
Hot Topic Analytics, see Service Manager H
elp Center > Enable Hot Topic Analytics for
other modules.

For detailed instructions about how to extend
Smart Ticket, see Service Manager Help
Center > Extend Smart Ticket to other
modules.

Connect to the Image Server by clicking Sys
tem Administration > Ongoing
Maintenance > Smart Analytics > Configu
ration. The default port number is 18000.

1. Execute the StopAll.sh script in the <S
mart Analytics Installation>/scripts/
directory.

2. Execute the StartAll.sh script in the <S
mart Analytics Installation>/scripts/
directory.

Smart Analytics module license.

Not supported.

Connect to DIH directly in containerized
mode.

Connect to the Mix Proxy in mixed mode.

Connect to DAH directly in containerized
mode.

Connect to the Search service in mixed
mode.

Click Operation > Smart Analytics, and
then expand the Smart Analytics Assistant
section.

Configure this function in Service Manager
by clicking the System Administration > On
going Maintenance > Smart Analytics > S
mart Ticket > Tuning tab. For detailed
instructions, see Service Manager Help
Center > Configure Smart Ticket.

Configure this function in Service Manager.

For detailed instructions about how to extend
Hot Topic Analytics, see Service Manager H
elp Center > Enable Hot Topic Analytics for
other modules.

For detailed instructions about how to extend
Smart Ticket, see Service Manager Help
Center > Extend Smart Ticket to other
modules.

Connect to the Image Server in the
container. The default port number is 31395.

You must apply both CompatibleF
orNG_Plus_SM941.unl

and CompatibleForNG_SM941t09
52.unl to SM 9.41 in the Mixed
mode. For more information, see |
nstall ITSMA in mixed mode
(scenario 1) > Task 6: Configure
integration with external Service
Manager > Apply unload files to
Service Manager.

Run the following commands on the master
node:

1. Execute the kubectl get pod
--all-namespaces | grep smarta comm
and to show all pods status.

2. Execute the kubectl delete pod
<pod_name> -n <namespace> comma
nd to stop the services.

ITSMA express license for fully containerized
mode.

Smart Analytics module license for external
SM in the Mixed mode.


https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=13572770
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SSL Two-way SSL is supported. SSL is disabled by default. To switch
between one-way SSL and two-way SSL, se
e Configure SSL for ITSMA in mixed mode.

® The outbound request of
search service supports
one-way SSL only.

Add Smart Analytics content groups

If the capacity of the existing smart search content groups is not enough for the indexed data, you can easily add content groups for Smart
Search.

The system does not display Service Management Content Group under either of the following circumstances:

® The installation and configuration process is not finished.
® The external SM has no Smart Analytics licenses.

To add Smart Analytics content groups, follow these steps:

1. On the suite landing page, click Suite Configuration.

For ITSMA, do not use the Smart Analytics Assistant utility available in the containerized Service Management or in the
external Service Management to add Smart Search content groups.

2. Click Operation > Smart Analytics.

3. View the capacity of the current content groups for Smart Search. The system provides on-screen recommendations for adding new
content groups based on the current document count and capacity of the existing content groups.

4. If you decide to add a new content group, click Add New Content Group.

When the system successfully adds a content group, the DIH service will restart so that the Smart Search feature stops
working until the process is finished. If the system fails to add a new content group, the DIH service will not restart and you can
continue to use Smart Search without any downtime.

If the "Adding a new content group"” status hangs for more than 10 minutes, some error might have occurred in the backend.
See the "Failed to scale out the content server" section in Smart Analytics troubleshooting.

5. Click Redistribute Documents to balance data distribution.

After you add a new content group, you are recommended to redistribute documents to improve query performance.

Use Smart Analytics Assistant

Smart Analytics Assistant is a tool that enables administrators to perform IDOL administrative actions in Smart Analytics. This tool provides a
command line on the user interface enables the administrator to send IDOL actions to Smart Analytics components. For example, you can use
this tool for content server maintenance, to check the system status, and for troubleshooting.

To use Smart Analytics Assistant, follow these steps:

. Log in to the ITSMA Suite Configuration user interface as sysadmin: https://SEXTERNAL_ACCESS_HOST>/itsmaconfig.
. Click Operation > Smart Analytics.
. Expand the Smart Analytics Assistant section.
. Double-click a Smart Analytics component in the Service Manager Components or Service Portal Components list.
w Service Manager Components

A WN R

Name Host Port Component description


https://docs.software.hpe.com/wiki/display/ITSMA201707/Configure+SSL+for+ITSMA+in+mixed+mode
https://docs.software.hpe.com/wiki/display/ITSMA201707/Smart+Analytics+troubleshooting

Smart Search DAH 1 smarta-ss-dah1-svc 9060 Supports query action for Service
Manager Smart Search

Smart Search DIH smarta-ss-dih-svc 31370 Supports index action for Service
Manager Smart Search

Mixed Mode Level Two Proxy smarta-mix-l2proxy-svc 31380 Supports query and index action
for Service Manager Smart
Search in mixed mode

Smart Search CFS smarta-ss-cfs-svc 31360 Sends index action for
attachment and external
connector to IDOL

Image Server smarta-ss-imgsvr-svc 18000 Analyzes and extracts content in
image

Smart Search DAH smarta-ss-dah-svc 9060 Load balancer for Smart Search
DAH(n)

Smart Search Content 1a smarta-ss-con-1la-svc 10010 Stores indexed records for
Service Manager Smart Search

Smart Search Content 1b smarta-ss-con-1b-svc 10010

Smart Search Content 2a smarta-ss-con-2a-svc 10010

Smart Search Content 2b smarta-ss-con-2b-svc 10010

Smart Ticket & Hot Topic smarta-st-proxy-svc 31390 Supports query and index action

Analytics Proxy for Service Manager Smart Ticket
and Hot Topic Analytics

Mixed Mode Main Proxy smarta-mix-proxy-svc 31370 Transfers request from consumer
to IDOL in mixed mode

Smart Ticket & Hot Topic smarta-st-con-1-svc 10010 Stores indexed records for

Analytics Content 1 Service Manager Smart Ticket
and Hot Topic Analytics

Smart Ticket & Hot Topic smarta-st-con-2-svc 10010

Analytics Content 2

Smart Search Agentstore smarta-ss-agent-svc 9050 Agentstore used by IDOL Server
to store agents and profiles

w Service Portal Components

Name Host Port Component Description

Service Portal DAH smarta-smsp-dah-svc 9060 Supports query action for Service
Portal search

Service Portal DIH smarta-smsp-dih-svc 31370 Supports index action for Service
Portal search

Service Portal QMS smarta-smsp-gqms-svc 16000 Supports type-ahead in Service
Portal search

Service Portal Content 1a smarta-smsp-con-la-svc 10010 Stores indexed records for
Service Portal search

Service Portal Content 1b smarta-smsp-con-1b-svc 10010

5. Select an action from the drop-down list. The system automatically populates the <Host> and <port> values in the action examples with
the corresponding values that you can find from the Service Manager Components or Service Portal Components list.
6. Click Run.

Follow these steps to manually restore the Category data for Smart Analytics:

1. Stop smarta-mix-proxy (in mixed mode), or stop smarta-st-proxy (in fully containerized mode).
2. Back up the Category data. To do this, follow the steps that are appropriate for your deployment:
a. To back up Category data in containerized Smart Analytics, use the Backup Component action in Smart Analytics Assistant in
the suite.
b. To back up Category data in external Smart Analytics, use the Backup Component action in the external Smart Analytics
Assistant.
By default, the Smart Analytics server Category Port is 9020.
3. Restore the Category data. To do this, follow these steps:
a. Copy the *.zip backup file generated in the previous step to the <Smart Analytics NFS root folder>/data/idol/mix/proxy directory
on the NFS server.
b. Delete all files and folders in the <Smart Analytics NFS root folder>/data/idol/mix/proxy directory.
Unzip the backup file and replace the existing files.
d. Runthe chmod -R itsma:itsma <Smart Analytics NFS root folder>/data/idol/mix/proxy command to grant the container pod

o



access rights to this folder.
4. Start smarta-mix-proxy (in mixed mode), or start smarta-st-proxy (in fully containerized mode).

Note that some action commands only work with certain Smart Analytics components in the suite. Refer to the following table for detailed

descriptions.

Action name

View Status

View Action History

View Index Status

View Root Category
Detail

Back up Component

Restore Content Server

Synchronize Category

Action example

http://<Host>:<port>/act
ion=GetStatus

http://<Host>:<port>/act
ion=GRL&format=xml

http://<Host>:<port>/act
ion=indexerGetStatus

http://<Host>:<port>/act
ion=CategoryGetHierD
etails

http://<Host>:<port>/act
ion=BackupServer&pat
h=/var/backup

http://<Host>:<port>/act
ion=RestoreServer&file
name=/var/backup/***.z

p

http://<Host>:<MainPro
xyACIPort>/action=Cat
egorySyncCatDRE

Description

Requests details of all
components. Check
whether all components
are up and running;
checks how many
documents are in each
database.

Displays a log of
requests, including the
date and time that a
request was made, the
client IP address that
made the request, and
the internal thread that
handled the action.

Checks the status of
index actions in the
Smart Analytics index
queue.

Displays the root
categories after
training.

Creates a backup that
can be used to restore
the component'’s state.
You can use this action
for the Content,
Category, Agent, and
Community
components, but you
must send the action to
the component ACI port
rather than to the IDOL
Proxy port. The backup
file is stored in the path
that you specified.

Restores the content of
a content server that
was previously backed
up.

Synchronize and build
the category after you
restore the Category
component.

When
running this
action for S
mart Ticket
& Hot Topic
Analytics
Proxy in
fully

Allowed component

all

dih

12proxy

content

main proxy

category

content

mainproxy

category

content

category

Allowed port

<Host>:<ACI_Port>

<Host>:<ACI_Port>

smarta-<ss/st>-dih-svc:31370

Mixed mode

fully containerized

smarta-mix-I2proxy-svc:
31380

None

<CONTENT_SERVICE>:10010

Mixed mode

fully containerized

Mixed mode

fully containerized

smarta-mix-proxy-svc:3
1370

smarta-st-proxy-svc:31
390

smarta-mix-proxy-svc:3
1390

smarta-st-proxy-svc:31
410

<CONTENT_SERVICE>:10010

Mixed mode

fully containerized

Mixed mode

fully containerized

smarta-mix-proxy-svc:3
1370

smarta-st-proxy-svc:31
390

smarta-mix-proxy-svc:3
1390

smarta-st-proxy-svc:31
410

<CONTENT_SERVICE>:10010

Mixed mode

smarta-mix-proxy-svc:3
1390



Back up Database

Restore Database

http://<Host>:<indexPor
t>/DREEXPORTIDX?fil
ename=c:/BackupFolde
rName/FilePrefix&Data
baseMatch=<Database
_name>&HostDetails=tr
ue

http://<MainProxyHost>
:<IndexPort>/DREADD

?FileName=/var/backup
/*** jdx& DREDbName=

***&CreateDatabase=Tr
ue

containerize
d mode, you
must
manually
enter port
number 314
10 in the
action
examples.

Exports all the index
documents for a
database from the
Smart Analytics content
server to a series of
compressed files in the
defined backup
directory. This

action backs up
individual databases. If
you want to backup all
databases on a content
server, use the action
Backup Component as
mentioned above.

Restores the index IDX
exported before. If no
DREDbName is
specified, use the
dbname of the indexed
file.

dih

Iv2 proxy

main proxy

content

dih

Iv2 proxy

main proxy

content

fully containerized

smarta-st-proxy-svc:31
410

smarta-<ss/st>-dih-svc:31371

Mixed mode

fully containerized

Mixed mode

fully containerized

smarta-mix-I2proxy-svc:
31381

None

smarta-mix-proxy-svc:3
1371

smarta-st-proxy-svc:31
391

<CONTENT_SERVICE>:10011

smarta-<ss/st>-dih-svc:31371

Mixed mode

fully containerized

Mixed mode

fully containerized

smarta-mix-I2proxy-svc:
31381

None

smarta-mix-proxy-svc:3
1371

smarta-st-proxy-svc:31
391

<CONTENT_SERVICE>:10011

The system does not display the Service Manager Components list under either of the following circumstances:

® The installation and configuration process is not finished.
® The external Service Manager has no Smart Analytics licenses.

For ITSMA, always use the Smart Analytics Assistant (SAA) utility available in the Suite Configuration user interface. Do not use the
SAA utility available in the containerized Service Management or in the external Service Management.

Add trusted clients for Smart Analytics

To improve security, you can restrict access to Smart Analytics to specific Service Manager servlet FQDNs or addresses. Only those Service

Manager servlets whose hostnames or IP addresses are listed as trusted clients can send requests and receive responses from the containerized

Smart Analytics.

To add a Smart Analytics trusted client, follow these steps:

1. On the suite landing page, click Suite Configuration.
2. Click Operation > Smart Analytics.
3. Expand the Add a Trusted Client section. The default value is *, which means all Service Manager servers can connect to the

containerized Smart Analytics.
4. Type the FQDN or IP address of a Service Manager servlet in the text field. You can separate multiple FQDNSs or IP addresses by

commas. Do not add any spaces between the FQDNs or IP addresses and commas.

For example, abc0123.lab.net,15.192.87.1,15.192.87.2,15.192.87.3

Do not add the master node FQDN or IP to the Trusted Client field.

You must add worker nodes as trusted clients. Run the kubectl get nodes --show-labels command to find the IP addresses
of the worker nodes.




5.

Click Apply, and then click Yes in the pop-up window to confirm.
It may take some time for the configuration to take effect. Wait until the Service Manager components under the Smart Analytics
Assistant tab are online again.

If the hostname or IP address of a Service Manager servlet is changed, you must manually update the information in the trusted clients
list. Also, you must perform a full reindex manually after you change the Service Manager data volume. If you do not, Smart Search
results from the old volume may be returned.

Configure external connectors to work with Smart Analytics in ITSMA suite

To enable search actions among different data sources, you need to configure different external connectors and servers to work with Smart
Analytics in the ITSMA suite.

If you are working with Service Manager 9.41, You need to update the IDOLTOKEN length value to 100. To do this, follow these steps:

. Log on to Service Manager as a system administrator.

. Type dbdict in the Service Manager command line, and then press Enter.
. Search for kmknowledge.

. Select IDOLToken, and then update the length value from 60 to 100.

. Click Save.

b wWNPE

Configure SharePoint Connector
Configure HTTP Connector
Configure File System Connector

Configure SharePoint Connector

® If you have never installed Smart Analytics SharePoint connectors before, perform Task 1, Task 2, and Task 4.
® If you have already installed and configured SharePoint Connector with a CFS server, perform Task 3 and Task 4 (Step 4 to
Step 6).

To enable search actions in SharePoint, you must install and configure the SharePoint connector with CFS outside the containerized
environment. To do this, perform the following tasks:

Task 1: Install SharePoint with a CFS server

Follow these steps:

1.

S EGIENEANN]

~

Save the Smart Analytics 9.52 installer from http://www.hpe.com/software/entittements to your computer, and then unzip this installation
package.

. Unpack the .zip file, and then double-click the setup application (setupSmartAnalyticsWindowsX64.exe).

The HPE SM 9.52 SmartAnalytics Setup wizard opens. Read the introduction, and then click Next.

. Read the license agreement, select | accept the terms of the License Agreement, and then click Next.
. Select New Installation, and then click Next.

Choose an installation folder, and then click Next. The default installation folder is C:\Program Files(x86)\HPE\Service Manager
9.52\SmartAnalytics.

. Select Advanced Install as your installation type, and then click Next.
. Enter the external access host in the SM Server IP field, and then click Next.


http://www.hpe.com/software/entitlements
https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=10753166#ConfigureexternalconnectorstoworkwithSmartAnalyticsinITSMAsuite-SharepointTask1
https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=10753166#ConfigureexternalconnectorstoworkwithSmartAnalyticsinITSMAsuite-SharepointTask2
https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=10753166#ConfigureexternalconnectorstoworkwithSmartAnalyticsinITSMAsuite-SharepointTask4
https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=10753166#ConfigureexternalconnectorstoworkwithSmartAnalyticsinITSMAsuite-SharepointTask3
https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=10753166#ConfigureexternalconnectorstoworkwithSmartAnalyticsinITSMAsuite-SharepointTask4

-
E HPE 5M 9.52 SmartAnalytics =

Configure SM Server IP

° Introduction

o License Agreement Specify the IP address of SM server. Please use avalid FQDM or IP

° Installation or Upgrade Address for the server address. Do notuse localhost or 127.0.0.1.

@ choose Install Folder

° Choose Installation Type

o Configurations
Pre-Installation Summary

SM Server IP: | <EXTERNAL ACUCESS HOST=

Installing. .. = =

Start Semvice

Install Complete

—
Hewlett Packard
Enterprise

Installamywhere

Previous I| Mext |

b

9. Select Customize in the Install Template drop-down list, and then select OMNI Group Server (for Security SharePoint) and SharePoint
Connector. Click Next.

pt
HPE 5M 9.52 SmartAnalytics =]l =

Choose Distributed Components

@ ntroduction
° License Agreement

) Install Template Customize -]
° Installation or Upgrade - :
@ choose Install Folder [ Image Server &
° Choose Installation Type [T] €Fs Server
© configurations OMNI Group Server ‘E
Pre-Installation Summary SharePoint Connector &
Installing... [] HTTP Connector
[] File System Connector -

Start Service
Install Complete OMNI Group Server collects user and group security
information from a variety of repositories.

—
Hewlett Packard
Enterprise

Installanywhere

Brevious | [ Next

10. Select No if there are no CFS servers installed on this computer. Otherwise, select Yes.
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HPE 5M 9.52 SmartAnalytics =l

Check CFS Dependency
O Introduction
o License Agreement Connecotors need a CFS server installed locally to transfer content.
Q Installation or Upgrade |s there a Connector Framewaork Server (CFS) already installed on

. .
@ choose Install Folder this machine

° Choose Installation Type

o Configurations
Pre-Installation Summary
Installing.. ~~~~ —
Start Senvice @ e

Install Complete

—
Hewlett Packard
Enterprise

Installamywhere

Brevious | [ MNext

You must install the external SharePoint connector and the CFS server on the same computer.

11. Enter the SM Smart Analytics Server IP and port as follows, and then enter the CFS Server port and Service port. Click Next.
SM Smart Analytics Server IP: <EXTERNAL_ACCESS_HOST>
SM Smart Analytics Server Port: 31370
CFS Port: 7000
CFS Service Port: 7001



HPE SM 9,52 SmartAnalytics i |

Configure CFS

a Introduction

@ License Agreement Please specify the HPE SM Smart Analytics server's IP and port,
Q Installation or Upgrade which will be used to commnunicate with the CF3 server.

@ choose Install Folder

) Please specify the ports for the CF3 server.
Q Choose Installation Type

0 Configurations HPE 5M Smart Analytics Server IP:
Pre-Installation Summary <EXTERMAL. ACCESS HOST=
Installing. .. HPE 5M Smart Analytics Server Port:
Start Semvice 31370
Install Complete CFS Port:

— CFS Service Port:
Hewlett Packard |
Enterprise

Installamywhere

Cancel Erevious Mext

If you have modified the CFS Port from 7000 to another number, you need to update the value for the IngestPort parameter to
the modified port number in the Connector configuration file (such as SharepointRemoteConnector.cfg). The file should
resemble the following:

[Ingestion]

IngestHost=127.0.0.1

IngestPort=7000

12. Enter the OMNI Group Server Port and Service Port (for Security SharePoint), and then click Next.

13. Configure the LDAP Repository information, and then click Next. If you want to index SharePoint without security, skip the configuration,
and then click Next directly.

14. Configure the SharePoint Connector information, and then click Next.

15. Click Install to install OMNI Group Server (for Security SharePoint), SharePoint Connector and CFS Server.

Task 2: Configure the SharepointRemoteConnector.cfg file
Follow these steps:

1. Go to <SharePoint Installation directory>/SharepointRemoteConnector, and then open the SharepointRemoteConnector.cfg file with a
text editor.
2. Configure the [FetchTasks] and [MyTask] sections as needed.



=i [FetchTasks]
2 Nurber=1

83 O=MyTask

=

S5 [Default]

=1

57 [[MyTask]

25  |Bharepointonline=false

22 |BharepointUrlType=3iteCollection

20 (3harepointUrl=http:/ agdlicvniSZ2l.asiapacific. hpgoorp. net s
291 |Usernasme=cacjiac

Q2 Password=9zTvwsLGmpm¥ ] IvHEA

a3

=k IndexSites=true

95 IndexLists=true

=0 IndexFolders=true

=i Indexittachments=trues

=l IndexU=zerProfilezs=false

295 MappedSecurity=true

00 EncryptACLEntries=true

01 //Domain=DOMATN

0z IncludeProviderName InACLe=true
03 GroupServerbebuglutputFile=8ynchronizeGroupsDEBUG. log
04 ZcheduleCyoles=-1

05 UzeEmailliscrouplame=true

. Restart your SharePoint Connector Server.
. (Mixed mode only) If you want to use OMNI Group Server (for Security SharePoint), continue with the following steps. Otherwise, goto T
ask 4.

The fully containerized mode does not support OMNI Group Server for SharePoint Connector.

a. Go to <SharePoint Installation directory>/OmniGroupServer, and then open the OmniGroupServer.cfg file with a text editor.

b. Configure the [LDAP] and [Sharepoint] sections as needed.
&4 [rLoar]
55 JietiveDirectory=True
66 fSroupServerLibrary=ogs_ldap.dll
a7 /GroupServerCycles=1
55  LDAPZerver=2381W00&0.asiapacific.hpgoorp. net
52 LDAFPOrt=3gso9
70 LDAPUserBase=0U=CN, 0U=Users, OU=LAccounts, DC=asiapacific, DC=cpgoorp, DC=net
71 [LDAPGroupBase=CN=FDL-HP3W-EnD-3H-3MEhp.com, OU=Managed Groups,0U=Aoccounts, DC=asiapacific,DC=cpogoorp, DC=net
TR /UzerFilter=(objectClass=hpEmplovees)
73 /GroupFilter={objectClass=hpGroup)
74 [LDAPUsername=jiaoc.cacfhpe.com
75 LDAPPassword=9sTvwsLGmpm¥] IvHMSL
Ta
77 ExtractDomainFrombN=true
75 LDAPMode=Group
79 Page3ize=10000
S0  EKeyUserName=siMiccountName
51 LDAPEnsbkleReverseLookup=true
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103 [BharePoint]
104 GrouplerverdobhType=Connector
105 ConhectorHost=127.0.0.1

106 |ConnectorPort=36000 |
10% ConnectorTask=MyTask
105

c. Restart the OMNI Group Server.

d. Go to the Mix Proxy directory in Container (for example, /var/vols/itom/itsma/itsma-itsma-smartanalytics/config/idol/st/mixProxy),
and then edit the proxy.cfg file.

e. Uncomment GooupServerHost and GroupServerPort, and then update the values to OMNI Group Server Host and Port,
respectively.

474
475
476
477
475
479
450
451
452
453
454
455
456
487
485
459

[SharePoint]

/4 huthentication

Library=C:‘\Program Files (x86)%HP)Service Manager 9.41%Smartinalytics/wodules/user ldapsecurity
V4=TRUE

EnahlelLogging=TRUE

Document3ecurity=True

CaselensitivelserNames=False

CazelfensitiveGroupNames=False

SecurityFieldC3Vs=usernsame, group

DocumentS3ecurityType=3harePoint

GroupServerHost=16.187.159.94
GroupServerPort=505ﬂ

GroupServerBepository=Combine
//8yneRolesFromGroups=true
EnahlelLogging=TRUE
EscapedEntries=true

f. Restart the Mix Proxy server.

Run the following commands on the master node to stop the Mix Proxy server:
kubectl get pod --all-namespaces | grep smarta-mix-proxy

kubectl delete pod <pod_name> -n <namespace>

Task 3: Configure the CFS connector, Smart Analytics server host, and port

To modify the existing configuration and connect to Smart Analytics in Container, follow these steps:

1. Go to <CFS Installation directory>/CFS, and then open the CFS.cfg file with a text editor.
2. Locate the [IdolServer] section, and then modify the host and port as follows:

[IdolServer]

Host=<EXTERNAL_ACCESS_HOST>

Port=31370

DefaultDatabaseName=News
//SSLConfig=SSLOptionl
3. Save your changes, and then restart the CFS service.

Task 4: Configure SharePoint Connector in Service Manager

1. Log on to Service Manager, and then click System Administration > Ongoing Maintenance > Smart Analytics > Smart Search. The
Smart Search configuration page opens.
2. Click the Connector Configuration link to open the connector configuration page.
3. Go to the SharePoint Connector tab, and then perform the following actions:
a. Type a configured SharePoint connector URL in the Add a SharePoint connector field (for example: http://192.168.255.255:3600
0/). You can skip this step if you have configured this URL in Service Manager before.


http://192.168.255.255:36000/
http://192.168.255.255:36000/

Connector Configuration and Monitor

kdonitar connectar status using this forem,

< CFSServer | < SharePoint Connector | ¢ OMMNI Group Server | ¢ HTTP Connector | < File Systemn Connector

Add a SharePoint connector

” | |Test CammaEian | | Add sitAfccountMame Field _
For sxampls : http:d12 3.4, 56360007
Al task Delete | ‘ Reftesh Status |
Connector URL Status
bt/ I Online

The “/" at the end of the URL is mandatory. Make sure that SharePoint is online.

b. Choose the field type from the sAMAccountName Field drop-down list. This field is the mapping field of SharePoint and Service
Manager users.

Connector Configuration and Monitor

Monitor connectar status using this farm,

< CFSServer | & SharePoint Connector | ¢ OMMI Group Server | & HTTP Connector | < File Systern Connectar

Add a SharePoint connector

| |Test Conmeeizm | | Add s&hlfccauntMame Fiald

Display Currency |~
Do Passnrord Reset

Forsxampls : hittp. 12 3.4 5636000/

Connectar URL Status
hittp:// I Online

Ess Access Only
Ess Initial &pp
Ess Initial App Marr o
—( ' ...IIII ) )
4. (For Security SharePoint) Go to <SharePoint Installation directory>/OmniGroupServer, and then open the OmniGroupServer.cfg file with
a text editor.

5. Set the value of FieldNameO to the option you selected for the sAMAccountName Field drop-down list.

ExtractDomainFromD=true

LDAPMode=Group

Page3ize=10000

EKeyUserName=sAMiccountName |

LDAPEnableReverseloockup=true

EeyGroupName=mail
KevMenber=member
LDAPDebugLogaing=TRUE
FieldEeyO=sAMiccountName
FieldNameO=Email
FieldEeyl=mail

FieldNamel=mail

FieldEevZ=cn

FieldNamez=cn

Group3erverMaxDatastorefueue=100000

Jiremove domain prefix for groups

GrouplerverOpl=3tartifter

Group3erverOpParamd=0;"%

GrouplerverCplpplyToO=GROUP

JAJdust to avoid unnecessary queries for wenbers that don't exist.
f#Thizs might not hawve any effect if the group memnbers are properly managed.
DisableUserFrombiSearch=TRUE

DizabhleGroupFromblSearch=TRUE

6. Restart the Omni Group server.
7. Do the following to add a splib library for the SharePoint connector. You can skip this step if you have added a splib library in Service
Manager before.
a. Open the Smart Search Configuration page.
b. Enter the Knowledgebase Name.
c. Select splib in the Type drop-down list.
d. Click Add. The Knowledgebase Maintenance page opens.



art Search Configuration

lit Global Search Configuration

dd Knowledgebase Environment C

Krowledgebase Marme |dem|:|sharepl:|int |

Type |sp|ih | v |
| Add |

8. Enter a Connector and Task, and then select the Do not use OmniGroupServer for access count check box if you are not configuring
an Omni Group Server.

nowledgebase Maintenance

demosharepoint

Status Display Mame
Status Offline Connectar | htp: - I - 50007 v
Type splib Task [MYTASK v
Last Update Time Refresh Interval [q S [wifio rot use OmniGroupServer for access conl
[
1= S minutes
Error
Id Error Message Tirme & Seript
Knoledgebase access script demosharepoint _kmaccess
| Full Reindex ” Refresh Statistics
9. Click Save.

10. Click Full Reindex and Refresh Status.

You need to create multiple libraries for each task if you have configured multiple tasks in the SharepointRemoteConnector.cfg
file.

11. You can perform a search when the status changes to Indexing and the Doc Count for this library is greater than 1.

Log off and then log back on to Service Manager if you can not find the library in your Smart Search library list.

Configure HTTP Connector

® |f you have never installed Smart Analytics HTTP connectors before, perform Task 1, Task 2, and Task 4.
® |f you have already installed and configured HTTP Connector with CFS server, perform Task 3 and Task 4 (Step 5 and Step 6).

To enable search actions in web sites, you must install and configure the HTTP Connector with CFS out of Container. To do this, perform the
following tasks:

Task 1: Install HTTP Connector with a CFS server

. Download the Smart Analytics 9.52 installer from http://www.hpe.com/software/entitiements, and then unzip this installation package.

. Unpack the .zip file and then double-click the setup application (setupSmartAnalyticsWindowsX64.exe).

The HPE Service Manager 9.52 SmartAnalytics Setup wizard opens. Read the introduction, and then click Next.

. Read the License Agreement. To continue the installation, select | accept the terms of the License Agreement, and then click Next.
. Select New Installation, and then click Next.

. Choose an installation folder, and then click Next. The default installation folder is C:\Program Files(x86)\HPE\Service Manager
9.52\SmartAnalytics.

ouhwWNR


http://www.hpe.com/software/entitlements
https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=10753166#ConfigureexternalconnectorstoworkwithSmartAnalyticsinITSMAsuite-HTTPTask1
https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=10753166#ConfigureexternalconnectorstoworkwithSmartAnalyticsinITSMAsuite-HTTPTask2
https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=10753166#ConfigureexternalconnectorstoworkwithSmartAnalyticsinITSMAsuite-HTTPTask4
https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=10753166#ConfigureexternalconnectorstoworkwithSmartAnalyticsinITSMAsuite-HTTPTask3
https://docs.software.hpe.com/wiki/pages/viewpage.action?pageId=10753166#ConfigureexternalconnectorstoworkwithSmartAnalyticsinITSMAsuite-HTTPTask4

7. Select Advanced Install as your installation type, and then click Next.
8. Enter the external access host in the SM Server IP field, and then click Next.

p
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° Installation or Upgrade Address for the server address. Do notuse localhost or 127.0.0.1.

@ choose Install Folder
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—
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9. Select Customize in the Install Template drop-down list, and then select HTTP Connector. Click Next.
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10. Select No if there are no CFS servers installed on this computer. Otherwise, select Yes.
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O Introduction
o License Agreement Connecotors need a CFS server installed locally to transfer content.
Q Installation or Upgrade |s there a Connector Framewaork Server (CFS) already installed on

. .
@ choose Install Folder this machine

° Choose Installation Type

o Configurations
Pre-Installation Summary
Installing.. ~~~~ —
Start Senvice @ e

Install Complete

—
Hewlett Packard
Enterprise

Installamywhere
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You must install the external HTTP connector and the CFS server on the same computer.

11. Enter the Service Manager Smart Analytics Server IP and port as follows, and then enter the CFS Server port and Service port. Click Nex
t.
Service Manager Smart Analytics Server IP: <EXTERNAL_ACCESS_HOST>
Service Manager Smart Analytics Server Port: 31370
CFS Port: 7000
CFS Service Port: 7001
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@ choose Install Folder
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Q Choose Installation Type

0 Configurations HPE 5M Smart Analytics Server IP:
Pre-Installation Summary <EXTERMAL. ACCESS HOST=
Installing. .. HPE 5M Smart Analytics Server Port:
Start Semvice 31370
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If you have modified the CFS Port from 7000 to another, you need to update the value for the IngestPort parameter to the
modified port number in the Connector configuration file (such as httpconnector.cfg). The file should resemble the following:
[Ingestion]

IngestHost=127.0.0.1

IngestPort=7000

12. Configure the HTTP Connector Server Port and HTTP Connector Service Port, and then click Next.
13. Click Install to install the HTTP Connector and CFS Server.
Task 2: Configure the httpconnector.cfg file

1. Goto <HTTP Connector Installation directory>/HTTPConnector, and then open the HTTPConnector.cfg file with a text editor.
2. Configure the [FetchTasks] and [MYSITE] sections as needed.



=13 [FetchTasks]

56 |MNumber=1
57 J0=MY¥SITE

55

5o [[MYSITE]
60 JURL=https://en.wikipedia.org/wiki/Main Page
51 |DIRECTORY¥=HTTPoonnector

G2 CantHawvel3Ws=*.cs3, .3

B3 CantHaveCheck=1

64 |8 tcayindice=True

65 |/ /Depth=59

a6 JProxyHost=proxy. _ com

&7 |ProxyPort=5030

68 F/FOLLONROBOIPROTOCOL=F LLoE
69 ff———-Login with form——-—-
700 A /LOGINMETHOD=FORMPOST

71 SALOSINURL=https:// login.comd

7i //LOGINUSERFIELD=0S username

73 A/ LOGINUSERVALUE=USERNAME[M COMP ANY . COM
74 //LOGINPASSFIELD=05 password

= .-"'.-"'LOGII‘-IPASSUALUE=PASSWORD_ENCRYPTED
76 AfLogin3ubmitField=ButtonID

77 A f———-HTTP digest authenticatioh----
78 J/DigestUsername=UIERNALME

=) .-"'.-"'DigESt.PaSSWDrd=PASSWORD_ENCRYPTED
20 ff=——-NTLM amuthentication----

21 A /NTLMUsernsme=USERNLME

g2 S HNTLMPassword=FPASSWORD

3. (Optional) To configure multiple tasks, configure the .cfg file as follows:

[FetchTasks]
Number=2
0=MYSITE1
1=MYSITE2
[MYSITE1]

[MYSITEZ]

The file should resemble the following:



55 FetchTasks
56 urber==2
5% JO=HMY3ITE
55 1=WikibwvJ
1=
&0 [MYSITE]
61 URL=https://en.wikipedia.org/wiki/Main Page
35 DIRECTORY=HTTPoconnector
63 CantHaveCSVa=+%, 022, .32
54 CantHawveCheck=1
65 fi8tayOndite=True
66 f/Depth=93
67 Prnxngcnst=prcnx5r._.cDm
55  ProxyPort=8080
62 J/FOLLOWEOBOTPROTOCOL=FALIE
70 ff----Login with form----
71 F/LOGINMETHOD=FORMPOST
7z J/LOGINURL=https://login.com/
7E 0 //LOGINUSERFIELD=0s username
74 J/LOGINUSERVALUE=UIERNAME[@COMPANY. CON
75 //LOGINPASSFIELD=o0s password
76 ffLOGINPASS?ALUE=PASSHORD_ENCRYPTED
77 fiLoginSubmitField=EuttonlID
75 ff----HTTP digest authentication----
79 fiDigestUsername=T3ERNANE
30 ffDigestPasswnrd=PASSHORD_ENCRYPTED
1 //--—-NTLM authentication----
32 S/NTLMUzername=UIERNLME
33 //NTLMPassword=FPASIWCORD
34
35 | [Wikikwa]
i6 |URL=https://en.wikipedia.org/wiki/Main Page
37 |DIRECTORY=HTTPoonhectaor
S5 JCantHawveCiVs=*.,oss3, %, s
32 |CantHaveCheck=1
a0 | istcayinsice=True
21 |/ /Depth=93
£l PergHDst=pery._.cnm
23 |ProxyPort=8080
24 J/FOLLOWEOBOTPROTOCOL=FALLIE
15 ff-—-—-Login with form----
4. Restart the HTTP Connector Server.

Task 3: Configure the CFS connector, Smart Analytics server host, and port
To modify the existing configuration and connect to containerized Smart Analytics, follow these steps:

1. Go to <CFS Installation directory>/CFS, and then open the CFS.cfg file with a text editor.
2. Locate the [IdolServer] section, and then modify the host and port as follows:

[IdolServer]
Host=<EXTERNAL_ACCESS_HOST>
Port=31370
DefaultDatabaseName=News
//SSLConfig=SSLOption1
3. Save your changes, and then restart the CFS service.



Task 4: Configure HTTP Connector in Service Manager

Log on to Service Manager, and then click System Administration > Ongoing Maintenance > Smart Analytics > Smart Search. The
Smart Search configuration page opens.

. Click the Connector Configuration link to open the connector configuration page.
Go to the HTTP Connector tab, perform the following actions:

a. Type a configured HTTP connector URL in the Add a HTTP connector field, for example: http://192.168.255.255:5678/. You
can skip this step if you have configured this URL in SM before.

The “/” at the end of the URL is mandatory.
Make sure the HTTP Connector's status is online.

2 To Do Queve: My To DoList | [& Search seversion Records

& scversion: scversion
$8 Cancel [ Save & Bxit Save

& Smart Analytics Configuration 53

[Connector Configuration and Monitor
anitor connector status using this form,
& CFSServer | & SharePoint Connector | & OMMI Group Server | & HTTP Connector | & File System Connector

Add a HTTP connector

I | [Test Connection Add

For sample : hitp:/7/ 12.5.4 56,5678

All task Delete | | Refresh status
Connectar URL Status
http:// I 5675/

Online

b. You can click Test connection to test the URL connection status, and click Add to add this URL to the current list.

4. Add a weblib library for the sharepoint connector (you can skip this step if you have added a weblib library to Service Manager before).
To do this, follow these steps:

a. Go to the Smart Search Configuration page.

b. Enter a Knowledgebase Name.

c. Select weblib in the Type drop-down list.

d. Click Add. The Knowledgebase Maintenance page opens.

Smart Search Configuration
Edit Global Search Configuration

Add Knowledgebase

Knowledgebase Name {demnwiki |

Type |'weh|ib | v |

| Add |

5. Enter a Connector and Task, and then click Save.
6. Click Full Reindex and Refresh Status.

You need to create multiple libraries for each task if you have configured multiple tasks in the HTTPConnector.cfg file.

Knowledgebase Maintenance

demowikibylora
Status

Display Mame
Status Offline Connector [ http:/// IR, 5 675/ v
Type weblib Task |l

Last Update Time

Refresh Interval |MVSITE

WIKIBY)
Error

Id Error Message Tirme @ Script

Knowledgebase access script


http://192.168.255.255:5678/

Knowledgebase Maintenance

demowikibylora

Status Display Mame  [dermowik]
Status Offline Connectar [ bt/ DR 5 675/ v
Type weblib Task [wkIBY) -
Last Update Tirme Refresh Interal |2 -

1= 5 minutss
Error

Id Error Message Time & Script

Enowdedgebase access script dernowikiby)_kmaccess

| Full Reindesx | | Refresh Statistics |

7. You can perform a search when the status changes to Indexing and the Doc Count for this library is greater than 1.

Log off and then log back on to Service Manager if you can not find the library in your Smart Search library list.

B 0K $8 Cancel [F Save 5 Delete O Find

@ kmknowledgebase record updated.

Knowledgebase Maintenance

demowikiby)
Status Display Mame  [demowiki

Status Connector [hitp:// N5 575 ‘ ™

Type weblib Task [WWIKIBY) E

Last Updte Time Refresh Interval [ -

1= 5 minutes
Error
d Error Message Tirme & Seript
Knowledgebase access script dernowikibyl_kmaccess
Full Reindex | [ Refresh statistics
Current Knowledgebase List

Knowledgebase Ma..  Type Display Mame Intersal Index Status Doc Count Last Index Tirme
Catalog_Library sclib Catalogs 1 Finished 1105153 220 1:07
Change_Library sclib Changes 1 Finished 36 110515 22111
Contact_Library sclib Contacts 1 Finished 11/05/15 22:11:49
Departrnent_Library  sclib Departrments 1 Offline
Device_Library sclib Configuration ltems 1 Offline
Incident_Library sclib Incidents 1 Finished 11705115 03:35:12
Interaction_Library sclib Interactions 1 Finished 1105153 03:35:22
Enowledge_Library  sclib knowledge Library 1 Finished 111115 02:07:40
KnownError_Library  sclib known Errors 1 Offline
Location_Library sclib Locations 1 Offline
Problerm_Library sclib Prablems 1 Offline 2
Request_Library sclib Requests 1 Offline
demowikibylora wvehlib demouiki 2 Indexing 100

Configure File System Connector

® |f you have never installed Smart Analytics File System connectors before, perform Task 1, Task 2, and Task 4.
® |f you have already installed and configured File System Connector with CFS server, perform Task 3 and Task 4 (Step 5 and
Step 6).

To enable search actions in file systems, you must install and configure the File System Connector with CFS out of Container. To do this, perform
these tasks:
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Task 1: Install File System Connector with a CFS server

. Download the Smart Analytics 9.52 installer from http://www.hpe.com/software/entitiements, and then unzip this installation package.
. Unpack the .zip file and then double-click the setup application (setupSmartAnalyticsWindowsX64.exe).
The HPE Service Manager 9.52 Smart Analytics Setup wizard opens. Read the introduction, and then click Next.
. Read the License Agreement. To continue the installation, select | accept the terms of the License Agreement, and then click Next.
. Select New Installation, and then click Next.
. Choose an installation folder, and then click Next. The default installation folder is C:\Program Files(x86)\HPE\Service Manager
9.52\SmartAnalytics.
. Select Advanced Install as your installation type, and then click Next.
8. Enter the external access host in the SM Server IP field, and then click Next.
5
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9. Select Customize in the Install Template drop-down list, and then select File System Connector. Click Next.
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File System Connector automatically aggregates documents
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Installamywhere

Cancel
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10. Select No if there are no CFS servers installed on this computer. Otherwise, select Yes.

You must install the external File System connector and the CFS server on the same computer.
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InstallAmawhere

Cancel
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11. Enter the Service Manager Smart Analytics Server IP and port as follows, and then enter the CFS Server port and Service port. Click Nex

t

SM Smart Analytics Server IP: <EXTERNAL_ACCESS_HOST>




12.
13.

Task 2:

SM Smart Analytics Server Port: 31370
CFS Port: 7000
CFS Service Port: 7001

HPE SM 9,52 SmartAnalytics ESEE

Configure CF$8
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@ License Agreement Please specify the HPE SM Smart Analytics server's IP and part,

Q Installation or Upgrade which will be used to commnunicate with the CFS server.
Q Choose Install Folder

. Please specify the ports for the CFS server.
Q Choose Installation Type

0 Configurations HPE SM Smart Analytics Server IP:
Pre-Installation Summary <EXTERNAL ACCESS HOST-
Installing... HPE 5M Smart Analytics Server Port:
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Hewlett Packard
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InstallAmawhere

Cancel

If you have modified the CFS Port from 7000 to another, you need to update the value for the IngestPort parameter to the
modified port number in the Connector configuration file (such as filesystemconnector.cfg). The file should resemble the
following:

[Ingestion]

IngestHost=127.0.0.1

IngestPort=7000

Configure File System Connector Server Port and Service Port, and then click Next.
Click Install to install the File System Connector and CFS Server.

Configure the filesystemconnector.cfg file

. Go to <File System Connector Installation directory>/FileSystemConnector, and then open the filesystemconnector.cfg file with a text

editor.
. Configure the [FetchTasks] and [MyTask] sections as needed.
53 [FetchTasks]
&0 Nuwrber=1
61 0=MyTask
62
&3 [MyTask]
64  //specifies the interval (in seconds) bhetween scheduled synchronize actions.
&5  ZcheduleRepeatSecs=300
66 //specifies whether the connector searches sub-folders.
67  DirectoryRecursive=TRUE
6% //The DirectoryPathCSVs parameter specifies a comwa-separated list of folders to search for files.
62  DirectoryPathC3Vs=\,J7\ ShareDirectory
70 //A regular expression that specifies the folders to search for files. The connector only searches folders:
71  //that are within the location specified by DirectoryPathC3Vs
72 //where the full path of the folder matches the regular expression
7% //where the full path of all parent folders (up to the folder specified by DirectoryPathCSVs) match the regular expression.
74 FPathCrawlRegex=.+
75 //L regular expression that specifies the folders to ignore. The connector ignores any folders where the path watches the regular expression.
76 //If a folder is ignored, all of its subfolders are also ignored.
77 //PathNoCravlRegex=
78 //The DirectoryFileMatch parameter limits the files that are retrieved by the connector. The walue of this parameter is =a wildeard expression
79 //The filename of a file must match the wildcard expression, otherwise the file is ignored. default to all files
G0 DirectoryFileMatch=+.pdf, *.doe, 5.ppt, *.oxe, *. log
81

Restart your File System Connector Server.



Task 3: Configure the CFS connector, Smart Analytics server host, and port
To modify the existing configuration and connect to containerized Smart Analytics, follow these steps:

1. Go to <CFS Installation directory>/CFS, and then open the CFS.cfg file with a text editor.
2. Locate the [IdolServer] section, and then modify the host and port as follows:

[IdolServer]
Host=<EXTERNAL_ACCESS_HOST>
Port=31370
DefaultDatabaseName=News
//ISSLConfig=SSLOptionl
3. Save your changes, and then restart the CFS service.

Task 4: Configure File System Connector in SM

Log on to Service Manager, and then click System Administration > Ongoing Maintenance > Smart Analytics > Smart Search. The Smart
Search configuration page opens.

1. Click the Connector Configuration link to open the connector configuration page.
2. Go to the File System Connector tab, and then perform the following actions:
a. Type a new file system connector URL in the Add a File System connector field (for example: http://192.168.255.255:1234/).
You can skip this step if you have configured this URL in Service Manager before.

The “/" at the end of the URL is mandatory. Make sure the File System Connector's status is online.

onnector Configuration and Monitor

wlonitor connector status using this form,

< CFSServer | & SharePoint Connector | ¢ OMMI Group Server | ¢ HTTP Connector | < File System Connector

Add a File System connector

|| | |Test Connection Add
For example : bt 12 3.4 5612347
All task
Connector URL Status
bt/ . 1 234/ Online

b. You can click Test connection to test the URL connection status, and click Add to add this URL to the current list.
3. Add a fsyslib library for the sharepoint connector (you can skip this step if you have added a fsyslib library in Service Manager before). To
do this, follow these steps:
a. Go to Smart Search Configuration page.
b. Enter a Knowledgebase Name.
c. Select fsyslib in the Type drop-down list.
d. Click Add. The Knowledgebase Maintenance page opens.

Smart Search Configuration

Edit Global Search Configuration

Add Knowledgebase

Knowledgebase Mame |Hemufi|ESEwer |

Type |fsys|ih | v |

| Add |

Add

4. Enter a Connector and Task, and then click Save.
5. Click Full Reindex and Refresh Status.


http://192.168.255.255:5678/

Knowledgebase Maintenance

demofileServer

Status Display Name [y dermofile]

Status Offline Connector | http:/ /NN 1234/ B

Type tsyslib Task [MVTASK B

Last Update Time Refresh Interval [z 2

1= Sminutes
Error
Time & Seript
Knowiledgebase access seript dermofileServer_kmaccess E

[ Full Reindex | [ Refresh statistics |

6. You can perform a search when the status changes to Indexing and the Doc Count for this library is greater than 1.

Log off and then log back on to Service Manager if you can not find the library in your Smart Search library list.

Set stop words, stop phrases, and synonyms for Smart Analytics

This topic includes the following tasks:

® Update Smart Analytics stop words

® Set stop phrases for Hot Topic Analytics
® Fully containerized mode
® Mixed mode

® Update Smart Analytics synonyms

Update Smart Analytics stop words

To update Smart Analytics stop words, follow these steps:

1. On the master node, run the following command to access the <Smart Analytics NFS root folder>/data/idol/langfiles folder:
cd <Smart Analytics NFS root folder>/data/idol/langfiles
The stop words lists are saved as the <language name>.dat file in this folder.
2. Run the following command to add a new word or modify an existing word in a language file:
vim <language name>.dat
3. Select ESC, and then enter :wq to save the changes and exit.
4. Restart all Smart Analytics services in the container. To do this, follow these steps:
a. Run the kubectl get pod --all-namespaces | grep smarta command to get all Smart Analytics pod’s status.
b. Run the kubectl delete pod <pod_name> -n <namespace> command to stop the services.
5. Train and perform a full reindex of Smart Ticket, Hot Topic Analytics, and Smart Search. To do this, follow these steps:
a. From Service Management, go to System Administration > Ongoing Maintenance > Smart Analytics > Smart Ticket. Select
a record in the Current Configuration List, and then click the Training button.
b. From Service Management, go to System Administration > Ongoing Maintenance > Smart Analytics > Hot Topic Analytics.
Select a record in the Current Configuration List, and then click the Start Index button.
c. From Service Management, go to System Administration > Ongoing Maintenance > Smart Analytics > Smart Search.
Select a record in the Current Configuration List, and then click the Full Reindex button.

Set stop phrases for Hot Topic Analytics

Adding stop phrases is a way to hide particular words or phrases from appearing in the Hot Topic Analytics topic map. The stop phrases are still
retained in the Smart Analytics data set.

Fully containerized mode

To update stop phrases for Hot Topic Analytics in containerized mode, follow these steps:

1. From Service Management on the master node, click System Administration > Ongoing Maintenance > Smart Analytics > Hot Topic
Analytics.

2. Click Stop Phrase. The Configure IDOLStop Phrase page opens.

3. Add the words or phrases that you identified as stop phrases to this page. These words or phrases must exactly match the key words to



find hot topics, and each word or phrase must start with a new line.

® Do not use wildcards in stop phrases.

® Stop phrases are case-sensitive by default, and the corresponding configuration is defined in the
IDOL/IDOLServer.cfg file as follows:
QuerySummaryStopPhraseMode=9

To set the stop phrases to be case-insensitive, update the configuration as follows:
QuerySummaryStopPhraseMode=41

4. Click Save. The system automatically saves the stop phrases in alphabetical order. Alternatively, you can click Save & Exit to close the
Configure IDOL Stop Phrase page.
5. Run Hot Topic Analytics again. The stop phrases are no longer displayed in the topic map.

Mixed mode

External Service Manager 9.41, 9.50, and 9.51 with containerized Smart Analytics

To update stop phrases for Hot Topic Analytics in Mixed mode (external Service Manager 9.41, 9.50, and 9.51 with containerized Smart
Analytics), follow these steps:

1. On the master node, run the following command to access the <Smart Analytics NFS root folder>/data/idol/st/contentl/main folder:
cd <Smart Analytics NFS root folder>/data/idol/st/contentl/main
The stop words lists are saved in the gssp.db file in this folder.
2. Run the following command to add a new word or modify an existing word:
vim gssp.db
. Select ESC, and then enter :wq to save the changes and exit.
. Continue to follow step 1 to step 3 to update the file in the <Smart Analytics NFS root folder>/data/idol/st/content2/main folder.
. Restart HPE Smart Analytics HTA and the containerized Smart Ticket content server. To do this, follow these steps:
a. Run the kubectl get pod --all-namespaces | grep smarta-st-con command to get all content server pod’s status.
b. Run the kubectl delete pod <pod_name> -n <namespace> command to stop the services.

g b w

External Service Manager 9.52 with containerized Smart Analytics
To update stop phrases for Hot Topic Analytics (external Service Manager 9.52 with containerized Smart Analytics), see Fully containerized mode

Update Smart Analytics synonyms

To update Smart Analytics synonyms, follow these steps:

1. On the master node, run the following command to access the <Smart Analytics NFS root folder>/config/idol/synonym folder:
cd <Smart Analytics NFS root folder>/config/idol/synonym
The synonyms are saved in the synonyms.txt file in this folder.
2. Run the following command to add a new word or to modify an existing synonym in this file:
vim synonyms.txt
3. Select ESC, and then enter :wq to save the changes and exit.
4. Restart all Smart Analytics services in the container. To do this, follow these steps:
a. Run the kubectl get pod --all-namespaces | grep smarta command to get all Smart Analytics pod’s status.
b. Run the kubectl delete pod <pod_name> -n <namespace> command to stop the services.
5. Train and perform a full reindex of Smart Ticket, Hot Topic Analytics, and Smart Search. To do this, follow these steps:
a. From Service Management, go to System Administration > Ongoing Maintenance > Smart Analytics > Smart Ticket. Select
arecord in the Current Configuration List, and then click the Training button.
b. From Service Management, go to System Administration > Ongoing Maintenance > Smart Analytics > Hot Topic Analytics.
Select a record in the Current Configuration List, and then click the Start Index button.
c. From Service Management, go to System Administration > Ongoing Maintenance > Smart Analytics > Smart Search.
Select a record in the Current Configuration List, and then click the Full Reindex button.

Roll back from containerized Smart Analytics

The Smart Analytics migration tool consists of three scripts: 1-StopSMApods.sh, 2-MergeConfiguration.sh, and
3-StartSMApodsRestoreContentData.sh. Your roll-back procedures varies depending on which scripts you have executed in the migration
process. See the following scenarios:

® If you have executed 1-StopSMApods.sh only, perform step 4 and 7.
® |f you have executed both 1-StopSMApods.sh and 2-MergeConfiguration.sh, perform step 1, 2, 3, 4, and 7.
® |f you have executed all three scripts, perform all the following steps.

Follow these steps to roll back Smart Analytics data:



= Step 1. Recover configuration files

1.
2.

3.

Log on to the NFS server.

Browse to the <Smart_Analytics_ NFS>/config/idol directory, and then search for all files whose names end with "cfg_backup". For
example, Content.cfg_backup.

Run the mv -f <File_Name>.cfg_backup <File_Name>.cfg command.

The following list includes some typical backup files:

Iss/contentla/Content.cfg_backup
Isslcontentlb/Content.cfg_backup
.Iss/content2a/Content.cfg_backup
.Isslcontent2b/Content.cfg_backup
Ist/lcontentl/Content.cfg_backup
Ist/lcontent2/Content.cfg_backup
Ist/mixProxy/proxy.cfg_backup

~ Step 2: Recover stop words, stop phrases, and synonyms

1.
2.

3.

4.

5.

Log on to the NFS server.

Browse to the <Smart_Analytics_ NFS>/data/idol/langfilese directory, and then run the find . -name *.dat_backup command to
search for all files whose names end with "dat_backup".

Run the mv -f <File_Name>.dat_backup <File_Name>.dat command to recover stop words.

The following list includes some typical backup files:

Jrussian.dat_backup

Iportuguese.dat_backup

Jarabic.l-r.dat_backup

Jchinese.dat_backup

Jczech.dat_backup

Jdutch.dat_backup

Jenglish.dat_backup

Jfrench.dat_backup

JJgerman.dat_backup

./hebrew.dat_backup

J/hungarian.dat_backup

Jitalian.dat_backup

Jjapanese.dat_backup

Ipolish.dat_backup

Ispanish.dat_backup

JIswedish.dat_backup

Jturkish.dat_backup

Browse to the <Smart_Analytics_NFS>/data/st/contentl/main directory and the <Smart_Analytics_ NFS>/data/st/content2/main direct
ory, and then run the mv -f gssp.db_backup gssp.db command in the two folders respectively to recover the stop phrases.
Browse to the <Smart_Analytics_ NFS>/config/idol directory, and then run the mv -f ./synonym/synonym.txt_backup
JIsynonym/synonym.txt command to recover the synonyms.

~ Step 3: Recover Smart Ticket data

1.
2.
3.

Log on to the NFS server.

Browse to the <Smart_Analytics_ NFS>/data/idol/mix/proxy/category directory.
Run the following commands:

rm -rf category

mv -r category_backup category

~ Step 4: Restart all related components

1.
2.

3.

4.

Log on to the ITSMA suite master node, and then browse to the folder in which 2-MergeConfiguration.sh is located.
Run the following command:

foriinls yamls™; do if [[ $i ="ss"* || $i = "st"*]]; then kubectl create -f yamls/$i; fi done

Run the following command to check the pods' status:

kubectl get pods --all-namespaces | grep smarta

When all pods’ status is Running, run the following commands:

kubectl create -f yamls/I2proxy.yaml

kubectl create -f yamls/proxy.yaml

w Step 5: Recover Hot Topic Analytics data

1.

Log on to the ITSMA suite master node, and then run the following command to get a list of Hot Topic Analytics content server pods.
kubectl get pods --all-namespaces | grep st-con
For example:
NAME READY STATUS RESTARTS AGE
Smarta-st-con-1-3678744724-mfodd ~ 1/1 Running 0 1h
smarta-st-con-2-1017065627-tktOw 171 Running 2 4h
. Run the following command to enter the pod:

kubectl exec -it <NAME> -n <NAMESPACE> sh



3. Browse to the /var/data directory, and then run the Is command to find all files in the folder.

There should be at least one file with the name of Backup-<TIME>-smarta-st-con-1-<RANDOM>-10010-0.idx. Record the name.
4. Run the following command:

curl http://127.0.0.1:10011/DREADD?<FILE_NAME>&createdatabase=true

~ Step 6: Re-index Smart Search data
Re-index the Smart Search data in Service Manager.

w Step 7: Remove useless files

1. Log on to the NFS server.

2. Browse to the <Smart_Analytics_NFS> directory.

3. Run the following commands, and then remove all the listed files.
find . -name *_backup
find . -name BackupContent*
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